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Thank You for Choosing Ross
You've made a great choice. We expect you will be very happy with your purchase of Ross 
Technology. 
Our mission is to:
1. Provide a Superior Customer Experience

• offer the best product quality and support

2. Make Cool Practical Technology

• develop great products that customers love
Ross has become well known for the Ross Video Code of Ethics. It guides our interactions and 
empowers our employees. I hope you enjoy reading it below.
If anything at all with your Ross experience does not live up to your expectations be sure to reach 
out to us at solutions@rossvideo.com.

David Ross
CEO, Ross Video
dross@rossvideo.com

Ross Video Code of Ethics
Any company is the sum total of the people that make things happen. At Ross, our employees are a 
special group. Our employees truly care about doing a great job and delivering a high quality 
customer experience every day. This code of ethics hangs on the wall of all Ross Video locations to 
guide our behavior:
1. We will always act in our customers’ best interest.

2. We will do our best to understand our customers’ requirements.

3. We will not ship crap.

4. We will be great to work with.

5. We will do something extra for our customers, as an apology, when something big goes wrong 
and it's our fault.

6. We will keep our promises.

7. We will treat the competition with respect.

8. We will cooperate with and help other friendly companies.

9. We will go above and beyond in times of crisis. If there's no one to authorize the required action in 
times of company or customer crisis - do what you know in your heart is right. (You may rent 
helicopters if necessary.)
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Warranty and Repair Policy
The Ultricore BCS system is backed by a comprehensive one-year warranty on all components.

If an item becomes defective within the warranty period Ross will repair or replace the defective 
item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are 
conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of 
Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be 
supplied free of charge while defective items undergo repair. Return packing, shipping, and special 
handling costs are the responsibility of the customer.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or 
application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or 
consequential damages (including loss of profit). Implied warranties, including that of 
merchantability and fitness for a particular purpose, are expressly limited to the duration of this 
warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of 
ownership.

Environmental Information
The equipment may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need 
for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back 
systems. These systems will reuse or recycle most of the materials from your end-of-life equipment 
in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your 
local or regional waste administration. You can also contact Ross Video for more information on the 
environmental performances of our products.

This appliance may contain a Coin type battery which should not be treated as household waste.

To ensure that the battery will be treated properly use the appropriate take-back systems in your 
area. These systems will reuse or recycle most of the materials from your end-of-life equipment in 
an environmentally friendly and health conscious manner.

Security and Privacy 
If you would like more information on how Ross Video security and privacy practices have been 
applied to the Ultricore BCS, what you should know about maintaining security of this product, and 
how we can partner with you to ensure security throughout this product's life-cycle, contact 
techsupport@rossvideo.com.

Notice — Changes or modifications to this equipment not expressly approved by Ross Video Limited 
could void the user’s authority to operate this equipment.



Ross Video has implemented reasonable administrative, technical, and physical safeguards to help 
protect against security incidents and privacy breaches involving a Ross Video product provided 
those products are used in accordance with Ross Video instructions for use. However, as systems 
and threats evolve, no system can be protected against all vulnerabilities and we consider our 
customers the most important partner in maintaining security and privacy safeguards. If you have 
any concerns, we ask that you bring them to our attention, and we will investigate. Where 
appropriate, we will address the issue with product changes, technical bulletins and/or responsible 
disclosures to customers and regulators. Ross Video continuously strives to improve security and 
privacy throughout the product life-cycle using practices such as: 

• Privacy and Security by Design
• Product and Supplier Risk Assessment
• Vulnerability and Patch Management
• Secure Coding Practices and Analysis
• Vulnerability Scanning
• Access Controls appropriate to Customer Data
• Incident Response
• Clear paths for two-way communication between customers and Ross Video

If you would like to report a potential product related privacy or security issue (incident, breach, or 
vulnerability), contact techsupport@rossvideo.com.

Company Address

Ross Video Limited 
8 John Street
Iroquois, Ontario
Canada, K0E 1K0

Ross Video Incorporated 
P.O. Box 880
Ogdensburg, New York
USA 13669-0880

General Business Office: (+1) 613  652  4886

Fax: (+1) 613  652  4425

Technical Support: (+1) 613  652  4886

After Hours Emergency: (+1) 613  349  0006

E-mail (Technical Support): techsupport@rossvideo.com
E-mail (General Information): solutions@rossvideo.com

Website: http://www.rossvideo.com

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
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Introduction
This guide covers the installation, configuration, and use of the Ultricore BCS Central Controller in a 
routing system. The following chapters are included:

• “Introduction” summarizes the guide and provides important terms, and conventions.
• “Before You Begin” provides an overview for creating a routing system with Ultricore BCS, and 

general information to keep in mind before installing and configuring your Ultricore BCS panel.
• “Hardware Overview” provides a basic introduction to the Ultricore BCS front and rear panels.
• “Physical Installation” provides instructions for the basic physical installation of the Ultricore 

BCS panel.
• “Basic Configuration” provides instructions for adding the Ultricore BCS to the DashBoard Tree 

View, accessing the Ultricore BCS interfaces in DashBoard, and basic global settings in 
DashBoard.

• “Software License Keys” outlines the available software licensed features, and how to install a 
software key for a licensed feature.

• “Ultricore-IP” outlines how to configure receivers and senders to be used in video and audio 
streaming.

• “Device Communication Setup” provides instructions for using Ultricore BCS to establish 
connections with NK Series devices, Ross Ethernet devices, and third-party devices in your 
routing system.

• “Database Configuration” provides instructions for defining the elements of your routing 
system database such as matrices, levels, destinations, and sources.

• “Tallies” provides instructions on how to enable TSL UMD messages in the active database, and 
assign Tally IDs to your sources and destinations.

• “Using Categories” describes how to assign each destination, source, and level, to a specific 
category in the routing system database.

• “Soft Panels in DashBoard” provides instructions for creating virtual panels in Ultricore BCS.
• “Using Salvos” describes how to create and recall a salvo using the options in DashBoard.
• “Setting up a Redundant System” outlines how to configure two Ultricore BCS panels into a 

single standby redundant system.
• “Tielines” outlines how to define a distributed routing system using the Tieline Builder feature of 

the Ultricore BCS.
• “Operation with Ross Devices” provides general information for operating the Ultricore BCS in a 

routing system that also includes Ross NK Series devices.
• “System Integration Examples” provides generalized examples of integrating Ultricore BCS into 

existing routing systems. 
• “External Control” lists the third-party protocol commands the Ultricore BCS supports.
• “Monitoring” describes the alarms and status indicators in the DashBoard interface for the 

Ultricore BCS. General information is also provided on the Ethernet port LEDs.
• “DashBoard Interface Overview” summarizes the functions, menus, and parameters of the 

Ultricore BCS tabs and windows in DashBoard.
• “Panel Menu System Overview” outlines the menus available using the hard panel.
• “Technical Specifications” provides the specifications for the Ultricore BCS.
• “Software Licenses” provides third-party software license information for your Ultricore BCS.
• “Glossary” provides a list of terms used throughout this guide.
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Related Publications
It is recommended to consult the following Ross documentation before installing and configuring 
your Ultricore BCS:

• DashBoard User Manual, Ross Part Number: 8351DR-004
• Ultricore BCS Quick Start Guide, Ross Part Number: 2201DR-108
• Ultrix Installation Guide, Ross Part Number: 2101DR-003
• Ultrix User Guide, Ross Part Number: 2101DR-004
• Walkabout Application Note, Ross Part Number: 2201DR-003

Documentation Conventions
Special text formats are used in this guide to identify parts of the user interface, text that a user 
must enter, or a sequence of menus and sub-menus that must be followed to reach a particular 
command.

Interface Elements
Bold text is used to identify a user interface element such as a dialog box, menu item, or button. For 
example:

In the Edit dialog, click Insert Above.

User Entered Text
Courier text is used to identify text that a user must enter. For example:

In the Language box, enter English.

Referenced Guides
Italic text is used to identify the titles of referenced guides, manuals, or documents. For example:

For more information, refer to the Ultrix User Guide.

Menu Sequences
Menu arrows are used in procedures to identify a sequence of menu items that you must follow. 
For example, if a step reads “File > Save As,” you would click the File menu and then click Save As.

Important Instructions
Star icons are used to identify important instructions or features. For example:

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and 
Gateway for your device.

Contacting Technical Support
At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as 
the nearest telephone.

Our 24-hour Hot Line service ensures you have access to technical expertise around the clock. 
After-sales service and technical support is provided directly by Ross Video personnel. During 
business hours (Eastern Time), technical support personnel are available by telephone. After hours 
and on weekends, a direct emergency technical support phone line is available. If the technical 
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support person who is on call does not answer this line immediately, a voice message can be left 
and the call will be returned shortly. This team of highly trained staff is available to react to any 
problem and to do whatever is necessary to ensure customer satisfaction.

• Technical Support: (+1) 613-652-4886
• After Hours Emergency: (+1) 613-349-0006
• E-mail: techsupport@rossvideo.com 
• Website: http://www.rossvideo.com 

mailto:techsupport@rossvideo.com?Subject=Information%20Request&Body=Hi,%0D%0D
http://www.rossvideo.com
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Before You Begin
Ultricore BCS is a fully featured connectivity control system that is designed to handle all the usual 
router requirements as well as harness the power of Ultrix. Ultricore BCS makes it quick and easy to 
configure a system and gives your staff an intuitive and powerful set of controls to make operations 
run smoothly.

If you have questions pertaining to the operation of Ultricore BCS, contact us at the numbers listed 
in “Contacting Technical Support”. Our technical staff is always available for consultation, training, 
or service.

General Overview
Ultricore BCS is the central system controller for Ross Video’s routing systems. It allows the 
connection of Ethernet based routers and remote control panels, and third-party automation 
systems.

By collating the potentially complex aspects of a system’s switching scheme, Ultricore BCS allows for 
minimal out-of-the-box configuration of routers. This not only makes it easier to initially setup a 
system, but it also makes it easier to change configuration as needed.

The DashBoard client software enables you to monitor and control your Ross routing system 
components, from a computer. DashBoard communicates with the Ross routing system through 
Ethernet TCP/IP connections. 

IP Connectivity
Ultricore BCS provides simple, familiar configuration options paired with sophisticated discovery 
and registration to facilitate adding IP into systems.

• Optional software licenses
• scalable based on the number of streams required for control in the system
• use the same work-flows regardless of transport to enable easier integration in hybrid operations 

using the same logical configuration, and control surfaces
• Ultricore IP
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Typical System Equipment
Use Ultricore BCS in typologies where routers and remote control panels are distributed 
throughout a facility. In this scenario some of the routers and panel are physically located a great 
distance from the Ultricore BCS. You would use Ethernet connections to the Ultricore BCS.

Figure 1  Example of a Possible Routing System with Ultricore BCS
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Before You Begin
Before configuring and operating the Ultricore BCS, you must first:

1. Download and install the latest version of the DashBoard client software. The DashBoard 
software and user manual are available from our website. 

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. 

2. Connect your routers and panels to your facility network.

3. Launch DashBoard.

4. Ensure that your routers and remote control panels are available/visible in DashBoard.

For More Information on...
• downloading and installing DashBoard, refer to the DashBoard User Manual.
• planning and installing your routing system, refer to the user documentation that accompanied 

your devices.
• configuring the NK-NET, refer to the NK-NET User Guide.
• configuring the NK-IPS, refer to the NK-IPS User Guide.

Installation and Setup Overview
The generalized work flow of installing and configuring your Ultricore BCS is:

1. Implement your routing system plan by installing the devices and configuring their network 
settings.

2. Use Walkabout to establish communications between Ultricore BCS and DashBoard.

3. Ensure that DashBoard discovers the routing system and all its devices.

4. Configure individual device settings in DashBoard.

5. Define the routing system database using the options in the Ultricore BCS interfaces in 
DashBoard.

6. Set up control panels.

Implementing a System Plan
Once the topology of the system has been decided with respect to routers, panels, connecting 
devices (NK-NET, NK-IPS) etc. the components are connected and configured. Once all the Ross 
routing system components are configured for network communication, the required information 
is entered into the Ultricore BCS’s databases through its DashBoard interfaces.

An example use topology would be a broadcast facility or studio where there are routers and 
panels distributed throughout a building or a campus with the Ultricore BCS collating the system’s 
components. 

 Ultricore BCS acts as a central system controller for up to 10 DashBoard clients and up to 50 
hardware clients (routers and/or remote control panels).

Establish Communications
Ultricore BCS supports the Walkabout system for initial configuration of IP settings. Once you 
establish communications over Ethernet between the Ultricore BCS panel and DashBoard, you can 
proceed to use the interfaces in DashBoard that enable Ultricore BCS to communicate with the 
other devices in your routing system.
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For More Information on...
• establishing a network connection to Ultricore BCS, refer to “Using Walkabout to Assign an IP 

Address to the Ultricore BCS Panel”.

Define the Routing System Database in Ultricore BCS
The Database interface in DashBoard for Ultricore BCS enables you to create system input and 
output lists, assign those signals to system sources and destinations, define multiple levels and 
matrices. You can create multiple databases, each one with unique parameters, that are saved to 
the Ultricore BCS panel memory. This provides the flexibility of recalling a database and edit 
parameters as needed. You may wish to use the following process when defining the database for 
your routing system.

 Ultricore BCS supports a maximum of 64 levels, with a maximum matrix of 4096 sources and 
4096 destinations.

Figure 2  Process for Configuring an Ultricore BCS

 Ultricore BCS does not support Unicode characters.

For More Information on...
• defining a database, refer to the section “Creating a New Database”.

Set up Virtual Control and Resource Management in Ultricore BCS
Once your router connections are defined, and a database is established, you can start building a 
map of several different physical devices that become one virtual device. When a switch request is 
made for a virtual device, all the physical devices that are mapped to the virtual device are switched. 

Ultricore BCS enables you to map inputs and outputs from routers for control via any remote 
control panel. These parameters can be saved to a database, enabling you to change configurations 
easily and quickly, allowing devices to used in a number of different operating scenarios.

Configure the Soft Panels in Ultricore BCS
There are seven types of soft panels available in the Ultricore BCS interface:

• A Matrix panel displays the sources and destinations in a grid pattern, allowing you to quickly 
select a router, then select which crosspoints to switch from, and perform a Take transition 
between the crosspoints.

• A MultiBus panel arranges the sources and destinations in separate crosspoint buses, but 
provides similar controls as the Matrix panel.

• A Category Index panel provides an interface for classic category/index selection. The various 
categories and indexes are set via the Cat/Index category table within each database.

• A Group category panel provides a method of grouping dissimilarly named resources into 
functional selection groups. The group assignments are set via the Group categories table within 
each database.

• A Push Button panel provides a button-per-source style panel in a grid layout. 
• An UltritouchPB panel provides a button-per-source grid of buttons scaled to support Ultritouch 

panels.
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• An UltritouchMV panel provides specific Ultriscape MultiViewer controls scaled for display on 
Ultritouch panel.

 Ultricore-BCS does not display UltritouchMV soft panels. Refer to the Ultritouch+Ultrix User 
Guide for information on using these soft panels.

Operation
Once configured, the Ultricore BCS provides central controller functionality for the routing system, 
including:

• the storage and implementation of routing system configurations, which collect a series of 
routing matrices into a system and provide a logical database view of the whole system

• switching the physical crosspoints of the routers according to the system configuration
• the control and system database interface for devices that control and/or display routing status 

(e.g. remote control panels, switchers, master control, automation systems, multi-viewers, and 
tally systems)

• virtual routing, matrix partitioning, and mapping
• label support for protocols supporting labels
• system control through DashBoard
• connection and status logging
• single Ultricore BCS operation or dual redundant mode
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Hardware Overview
This chapter presents information on the Ultricore BCS front and rear panels. 

Front Panel Overview
The Ultricore BCS front panel is a touchscreen display that enables you to monitor Ultricore BCS 
communication status and routing system the panel is connected to. (Figure 3)

Figure 3  Ultricore BCS — Example of the Front Panel

 This information is also reported in the System Monitor interface in DashBoard. Refer to “System 
Monitor Tab” and “Monitoring via the Front Panel” for more information.

1. Product Name

Indicates the Ultricore BCS product name.

2. Active Database

Reports the database currently loaded on this Ultricore BCS.

3. Panel Status

Displays the following information:

› IP — the IP Address assigned to this Ultricore BCS.
› Version — the build version of the Ultricore BCS.
› Name — the unique identifier assigned to the Ultricore BCS.
› Uptime — the number of hours, minutes, and seconds since the last reboot of the Ultricore 

BCS.

4. Incoming Connections

Reports the connected external devices currently sending data to the Ultricore BCS: 

› DashBoard Clients — the total number of DashBoard clients communicating with this 
Ultricore BCS.

› RCP Panels — the total number of remote control panels communicating with this Ultricore 
BCS.

› 3rd Party Control — the total number of third-party automation control devices 
communicating with this Ultricore BCS.
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› Ross IP-Video x/y — where x represents the current number of Ross Video IP Connectivity 
video devices (e.g. NEWT-IPX) communicating with this Ultricore BCS and y represents the total 
number of devices the Ultricore BCS is licensed to communicate with.

› Ross IP-Audio x/y — where x represents the current number of Ross Video IP Connectivity 
audio devices (e.g. IGGY-MADI) communicating with this Ultricore BCS and y represents the 
total number of devices the Ultricore BCS is licensed to communicate with. 

› IP-Video x/y — where x represents the current number of third-party IP Connectivity video 
devices communicating with this Ultricore BCS and y represents the total number of third-party 
video devices the Ultricore BCS is licensed to communicate with.

› IP-Audio x/y — where x represents the current number of third-party IP Connectivity audio 
devices communicating with this Ultricore BCS and y represents the total number of third-party 
audio devices the Ultricore BCS is licensed to communicate with.

5. Outgoing Connections

Reports the name and IP address of each external device that the Ultricore BCS is transmitting 
data to.

6. Memory Utilization

Reports the percentage of system RAM currently in use and will vary depending on the size of 
your routing system.

7. Disk Space Utilization

Reports the percentage of available storage space and will vary depending on the complexity of 
your routing system, the features enabled on the Ultricore BCS, and the stored database(s).

8. System Utilization

Reports on the level of traffic and communications the Ultricore BCS is managing. For example, 
this value is low when the system is idle or during periods of low activity. An increase in activity, 
such as when a user changes configurations, the system is busy switching or processing lots of 
parameter changes, there was a burst of network traffic will impact the System Utilization value 
reported.

Rear Panel Overview
The Ultricore BCS rear panel provides connections for power supplies, communications, and 
network connections. 
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Figure 4  Ultricore BCS — Rear Panel, Side View

1. PWR1 and PWR2 Connections

There are two power supply connectors located on the rear of each Ultricore BCS. Each connector 
requires a 15VDC connection to an external power supply. Refer to Table 85 for power 
specifications.  

The Ultricore BCS ships with one power supply. An option is available to order a second power 
supply.

2. HDMI Port

This port is not implemented.

3. USB Port

This port is used with supported dongles for serial communication. Refer to the section 
“Supported USB-Serial Converters” for a list of supported devices.

4. ENET1 and ENET2 Ports

Each ENET port is an RJ45 connector 1GbE network interface. 

Use the to connect the Ultricore BCS to the local area network (LAN).

Use the Ultricore BCS panels. Refer to “Setting up a Redundant System” for details. 

Notice — The Ultricore BCS automatically powers on when power is applied.

Notice — The ENET ports do not provide, nor make use of, Power-over-Ethernet (PoE).
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Physical Installation
If you have questions pertaining to the installation of Ultricore BCS, please contact us at the 
numbers listed in “Contacting Technical Support”. Our technical staff is always available for 
consultation, training, or service.

Before You Begin
These installation guidelines assume the following:

• The relevant Ross equipment is installed into a ventilated rack frame. The relative humidity in the 
environment of the equipment should be <70% (non-condensing). The ambient temperature of 
the air entering the front panel should not exceed 40°C (104°F), and should not fall below 0°C 
(32°F).

• The install location of the panel should be accessible, dry, and dust-free.
• The socket/outlet should be installed near the equipment and be easily accessible.
• Valid IP addresses are available for the equipment.

Static Discharge

Throughout this chapter, please heed the following cautionary note: 

Mounting Requirements
The Ultricore BCS panel is designed for installation into a standard 19” equipment rack. It has 
integrated rack ears, allowing it to be screwed in using standard screws and cage nuts.

The Ultricore BCS panel mounts in the rack frame by means of four rack screws fastened through 
the front mounting ears. This should normally be sufficient to carry the load, including the weight of 
accompanying cables. 

Under some conditions, the ambient air temperature inside rack-mount cabinets can be greater 
than the ambient temperatures within a room. For safe long term reliability,  adequate ventilation 
within a rack frame must also be maintained.

For More Information on...
• the technical specifications for the Ultricore BCS, refer to “Technical Specifications”.

Connecting the Ultricore BCS to a Network
The ENET 1 port is a standard 10/100/1000 RJ45 Ethernet connector and is used to exchange data 
and communicate with other devices in your router system. 

 Contact your IT department before connecting to your facility network to ensure that there are 
no conflicts. They will provide you with an appropriate value for the IP Address, Subnet Mask, and 
Gateway for your device.

The Ultricore BCS is connected directly to your network so that it can interface with the devices in 
your routing system. After a physical connection is established, use the DashBoard client to 
configure the network settings for the Ultricore BCS.

ESD Susceptibility — Static discharge can cause serious damage to sensitive semiconductor 
devices. Avoid handling circuit boards in high static environments such as carpeted areas and when 
synthetic fiber clothing is worn. Always exercise proper grounding precautions when working on circuit 
boards and related equipment.
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 If difficulties or problems are experienced when connecting the Ultricore BCS to a network hub, 
or with assigning IP addresses, please contact your network administrator.

To establish a physical connection to the network

1. Connect one free end of the straight through CAT5/5e/6 cable to a free port of the network hub.

2. Connect the other end of the same cable to ENET 1 on the Ultricore BCS rear panel.

Figure 5  Ultricore BCS — Network Connection

Connecting to a Power Supply
The Ultricore BCS panel is powered by one +15V DC, 30W PSU, with an optional PSU available.

Each power cord should be connected to a separate power source for protection against failure of 
the A/C power circuit. In the event of one power supply failure, the panel load is seamlessly 
transferred to the other connected redundant power supply.   

To connect the power cables to the Ultricore BCS panel

1. Connect the male end of the provided power cable into the socket marked PWR1 on the 
Ultricore BCS rear panel.

Warning Hazardous Voltages — The safe operation of this product requires that a protective 
earth connection be provided. This protective earth is provided by the ground conductor in the 
equipment’s supply cord. To reduce the risk of electrical shock to operator and service personnel, this 
ground connector must be connected to an earthed ground.

Warning — In some countries it may be necessary to supply the correct mains supply cord. Use only 
certified cords for the country of use.

HDMI

PWR 1
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USB

ENET 2

ENET 1 To network hub
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Figure 6  Ultricore BCS — Primary Power Connection 

2. Connect the second power cable into the PWR2 power supply socket if a second power supply 
is required.

3. Connect the supplied AC power cable into the power modules.

4. Connect the supplied power cable’s three-prong male connector to an AC outlet.

Notice — The Ultricore BCS automatically powers on when power is applied.

HDMI

PWR 1
PWR 2

USB

ENET 2

ENET 1

Note: It is recommended that you always connect
the Power Supply Unit to the Ultricore BCS before
connecting to Mains Power.
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Basic Configuration
The Ultricore BCS system controller with the DashBoard client software allows configuration and 
control of the Ultricore BCS and other routing system devices, enhancing the capability of any 
installed Ross products by providing access to the entire range of functions. Ultricore BCS provides 
a basic platform operation with SLP discovery and manual configuration of connection to 
DashBoard. 

This chapter provides instructions on basic set up that includes launching DashBoard, using 
Walkabout to assign an IP address to the Ultricore BCS panel, adding the Ultricore BCS to the Tree 
View in DashBoard, and accessing the Ultricore BCS interfaces in DashBoard.

Launching DashBoard
DashBoard must be run on a computer that has a physical wired Ethernet connection. Wireless 
connections do not allow device discovery.

For More Information on...
• the DashBoard client software and user documentation are available on our website.
• the Ultricore BCS interfaces in DashBoard, refer to “DashBoard Interface Overview”.

To launch DashBoard

1. Ensure that you are running DashBoard software version 9.2 or higher.

2. Launch DashBoard by double-clicking its icon on your computer desktop.

Using Walkabout to Assign an IP Address to the Ultricore BCS 
Panel
Once the Ultricore BCS panel is physically installed and cabled to your facility network, you will need 
to assign it a static IP Address to enable DashBoard to locate it on your network. Establishing an IP 
Address enables DashBoard to communicate with the Ultricore BCS and update the Basic Tree View 
with the Ultricore BCS nodes.

To assign a static IP address to the Ultricore BCS panel

1. Launch DashBoard.

2. From the DashBoard client main toolbar, select File > Show Walkabout.

The DashBoard window displays the Walkabout table.

3. Click Refresh, located at the bottom of the Walkabout tab, to ensure the list in the Walkabout 
table is current.

4. In the Walkabout table, find the entry for the Ultricore BCS you want to configure.

5. Use the Name field to assign a unique identifier to the Ultricore BCS panel. This is the name 
displayed in the Tree View of DashBoard.

 After editing a cell in the Walkabout table, press Enter to confirm your edits. To verify your 
changes, wait up to 1 minute, then click Refresh.

6. Use the Address field to specify the IP Address supplied by your IT Department for this device.

7. Ensure the Netmask field is set to match your network requirements.

8. Use the Gateway field to specify the IP Address for connection outside of the local area 
network (LAN).
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9. Click Reboot in the row of the Walkabout table for the Ultricore BCS to reboot the device.

Adding the Ultricore BCS to the Tree View in DashBoard
Once you have assigned the Ultricore BCS panel to a static IP Address via Walkabout, you can then 
manually add it to the Tree View in DashBoard. Manually adding the Ultricore BCS panel displays its 
node in the Tree View, granting you access to the interfaces described in “DashBoard Interface 
Overview”.

To manually add the Ultricore BCS to the Tree View in DashBoard

1. In the Basic Tree View toolbar of DashBoard, click .

The Add New Connections dialog opens.

2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Enter the IP Address for the Ultricore BCS in the IP Address field assigned in the section “To 
assign a static IP address to the Ultricore BCS panel”.

6. Click Detect Frame Information.

The fields in the TCP/IP DashBoard Connect/openGear Device dialog are auto-populated with 
data retrieved from the Ultricore BCS panel.

7. Click Finish. 

The Ultricore BCS panel displays in the Tree View. 

Accessing the Ultricore BCS Interfaces in DashBoard
The interfaces are accessed by expanding the Ultricore BCS node in the DashBoard Tree View.

To access the Ultricore BCS interfaces in DashBoard

1. Locate the Ultricore BCS node in the Tree View of DashBoard.

2. Expand the main Ultricore BCS node.

3. Expand the Ultricore BCS sub-node to display a list of sub-nodes in the Tree View.

Each sub-node is an Ultricore BCS interface.
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4. Expand a sub-node to access the functions of the interface.

5. Double-click a node to display its tab in the right-side of the DashBoard window. For example, 
double-click the Database Builder node to display the interface for creating new databases.
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 The selected interface may be blank or missing some data if the database is new and is not 
configured yet. Also, an outgoing connection must be established before remote devices will be 
listed on the Database Builder interface.

Reviewing the Network Settings for the Ultricore BCS Panel
Once you establish initial communications with the Ultricore BCS panel, and it displays in the 
DashBoard Tree View, you may wish to alter the network settings according to your facility network 
requirements.

To update the network settings for the Ultricore BCS panel

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Network tab.

3. Locate the Settings area of the tab.

4. Use the Address field to specify the new static IP Address for the Ultricore BCS panel.

5. Use the Subnet Mask field to specify the subnet mask for your network.

6. Use the Gateway field to specify the gateway for communications outside of the local area 
network (LAN).

7. Click Network Settings Apply.

Re-naming the Ultricore BCS
Each Ultricore BCS can be given a unique name that is used on internal menus and as the identifier 
in the tree views of DashBoard. 

 Changing the Ultricore BCS name after database configuration takes time to propagate through 
the system, and for DashBoard to reconnect, resuming stable system operation. Sufficient time 
must be allowed when making this change before attempting to use the system. This time will 
vary depending on features, matrix size, and configuration. In the case of a system with an 
ULTRIX-1RU and ULTRIX-2RU, the worst case will be 3-4 minutes. In the case of a system with an 
ULTRIX-5RU, the worst case is 10 minutes. The Ultricore BCS name is typically assigned during 
initial commission and very rarely ever changed again.

To re-name the Ultricore BCS in DashBoard

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Setup tab.

3. Use the Device Name field to specify the new name for the Ultricore BCS.

4. Press Enter to apply the new name.

Configuring Access for DashBoard Clients
You can specify which DashBoard clients on your network can access and connect to your Ultricore 
BCS. By default, the Permitted Clients list is blank, allowing all DashBoard clients on your network 
to connect to your Ultricore BCS.
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To enable access for a DashBoard client

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Network tab.

3. Locate the Permitted Clients area of the Network tab.

4. Click Add in the Permitted Clients area of the Network tab.

The Add Address dialog opens.

5. Use the IP Address field to specify the IP Address of the DashBoard client you wish to grant 
access to your Ultricore BCS.

6. Click Apply.

The Add Address dialog closes.

The Dashboards list in the Permitted Clients area updates to display the specified IP Address.

7. Repeat steps 4 to 6 for each DashBoard client you want to allow access.

 Ensure that the IP Address for your DashBoard client machine is also added.

8. Click Apply in the Permitted Clients area to apply the change.

To disable access for a DashBoard client

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Network tab.

3. From the Dashboards list, select the IP Address for the DashBoard client you want to disable 
access for.

 Do not delete the IP Address for your DashBoard client machine.

4. Click Delete in the Permitted Clients area of the Network tab.

5. Click Apply in the Permitted Clients area to apply the change.
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Connecting to an ULTRIX-FR12
The Ultricore BCS acts as a primary controller for one or more ULTRIX-FR12. A connection is made 
from the controlling Ultricore BCS panel to each ULTRIX-FR12. The controlling Ultricore BCS 
(primary) contains the full database configuration for the entire operation of the routing system.

All client devices, such as a remote control panel (RCP) or third-party controllers, must be 
configured for and communicate with the primary Ultricore BCS. Each ULTRIX-FR12 configured as a 
client device will only accept control commands via the Ultricore BCS. To configure an ULTRIX-FR12 
as a client device, the Remote Controller Mode must be first enabled on the ULTRIX-FR12.

An Ultricore BCS with the Ultrix-IP license also enables the video senders/receiver endpoints to be 
reported as available ports to the routing database. The video senders/receivers are seen as part of 
a single video-IP matrix, and the audio senders/receivers are part of a single audio-IP matrix. 
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When a video sender stream is active and the video format changes on the SDI input of that 
stream, the Ultricore BCS will automatically detect the update and then updates all the receivers 
subscribed to that sender. This allows the existing streams to adapt.

Setup Overview
6. Configure the Ultripower Manager feature to group the Ultripower units together to safely 

power on/off the ULTRIX-FR12. Refer to the ULTRIX-FR12 Install Guide for details.

7. Set up any licensing requirements for the ULTRIX-FR12. Refer to the ULTRIX-FR12 User Guide.

8. Set up any Ultriscape requirements for the ULTRIX-FR12. Refer to the Ultriscape User Guide.

9. Enable Remote Controller Mode on the ULTRIX-FR12. Refer to the ULTRIX-FR12 User Guide.

10. Create a database within the Ultricore BCS to accommodate the I/O of the ULTRIX-FR12. Refer 
to “Creating a New Database”.

11. Create a connection point from the Ultricore BCS to the ULTRIX-FR12. Refer to “Connecting to 
an Ultrix Router”.

12. Edit the Ultricore BCS database to map logical sources and destinations to ULTRIX-FR12 
inputs/outputs. Refer to “Defining the Destinations in a Database” and “Defining the 
Sources in a Database”. 

13. Map the Ultriscape heads/PiPs. Refer to the Ultriscape User Guide for details.
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Software License Keys
The Ultricore BCS includes software options that license functions and features. This chapter 
outlines the available software licensed features, and how to install a software key for a licensed 
feature. 

Before You Begin
When installing a software license key on the Ultricore BCS:

• You must have the DashBoard client installed and communicating with the Ultricore BCS that you 
wish to install the key for.

• Ensure that you are using DashBoard version 8.9.0 or higher. This information is available by 
selecting Help > About DashBoard from the DashBoard main toolbar.

License Keys Overview
Table 1 provides a brief summary on the types of licensed features available for the Ultricore BCS.

Installing a License Key
Ross Video uses license keys to control user access to specific Ultricore BCS features. You can 
obtain a key for an Ultricore BCS licensed feature from Ross Video Technical Support.

To install an Ultricore BCS license key

1. Launch the DashBoard client. 

2. Locate the Ultricore BCS node in the Tree View.

Table 1  List of Ultricore BCS Licensed Features

License Description
Ultricore-NVISION Enables the use of the NVISION protocol on Ultricore BCS

Ultricore-SNMP Enables basic SNMP monitoring on Ultricore BCS 

Ultricore-BCS-CLIENT Each seat adds support for 10 device connections (panels, routers, 
DashBoard clients) to a maximum of 100 connections

ULTRICORE-TLX Enables the Tieline Builder feature for the Ultricore BCS

Ultricore-IP You must install this license to enable the Ultricore-IP feature for the 
Ultricore BCS.
Enables RDS and basic NMOS-IS-04 discovery support for the Ultricore-IP 
feature.
Depending on your routing system, you will also need to install one of the 
following IP licenses.

Ultricore-IP+V Each seat adds support for 16 video streams between Ross Video devices

Ultricore-IP+A Each seat adds support for 384 audio streams between Ross Video 
devices

Ultricore-IP+V3RD Each seat adds support for 16 video streams from third-party devices

Ultricore-IP+A3RD Each seat adds support for 384 audio streams from third-party devices
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3. Expand the Ultricore BCS node to display a list of sub-nodes in the Tree View.

4. Expand the Devices node.

5. Expand the Controllers + Matrices node.

6. Double-click the node for your Ultricore BCS.

The Device Configuration interface opens.

7. Click Licenses.

8. Make a note of the character string in the Request Code field for the feature you wish to 
enable.

9. Contact Ross Video Technical Support using the information found in “Contacting Technical 
Support”.

a. When you speak to your Technical Support representative, tell them your name, your facility 
name, and the Request Code from the Licenses table.

b. You will be given a License Key that must be entered in the applicable field in the Licenses 
table.

10. Enter the provided License Key in the applicable License Key field in the Licenses table.

 You can also right-click on the row for the License Key you are installing, and copy the Request 
Code to or paste the License Key from the Microsoft® Windows® clipboard.

11. Click Apply in the row for the License Key you entered in step 10.

12. Verify that the Count field is updated to report each installed License Key.
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Ultricore-IP
Ultricore-IP discovers, exposes, and controls multicast streams found on the IP network. The 
streams are added into the Ultrix router database as available ports. This chapter outlines how to 
configure receivers and senders to be used in video and audio streaming.

 Ensure that you have the required software licenses installed and are connected to a router with 
at least one Ultrix-IP blade installed. Refer to “Software License Keys”.

What are Receivers, Senders, and Streams?
The following terms may be used throughout this chapter:

Receiver

An element within a device that receives exactly one stream, which contains one flow from a 
network. If redundancy is enabled, then both sender and receiver can represent the two flows.

Sender

An element within a device which presents exactly one flow, packaged as a stream onto a network.

Stream

One flow, encapsulated within a transport protocol. Examples include SMPTE ST 2110-20 Video, or 
SMPTE ST 2110-30 Audio.

Functional Overview
Ultricore-IP is an optional software license that runs on the Ultricore BCS panel that uses the same 
routing work flow regardless of the transport protocol. The number of video and/or audio streams 
the Ultricore-IP recognizes depends on the software license(s) installed for the Ultricore BCS.

 The connection between Ultricore BCS and Ultricore-IP is via Registration and Discovery Service 
(RDS).

Once the required software licenses are installed, the RDS instance running on Ultricore BCS is 
activated and all devices that support NMOS IS-04 can register themselves with it. Once Ultricore-IP 
connects within the RDS, it can add the detected devices and resources to the router matrix much 
like SDI ports.

Setup Overview
The generalized work flow of configuring the Ultricore-IP feature is:

1. Download and install the latest version of the DashBoard client software.

2. Install the Ultricore-IP software license key to enable RDS and basic NMOS-IS-04 discovery.

3. Install any additional Ultricore-IP software license key(s) to enable support for video and/or 
audio streams as per your system requirements.

4. Configure the PTP settings for the ULTRIX-FR5 (with at least one Ultrix-IP blade) that the 
Ultricore BCS will communicate with. Refer to the Ultrix User Guide for details.

5. Configure the IP senders for each device in the routing system.
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6. Use the Ultricore-IP interface to discover each advertised network stream via the NMOS IS-04 
protocol.

7. Verify that the NMOS detected ports are added to the list of available ports for the routing 
system.

8. Add the newly discovered NMOS ports to your database. 

System Overview
The Ultricore-IP feature enables the video senders/receiver endpoints to be reported as available 
ports to the router database. The video senders/receivers can be seen as part of a single video-IP 
matrix, and the audio senders/receivers are part of a single audio-IP matrix. Or the streams belong 
to the same matrix with video and audio on different levels where each stream is reported as a 
single level despite how many channels it transports.

Figure 1  Example Setup with an Ultricore BCS
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Install the Ultricore-IP Software Licenses
Refer to “Installing a License Key” for details on the available Ultricore-IP licenses and how to 
install them for your Ultricore BCS.

Use the Ultricore-IP Interface to Access the Network Streams
Once the Ultricore-IP license is installed, and a connection is made with an Ultrix with at least one 
Ultrix-IP blade, the System Status > Ultricore IP tab displays in DashBoard. The Ultricore-IP 
automatically detects the RDS and advertised streams of NMOS devices in your network and 
reports them in the Ultricore IP tab.

To access the Ultricore-IP tab in DashBoard

1. Follow the procedure “To access the Ultricore BCS interfaces in DashBoard”.

2. Double-click the System Status sub-node.

3. Select the Ultricore-IP tab.

4. Specify the NMOS IS-04 version that the Ultricore-IP will use to communicate with the 
Registration and Discovery Service (RDS) for your network as follows:

a. Select Advanced Options.

b. Use the Version to Connect options to select each NMOS version required.

c. If required, use the IS-05 Preferred Version options to specify the NMOS IS-05 Connection 
service.

d. Click Apply (you may need to scroll to the bottom of the tab to locate this button).

 If your network has more than one Ultricore BCS running or if a third-party RDS is present, ensure 
that there is only one instance of the RDS with the same priority on the network.

5. Use the fields in the Ultricore-IP tab to monitor the advertised IP streams available in your 
network. Refer to “Ultricore-IP Tab” for a description of the available options and fields.

To register the Ultricore BCS when using Registry Service Discovery (RDS)

1. Display the Ultricore-IP tab. 

2. Locate the Discovery area of the tab. 

3. To determine how the Ultricore BCS will register in an RDS system:
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• Select the Enable mDNS Browsing box to configure the Ultricore BCS to use mDNS to 
automatically register in an RDS on the network with the lowest priority.

• Clear the Enable mDNS Browsing box to allow the user to set an RDS IP in the Registry 
Service Address field and forces the Ultricore BCS to register to this specific RDS.

4. Use the Add RDS options to specify an RDS to register.

Automatic Sender Session Description Protocol (SDP) Updates
By default, a receiver is automatically updated when the associated sender changes. The Ultricore 
BCS monitors all active connections on the system. When an active sender, that is associated with 
any receiver, is updated, the system will issue a connection update to all affected receivers. This 
update includes the latest information about the sender, including the updated SDP data.

Overview
This feature is helpful to avoid receivers to be configured with a stale version of a sender. If the 
parameters of a sender changes, an SDP update is trigged. This update is then forwarded to all 
receivers that Ultricore BCS detects as subscribed to the updated sender.

Ultrix-IP Senders Adaptive Input
On Ultrix-IP, the senders have a configuration option that allows the stream to update itself 
following its SDI input format detected (as long as it is a valid video format). You can choose to limit 
the video format changes on a bandwidth base or just allow one fixed video format. In the case 
where the sender can follow the video that is on its input, the SDP is updated on all 
interfaces/protocols where it is available (such as NMOS, Ember+, etc.)

This update of the sender is identified by the Ultricore BCS, which in turn forward it to all subscribed 
receivers.
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Ultricore Profiles
A DashBoard client has the ability to detect devices on a subnet and can enable complete control of 
all settings on all devices. Ultricore Profiles are designed to enable administrators to assign and 
manage user permissions and determine the level of access for those users. For example, one user 
is only responsible for monitoring the video sources is given access only to control panels, while 
another user who manages the input and outputs of the routing matrix is also given access to 
manage the databases. 

This chapter provides an introduction to the Ultricore Profiles for your routing matrix and includes 
general information on managing those profiles. 

Overview
The Ultricore Profiles operate as a form of hierarchical database where user permissions are 
organized into a tree-like format. A profile determines which groups and pages that a user can 
access. 

Any number of profiles may be created and can be used in the following ways:

• Group/Role — This profile type is not specific to any user or machine. Once created they can be 
referenced or used by any number of users or machines. For example, a Graphics Editor profile 
can be created and referenced by a team of graphics editors. When a new control panel is added 
to that profile, all graphics editors are updated with the new panel automatically.

• User — A user profile identifies a specific username and can either reference an existing role as 
above or copy an existing role then modify, add, or remove items to allow total customization as 
required. This allows a user that has a specific profile to have the same capabilities on any 
DashBoard system regardless of where they log in. 

• Location — This profile is defined by a specific location (user station) and assigns a consistent 
function regardless of who is logged in that suits the operation in that location. In this way the 
DashBoard instance in front of, for example, the audio operator in a specific control room will 
only have the optimize functionality for that role. A location profile can also reference or copy and 
modify role profiles.

Profiles can also be created that identify a specific user at a specific user station to further optimize 
the user interface in different locations. If no profile exists for the combination of user and location, 
the system default profile is used.

When there are multiple possible profiles the one used is chosen as follows:

1. A User profile has the highest priority. This means that an administrator can log in anywhere 
and execute Administrator level functions or an operator can login anywhere and have an 
optimized UI for their function.

2. A Location profile is used for all users at a specific location unless the user logged in has a 
profile. This allows more or different functionality for users logged into a specific location even 
if they do not have a specific profile themselves.

3. The system default profile is used in all other scenarios.

Modes of Operation
The Ultricore Profiles feature consists of three sub-functions or modes of operation.

 The ULTRICORE-PRO license is required to upgrade from the basic, non-configurable profiles on 
an Ultrix chassis to full, customizable configurations. The ULTRICORE-PRO license is standard on 
the Ultricore-BCS.
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Creation and Management of User Credentials
User profiles can reference the operating system username of the individual currently logged into 
the workstation.

Enabling User Credentials in the Setup tab of the status page engages the Ultricore User Credentials 
feature which allows an independent definition of usernames and passwords specifically for the 
Ultricore Profiles feature.

Creation and Management of User Profiles via the Default Role Profiles Only 
User and Location profiles are created and function as above but only reference one of the three 
default profiles:

• Engineer Admin (default profile) can access all features;
• Operator Admin (default operator profile) has full database and configuration capability but not 

engineering configuration and admin functions; or 
• Operator (default minimum profile) can access all soft panels for normal day to day operations.

Full Creation, Customization and Management of User Profiles
In addition to the above modes included with Ultricore-BCS is the ability to create and customize 
group and role profiles as well as create custom profiles on a user or location basis as appropriate. 
In addition, the order of items within these profiles can be set to fully optimize the operational 
environment for a specific user or group as needed.

Ultricore Profiles Interface
The options for configuring and managing the Ultricore Profiles are organized as individual panes 
within a single interface of a DashBoard window. 

Accessing the Ultricore Profiles Interface
You display the Ultricore Profiles interface by selecting its node in the DashBoard Tree View for the 
Ultricore-BCS in your system. By default, all nodes are displayed and accessible by any user or 
DashBoard client machine.

To display the Ultricore Profiles interface

1. Launch DashBoard on your desktop. 

2. Locate the Ultricore BCS in the Tree View of DashBoard.

3. Expand the Ultricore BCS node to display a list of sub-nodes in the Tree View.

4. Expand the Database sub-node.

5. Double-click the Ultricore Profiles sub-node.

The Ultricore Profiles interface is organized into five distinct areas. Each area is briefly described 
in this section starting with the leftmost area of the DashBoard window.
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Figure 2  Example of the Ultricore Profiles Interface

Users

When the system is configured to use the default user login mechanism, a list of all currently 
configured usernames along with their current online status displays in this area.

Profiles

A list of all currently configured profiles. Selecting a profile (row) in this area automatically updates 
the items displayed in the Profile Details, Device Tree, and Options areas.

Profile Details

This area displays the details of the profile showing the conditions under which the tree in the 
following section will be applied. 

Tree Nodes

A visual representation of the tree view that is defined in the Profile Details. Note that certain 
entries that are specific to licenses or other conditions may be visible but not in the actual tree view. 
Should conditions change that enable those entries, they will appear as shown in this display. A 
profile also maintains the position of items in groups allowing the most relevant items to be the 
easiest to reach.

The tree nodes are organized in a hierarchy where the top level (blue icons) list system specific 
options, and secondary levels (yellow icons) list specific functions. 

Group Tabs

This area displays all the available items that have not yet been assigned to the currently selected 
profile but are available to define.
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Creating a Database of Users
If you wish to use the User Profile feature, the first step is to create a new user account. Once this 
account is created, all users will default to the Operator Profile (the default minimum profile) 
unless or until they have a profile created that allows them appropriate access for their role. 

When creating users and profiles, ensure that the system is not in use. Any currently active 
DashBoard instances will require users to login and features may be blocked. 

You can create as many users as required by your system.

To create a new user account

1. Display the Ultricore Profiles interface as outlined in “To display the Ultricore Profiles 
interface”.

2. Click Manage Users.

The Manage Users dialog opens.

 Users can change their own password at the login screen, the Update Password button allows 
an Administrator to reset a forgotten password. A user name change requires the deletion of the 
current user and the creation of a new one with the new user name.

3. Click Add.

4. Use the User Name field to assign a unique identifier for the user account. 

5. Use the Password field to define the password the user will need to enter when logging in with 
this account.

6. Repeat this procedure for every new user you wish to create.

Once all the user accounts are created, you can proceed to create profiles and assign users to these 
profiles.

Creating a Profile
 The User Profiles features offers a significant flexibility to optimize the tools in front of individual 

operators which, if inadvertently mis-configured could lead to administrators being locked out. 
As such, it is a good idea for the administrator to ensure that no users are actively working within 
the system prior to making significant changes to users and profile settings. 
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Four profiles are created automatically: 

• Engineer Admin Profile — a group profile giving access to all features and functions as has been 
available prior to the Dashboard User Profiles feature. This profile is read-only by default.

• Operator Admin Profile — a group profile giving access to all non-engineering features and 
functions. This allows an operational Administrator the ability to configure and use all 
operational functions and databases of the systems. 

• Operator Profile — a group profile giving access to only the soft control panels. This allows users 
that are registered but either have no defined profile on a system or only require basic 
operational access the ability to control pre-configured operational functions of the systems. 

• Ultricore Admin Profile — a user profile which allows the “Administrator” user mentioned above 
to have full admin and engineering capabilities by using the Default Profile. This profile is 
read-only by default.

 All users default to the Default Tree Profile with no System Login required. In other words, until 
specifically enabled, the Ultricore Profiles feature is not engaged, and the systems will all behave 
as in previous versions. It should be noted that while the user profiles feature is not engaged, the 
default user profile can be modified should the tree for all users need to be modified. 

To create a profile

1. In the Profiles area, click Manage Profiles. 

The Manage Profiles dialog opens.

2. Click Add to create the new profile.

3. Use the Profile Name field to assign a unique name for the profile. 

Since the profile could be either specific to a user, a workstation or a group of users, it is 
recommended to create a name that reflects its purpose. For example, John Doe (a specific 
user), Graphics Operator (a group of users), or PCR1-TD (a workstation). 

4. Use the Username field to assign a specific user to the profile. 

An asterisk (*) indicates the profile applies to all users subject to the other profile detail entries. 

5. Use the Machine Name field to specify the OS/DNS machine name for a workstation. 

This allows the identification of a specific workstation in an environment where DHCP means 
the IP address may change over time. 

6. Use the IP Address field to specify the IP address for a workstation. 

This allows identification of a specific workstation in a statically addressed system. 

7. Use the Admin box to enable/disable (selected/cleared) access to admin functions.
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For example, upload, reboot, refresh and other tasks that are not normal operational functional 
requirements. 

8. Use the Parent Profile to assign any of the currently configured profiles as a parent or 
reference profile for the profile being created or edited. 

9. Use the Use and/or Copy options to determine if the parent profile tree configuration is used 
directly by the profile being created or edited or copied into this profile allowing customization 
of the tree for the specific needs of the user. 

 If another profile tree is used rather than copied, changes to the tree need to be performed on 
the parent profile tree and will affect all users that “use” that parent profile and that the same 
change would need to be executed individually on all users that copied the parent profile tree. 

10. Repeat this procedure for every new profile you wish to create.

Defining the Permissions for a Profile
Once a profile is created, the remaining two areas of the Ultricore Profiles interface allow display 
and/or modification of the tree structure that will be enabled for the user or users of the selected 
profile. 

Figure 3  Example of the Tree Nodes and Tabs for a Selected Profile

Overview
This section provides a brief overview of each area and their options.

Tree Nodes

The tree (the leftmost area) displays all the assigned options and their desired order in the tree 
structure much like the tree view in DashBoard for an Ultricore BCS. The nodes in Ultricore Profiles 
tree view are determined by your system configuration and any licenses installed for your system. 
Buttons at the bottom of this area (Up, Down, Remove) allow entries to be moved up and down in 
the tree within the group to which the item belongs or removed if they are not required for the 
selected profile. When removed, the item is returned to the list of available items in the appropriate 
group tab. 
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Group Tabs

The group tabs (the rightmost area) contain all items available in the group in question that are not 
included in the selected profile’s tree currently. If an item is not in the tree currently but required, 
the appropriate group tab is selected, the item required is selected and the Assign button is clicked 
moving it to the bottom of the appropriate group of the tree. The Up and Down buttons can then 
be used to order the tree items specific to the needs of the profile. 

When any changes are made to the tree structure(s), the changes are captured locally but are not 
recorded in the database until the Apply button on the bottom row is clicked. Clicking Apply 
records all the pending changes in the system database. Clicking Cancel will discard any unsaved 
changes. There are no pending changes if the Apply and Cancel buttons are not highlighted. 

Enabling the Ultricore Profiles Feature
Once you created the profiles and groups for your system, you can proceed to enable the Ultricore 
Profiles feature. Enabling the feature requires you to disable the current user credentials and 
settings and apply the profiles and groups you defined in previous sections. 

 Before proceeding, ensure that you created a new Administrator profile that has full access to 
your system. This is a separate profile from the default Ultricore Admin profile (which is 
read-only).

 This procedure requires a reboot of the Ultricore BCS.

To enable the Ultricore Profiles feature

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Setup tab.

3. Locate the Ultricore Profile Settings area.

You may need to scroll down the tab to view this area.

4. Clear the User Credentials box.

A dialog opens to confirm the selection.

5. Select the User Profiles box.

A dialog opens to confirm the selection.

6. Click Reboot.

Application of the Ultricore Profiles
Once the Ultricore Profiles function is enabled, all users from that point forward will initially receive 
a tree that only has a System Login entry. Once the user is created with either the default or a 
specific password by the Administrator, the user can login through a login page displayed in the 
DashBoard window. 

Figure 4  Example of the System Login Sub-node
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To log in

1. In the Basic Tree View, locate the device you wish to access.

2. Expand the device nodes to display the System Login sub-node.

3. Double-click the System Login sub-node.

The System Login page displays in the DashBoard window.

4. Enter the credentials for the profile assigned to you.

5. Click Login.

• The login information is confirmed by the system, and the appropriate tree with all assigned 
pages and functions are immediately available for use in the DashBoard window. 

• The Login page updates to the Logout page. 

When you log out, the Basic Tree View returns to the System Login tree view.

To change the password

• Click Change Pwd on the System Login page.

 The old password is required for the user to change the password and the new password needs 
to be confirmed to ensure the new password is as the user expects. If the old password is 
forgotten or lost the admin can force an update to the user password through the Manage Users 
dialog in the Users area of the Ultricore Profiles interface. 

User Data Import/Export 
Due to the need to maintain different permutations of user data to system data, the Import/Export 
database functions now includes the ability to import databases with and without the user data 
(user accounts and profiles). In addition, the user files can be imported and exported independently 
to any chosen database. This allows for instance a different show configuration to be loaded while 
maintaining the same staff and location configuration or for a truck for instance, allows a new crew 
configuration to be loaded without changing system configurations. 

 To import/export Ultricore Profiles, follow the same steps as outlined in “Importing a Database” 
and “Exporting a Database” but click Ultricore Profiles in steps 3.
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Device Communication Setup
Ultricore BCS functions as a central controller for the Ross routing system. From Ultricore BCS, you 
can store and implement routing system configurations into a system while providing an overview 
of your entire routing system. 

Ultricore BCS Communications Overview
A connection point is how the Ultricore BCS is connected to routing system components such as 
routers (matrices), and remote control panels. A connection point defines the interface and the 
protocol to be used for communications. Once defined, Ultricore BCS retrieves the information of 
any device on that connection point.

 Third-party device information is not automatically retrieved. These devices must be added 
manually. 

Ultricore BCS provides bi-directional protocol translation to facilitate the control of third party or 
legacy routers as part of a Ross routing system. You can also integrate control over a Ross routing 
system by a third-party automation system. Table 2 lists the important communication ports for 
Ultricore BCS.

Device Discovery in DashBoard
When DashBoard is launched, devices such as openGear frames and Ross NK routers, are listed and 
made available in the Tree View. DashBoard uses the open SLP protocol to locate devices on the 
same network as the computer running the DashBoard client software. There are two methods for 
adding a device to the Tree View in DashBoard: using the auto-connect feature of DashBoard or 
manually adding a device by specifying the IP address of the device. Both methods are described in 
more detail in the DashBoard User Manual.

Communications between Ultricore BCS and the Devices in a Routing System
The Ultricore BCS Connections interface enables you to define connections to devices in your 
network. To enable Ultricore BCS to function as the ‘master’ of the routing system, you must 
establish communications with the devices it is connected to and define how they are connected. 
Each router must have a connection point defined. For those devices that are not directly connected 
to your network, such as Ross NK Series T-Bus devices, you must supply their interface connection 
information (NK-NET/NK-IPS) in the Connections interface. Once this information is entered into the 
interface, the Ultricore BCS can communicate directly with these devices.

Connecting to an Ultrix Router
Ultricore BCS acts as a master controller for one or more Ultrix routers as well and legacy Ross NK 
series devices. A connection is made from the controlling (primary) Ultricore BCS panel to the 
(client) Ultrix router(s). The controlling Ultricore BCS panel contains the full database configuration 
for the entire operation of the system.

Table 2  Communications Ports

Device Protocol Port
NK Routers TCP 5000

Ultrix Routers TCP 15000

Walkabout Discovery UDP 5555
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For More Information on...
• configuring the Ultrix router, refer to the Ultrix User Guide.

General Work Flow

Figure 5  Ultrix Connection Work Flow

Setup Notes
Keep the following mind when establishing a connection point from an Ultricore BCS to an Ultrix 
router:

• Ensure unique device names for each Ultrix router. This allows identification of each individual 
router throughout the setup process. You can edit the name via the Ultrix front panel or 
DashBoard interface as outlined in the Ultrix User Guide.

• Ensure that the Remote Controller Mode is enabled for each Ultrix router. Refer to the Ultrix User 
Guide for details.

• Ultrix hardware configuration (licensing, port configuration, etc.) is achieved via its own device 
node within the DashBoard tree.

• Ultriscape Multi-Viewers are configured via the Ultriscape node within the DashBoard tree of the 
Ultrix that physically hosts that Multi-Viewer.

• Routing commands are issued to the Ultricore BCS via remote control panels, external protocols 
or DashBoard soft panels1. Any client router will ignore routing commands not originating from 
the primary while in this connected mode.

Adding a Connection Point
Before defining a connection point between the Ultricore BCS and an Ultrix router, you must verify 
that the router is listed in the Walkabout utility.

Once a connection point is established between the Ultricore BCS and its client routers, the physical 
inputs and outputs the clients provide will display in the Port Labels tab of the primary Ultricore 
BCS database. These input and outputs ports are now ready for renaming (if required) and mapping 
to logical source and destinations. 

To add an Ultrix connection point

1. Ensure each router is installed, configured, and listed in the Basic Tree View of your DashBoard 
client.

2. Ensure that the Remote Controller Mode is enabled for each router as follows:

a. In the Tree View for each router, double-click the System Status node.

b. Select the Database tab.

c. Select the Remote Controller Mode check box.

3. Launch the Walkabout utility in DashBoard as follows:

d. Select Show Walkabout to open the Walkabout utility in the DashBoard window.

1. Only the soft panels defined within the database of the Ultricore BCS may control the system.
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e. Verify that the Ultrix router is listed in the table of the Walkabout utility. Make a note of its 
name and IP Address.

4. Display the Connections tab in DashBoard for Ultricore BCS as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Connections node.

The Connections tab opens that lists the current database connection points.

5. Click Edit > Add.

The Add Connections dialog opens.

6. In the Add Connections dialog, perform the following:

a. Use the Protocol menu to select ultrix.

b. Use the Type menu to select tcp.

c. Use the Count menu to specify the number of new connection entries (rows) to make in the 
Outgoing Connections table. For example, to connect to three Ultrix routers you would 
enter a value of 3.

d. Click Apply to create the new device row(s) in the Outgoing Connections table.

The Add Connection dialog closes.

7. In the Name column of the Outgoing Connections table, click the cell of the new Ultrix row to 
display the drop-down menu.

8. From the drop-down menu, select the Ultrix router you which to establish a connection to.

9. If the Ultrix router is not listed in the drop-down menu:

a. Close the Connections tab.

b. Launch Walkabout to detect the on-line devices in your system.

c. Double-click the Connections node for the Ultricore BCS to display its Connections tab.

d. Repeat steps 5 to 8.

10. In the Enabled column of the new row, select Enable.

11. Repeat steps 7 to 10 for each additional Ultrix router.

12. Click Apply at the bottom of the Connections tab to save the new settings.

Deleting a Connection Point
Once a connection point is deleted from the Ultricore BCS database, the Ultricore BCS panel and 

the Ultrix router will need to be re-configured as per the new requirements. This will require you 
to update the database(s) on each device.
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To delete a connection point between Ultricore BCS and an Ultrix router

1. Display the Connections tab for Ultricore BCS as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Connections node.

The Connections tab opens that lists the current database connection points.

2. In the Outgoing Connections table, select the Ultrix connection to be deleted.

The row is now highlighted in the Outgoing Connections table.

3. Click Edit > Delete.

4. Power cycle the Ultrix router to re-establish its own internal database.

5. Re-configure Ultricore BCS and the Ultrix router as per the new requirements.

Connecting to Ross NK Series Devices
Ross NK routers and remote control panels are linked via the T-Bus Control System, a multi-drop 
RS-485 control system. These T-Bus devices can communicate over Ethernet via a Ross NK-IPS or 
NK-NET.

A connection point between the Ultricore BCS and an NK-IPS or NK-NET is defined using the 
auto-populated fields in the Connections tab of the Ultricore BCS interface. Once a connection point 
is established, the Ultricore BCS gains control over those Ross NK devices connected to the NK-IPS 
or NK-NET.

To establish a connection point between Ultricore BCS and an NK-IPS or NK-NET

1. Launch the Walkabout utility in DashBoard as follows:

a. Expand the NK Utilities node in the Tree View.

b. Double-click Show Walkabout to open the Walkabout utility in the DashBoard window.

c. Verify that your the NK-NET or NK-IPS is listed in the table of the Walkabout utility. Make a 
note of its name and IP Address.

 If the device you want to connect to the Ultricore BCS is not detectable in Walkabout, you can still 
establish communications with it in Ultricore BCS using the Connections > Settings menu to 
manually enter/edit the device settings.

2. Display the Connections tab for Ultricore BCS as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Connections node.

The Connections tab opens that lists the current database connection points.

3. Click Edit > Add.

The Add Connections dialog opens.

4. In the Add Connections dialog, perform the following:

a. Use the Protocol menu to select Ross NK.

b. Use the Type menu to select tcp.

c. Use the Count menu to specify the number of new connection entries to make in the 
Protocol Servers table.

d. Click Apply to create the new device row(s) in the Protocol Servers table and close the Add 
Connections dialog.
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5. In the Name column, click the cell of the new row to display the drop-down menu.

6. From the drop-down menu, select the device you which to establish a connection to.

 Ross Video devices will auto-populate this menu.

7. In the Enabled column of the new row, select Enable.

8. Click the [...] button to verify or manually edit the connection settings for the device.

9. Click Apply at the bottom of the Connections tab to save your settings.

Once a connection point is established between Ultricore BCS and the Ross NK router, the router 
ports are automatically included in the Available Ports list of the Ultricore BCS database. 

Connecting to Ross Remote Control Panels
Ultricore BCS can communicate with external remote control panels such as the Ross RCP-NK 
series, RCP-ME, and RCP-QE. Communication with Ethernet enabled panels is direct from the panel 
to Ultricore BCS. Refer to the panel user manual for specific configuration details.

RCP-NK Series Panels
Communication with RCP-NK series panels is via an established connection point with either an 
NK-IPS or NK-NET network bridge. Refer to the RCP-NK User Guide for details. Refer to “Operation 
with Ross Devices”.

 RCP-NK series control panels do not automatically receive the active database labels. The 
database labels must be replicated on each RCP-NK series device. 

RCP-ME and RCP-QE Panels
The connection from the remote control panel to Ultricore BCS is configured on the panel’s 
DashBoard interface.

1. Display the RCP Connection Editor in DashBoard for your remote control panel. Refer to the 
user guide for your remote control panel for details.

2. Locate the Servers to Connect to table.

3. In the first row of the table, use the IP address column to specify the IP address of the Ultricore 
BCS that the remote control panel will communicate with.

4. Send the current configuration file to the remote control panel. Refer to the user guide for your 
remote control panel for details.

The remote control panel will connect to the Ultricore BCS and receive a copy of the current 
database labels.

Connecting to Third-Party Devices
Ultricore BCS is capable of communicating with third-party devices via either a server connection 
(in-coming control), or a client connection (out-going control). Ultricore BCS runs several servers by 
default to provide connection end points for many industry standard control systems. Client 
connections for out-going control may be defined on an as-need basis.

 Before proceeding, ensure that your third-party device is installed and configure according to its 
documentation.
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Overview
Ultricore BCS provides bi-directional translation of the following third-party protocols:

• GVG Native Serial and Ethernet protocols
• Probel SW-P-08 serial protocol

Connection to third-party devices may be categorized into two broad groups: controller and 
controllee.

• Controllers are devices that will control the Ultricore BCS and connect via what may be termed an 
incoming connection.

• Controllees are devices to be controlled by Ultricore BCS router and connect via what may be 
termed an outgoing connection.

For More Information on...
• the protocols and ports for configuring third-party communications on Ultricore BCS, refer to 

Table 3 and Table 4.
• the commands that Ultricore BCS supports, refer to “External Control”.

Incoming Ethernet Connections
The Ultricore BCS can communicate with third-party external devices via a TCP connection. By 
default, Ultricore BCS runs a server process for the following Ethernet protocols:

These Ethernet servers are always running. No further configuration is required — simply configure 
your client device to match the Ultricore BCS’s TCP/IP address and port number.

Outgoing Ethernet Connections
This section outlines how to configure a client connection (out-going control) interface to the 
external system.

To set up an outgoing (client) connection over Ethernet between Ultricore BCS and a 
third-party device

1. Expand the Database node.

2. Double-click the Connections node located under the Database node.

The Connections tab opens that lists the current database connection points.

Table 3  Supported Protocols — Ethernet Connection

Protocol Default Port
GVG Native Series 7000 TCP: 12345

NVISION NP00016 TCP: 5194

Probel SW-P-08 TCP: 8910

RossTalk TCP: 7788

TSL UMD v3.1 TCP: 5727
UPD: 4490

TSL UMD v4.0 TCP:5728
UDP: 4491

TSL UMD v5.0 TCP: 5729
UDP: 4492
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3. Click Edit > Add.

The Add Connections dialog opens.

4. In the Add Connections dialog, perform the following:

a. Use the Protocol menu to select the Ethernet protocol the device uses to communicate with 
the Ultricore BCS. Refer to Table 3 for a list of options.

b. Use the Type menu to select tcp or udp as required by the external device.

c. Use the Count menu to specify the number of new connection entries to make in the 
Servers table.

d. Click Apply to create the new device row(s) in the Protocol Servers table.

5. In the Name field, type a unique identifier for the third-party device. This name is used to 
identify the specific device within the Ultricore BCS database.

6. Click the [...] button in the new row to display the Communication dialog.

7. Use the Communication dialog to further define the server to connect to:

a. Use the Address field to specify the IP Address assigned to the third-party device.

b. Use the Port field to specify the Port Number assigned to the third-party device that the 
Ultricore BCS will try to connect to.

c. Use the Wrapping field to specify the TSL UMD v5.0 TCP wrapping is enabled or disabled. 

 The list of options is dependent on the protocol selected. Refer to the external control for 
protocol details.

d. Click Apply to save your settings and close the dialog.

8. Edit the Details field to your requirements.

9. In the Enabled column of the new row, select Enable.

The Connected field in the Outgoing Connections table reports “Connect” when 
communication is established between the third-party device and Ultricore BCS.

10. Click Apply in the Connections tab to save the new settings.

Defining a Serial Connection
Ultricore BCS may communicate directly with third-party devices using a native serial protocol. A 
USB-to-Serial converter must be used to give the Ultricore BCS a serial communication port. Refer 
to Table 4 for information on the supported protocols.

Only USB-serial devices based on these chip-sets are supported: FTDI Chip, Belkin, Prolific PL 
2303, and Silicon Labs CP210x.
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 A serial connection point must be implemented on the Connections tab in the Ultricore BCS 
database before communications can start. The settings may be changed from the protocol 
defaults to suit your requirements.

To set up a serial connection between Ultricore BCS and a third-party device

1. Double-click the Connections node located under the Database node.

The Connections tab opens.

2. Click Edit > Add.

The Add Connections dialog opens.

3. In the Add Connections dialog, perform the following:

a. Use the Protocol menu to select the protocol standard.

b. Use the Type menu to select Serial.

c. Use the Count menu to specify the number of new connection entries to make in the 
Protocol Servers table.

d. Click Apply to create the new device row(s) in the Protocol Servers table.

4. In the Name field, type a unique identifier for the third-party device. This name is used to 
identify the device within the Ultricore BCS database.

5. Click the [...] button in the new row to display the Communication dialog.

6. Use the Port field to specify the Port Number assigned to the third-party device that Ultricore 
BCS will connect to.

7. From the Type menu in the Communication dialog, select RS232 or RS422.

The table in the Communication dialog updates to display the settings for serial 
communication.

8. Use the Type field to specify the serial transmission standard for the third-party device.

9. Use the Baud Rate field to specify the bit rate for the third-party device.

Table 4  Supported Protocols — Serial Connections

Protocol
Settings

Type Baud Data Bits Parity Stop Bits
GVG Native Series 7000 RS232 or RS422 38400 8 None 1

Probel SW-P-08 RS232 or RS422 38400 8 None 1

TSL UMD v3.1 RS422 or RS485 38400 8 Even 1

TSL UMD v4.0 RS422 or RS485 38400 8 Even 1

TSL UMD v5.0 RS422 or RS485 38400 8 Even 1
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10. Use the Parity field to specify the parity.

11. Click Apply to save your settings and close the Communication dialog.

12. In the new row of the Servers table, select the Enabled box.

13. Click Apply to save your settings.

The Connected field in the Outgoing Connections table reports “Connect” when the ability to 
communicate with the serial port is confirmed and enabled. The system does not poll or query 
the serial link to verify the validity of the setup.

Creating a Logical Matrix for an External Device
If the external device presents a matrix of crosspoint switches for routing, you can create logical 
matrices in an Ultricore BCS database using the device inputs and outputs. Creating a logical matrix 
from the external device enables Ultricore BCS to include the inputs and outputs for selection in the 
Sources and Destination tabs of the Ultricore BCS database.

 The input/output range and level you specify in the Ultricore BCS database must match the 
settings within the external matrix. 

To create a logical matrix from an external device

1. Expand the Database node.

2. Double-click the Third Party Matrices node located under the Database node.

The Third Party Matrices tab opens. 

3. Click Edit > Insert to add a blank row to the Third Party Matrices table.

4. In the Name field, type a unique identifier for the third-party matrix. This name is used to 
identify the matrix within the Ultricore BCS database.

5. From the Device ID drop-down menu, select the device you want to define the logical matrix 
for. This is the name given to the device when you established a connection point with it on the 
Connections tab.

 The Device ID menu lists only the third-party devices that have a valid connection point with the 
Ultricore BCS router.

6. Define the matrix size as follows:
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a. Use the First Output and Last Output fields to define the range of destinations from the 
device within the Ultricore BCS database.

b. Use the First Input and Last Input fields to define the range of sources from the device 
within the Ultricore BCS database.

 These created inputs and outputs will use the nomenclature DeviceID.Slot.Port.Type.Channel 
where DeviceID represents the Name assigned to the external device on the Connections tab.

7. Use the Level field to specify the number of levels for the device within the Ultricore BCS 
database.

8. Use the Type field to specify the signal type for the matrix. 

9. Click Apply to save the new matrix to the database and add it to the list of available matrices in 
the Port Labels tab.
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Database Configuration
A database in Ultricore BCS stores and implements a routing system configuration. Multiple 
databases can be configured using a different combination of devices, matrices, levels, sources, and 
destinations for the routings system. Procedures in this chapter assume that you have DashBoard 
launched and the Ultricore BCS displayed in the Tree View.

How a Database Determines the Routing System
The various tables within an Ultricore BCS router determine if a signal/route can be made from 
input to output.

For a given level, if there is a physical port mapped in both the Source and Destination tabs, and the 
controlling device has the level enabled, then a crosspoint switch can be issued and executed on 
the router(s). Table 5 outlines a database with four levels. Level 1 has mapped valid Sources and 
Destinations, and the level is enabled on the controlling device.

Configuration Overview
The generalized work flow of configuring a database for the Ultricore BCS is:

10. Establish connection points to external devices. Refer to “Device Communication Setup” for 
details.

11. Verify available I/O ports to ensure correct system connections. This default port naming 
convention of frame.slot.port.type nomenclature is to be overwritten (if required) at this 
stage.

12. Create a database as outlined in the procedure “Creating a New Database”.

 Ultricore BCS does not support Unicode characters.

13. Define a soft panel or establish a connection from a remote control panel (RCP).

Database File Management Overview
Each database consists of a collection of configuration files necessary for Ultricore BCS operation. 
The database resides within the Ultricore BCS storage system. Multiple databases may be saved 
and accessed at any time. 

Table 5  Example of a Multi-Level Database Setup

Level 1 Level 2 Level 3 Level 4
Is a physical source assigned?  Xa

a. An entry is not present in the corresponding Level column of the Source table.

 

Is a physical destination assigned?   Xb

b. An entry is not present in the corresponding Level column of the Destinations table.

X

Is the Level enabled on the Controller 
device?   

X

Can a switch be executed? c

c. A resulting switch will be executed.

Xd

d. A resulting switch will not be executed. Physical ports from the same logical matrix must be entered 
in the same control level before a connection can be made.

Xd Xd
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Use the System Status > Database tab to create, load, and delete databases. Use the System 
Status > Transfer tab to backup and restore databases.

For More Information on...
• the System Status tabs and menus, refer to “System Status Interfaces”.

Database management consists of the following tasks:

Creating a New Database

A database manages the configuration file and settings for your Ultricore BCS. Ultricore BCS may 
use a number of database configurations depending on its role in the routing system. Refer to 
“Creating a New Database” below.

Loading an Existing Database

Use the System Status > Database tab to load a configured database to your Ultricore BCS. Refer 
to “Loading a Database”.

Exporting a Database

Enables you to capture a database configuration in a *.uda file that is saved to a location on your 
network that you can specify. Refer to “Exporting a Database”.

Importing a Database

Enables you to import a saved *.uda file and make it available in the System Status > Database 
tab. Refer to “Importing a Database” for details.

Deleting an Existing Database

You can choose to permanently delete any configured database on your Ultricore BCS. Refer to 
“Deleting a Database” for details.

Creating a New Database
When you define a database, the information you enter into the Levels, Sources, and Destinations 
fields will auto-populate the applicable fields in the other interfaces for that Ultricore BCS router. 
You can change the labels for the destinations and sources at any time using the options in the 
Destinations and Sources interfaces. There are two methods for creating a new database: using the 
Database Builder, or using the options in the System Status > Database tab. Both methods are 
described below.

Using the Database Builder
Use the Database Builder to quickly create a starting point database. Once you define the basic 
parameters of the new database using the settings in the Quick Start interface, you can then define 
the levels, destinations, and sources for the new database. This makes it very easy to build basic 
configurations as well as get a system up and running quickly. 

To create a new database using the Database Builder

1. Display the Database nodes as outlined in the procedure “To access the Database interfaces 
in DashBoard”.

2. Double-click the Database Builder sub-node.

The Database Builder interface opens in the DashBoard window with the Quick Start page 
automatically displayed.
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3. Use the Provide a Name field to type a unique identifier for the database.

4. Select the box(es) from the provided list of detected routers the routers to make the database 
available to. 

5. If you wish to leave the remaining settings at their default values and quickly setup a database, 
you can click Finish and the database will be generated based on selected routers in step 4.

 Click Next, located at the bottom of the DashBoard window, to display the next page of options 
in the Database Builder interface.

6. If any AUX Ports are populated with SFP modules, use the Include AUX ports menu to specify 
how to label the I/O in the database.

 The default is Insert at Slot, which labels the I/O in each slot as 1-18 with the AUX Ports as 17 and 
18.

7. Use the Support Video Signal and Number of Audio Channels menus to define the Levels in 
the database.

8. Use the Breakaway Source Support menus to implement audio shuffling. The options for SDI 
and MADI channels are as follows: 

• None — there are no audio channels of this type.
• Mono — audio channels are applied to all levels
• Stereo — audio channels are assigned by pair (1-2, 3-4, 5-6 etc.)
• Quad — audio channels are assigned in groups of four (1-4, 5-8, 9-12 etc.)
• Oct — audio channels are assigned in groups of eight (1-8, 9-16, 17-24 etc.)

 You must have SFP modules installed that support MADI.

9. Use the Disconnect Source menu to set unused audio channels to disconnect.

10. Use the Passthrough Source menu to route the sources without changes/edits.

11. If you have an UltriScape license installed, use the last set of menus to define the heads, 
including the number of Picture in Picture (PIPs) that new layouts can include. 

 You can still create and edit layouts in a database with settings that differ from these.

12. Click Next to review the levels, destinations, and sources tables before completing the database 
builder.
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a. Use the Levels page to review or rename the level labels if required.

b. Use the Destinations page to review the destination label to physical port mapping. 
Renaming the labels is also possible from this page if required.

c. Use the Sources page to review the source label to physical port mapping. Renaming the 
labels is also possible from this page if required.

13. Click Finish to save the new settings.

 Click the Rename button on a page to define multiple elements. For example, clicking Rename on 
the Sources page enables you to define a prefix (e.g. SRC) and apply from a starting point (input 
4).

14. Click Finish to create the new database and apply it to the routers selected in step 4.

Using the Database Tab
You can use the Database tab in the System Status interface when only configuring a database for a 
single device.

To create a new basic database

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Database tab.

3. Locate the Add Database options in the Database Management area of the tab.

4. In the Add Database Name field type a unique identifier for the database. When the database is 
currently loaded in the system (in use), the Database node displays the database name in the 
tree view under the Ultricore BCS node.

5. Use the Levels field to specify the total number of levels available in the database.

6. Use the Sources field to specify the total number of inputs available in the database.

7. Use the Destination field to specify the total number of outputs in the database.

8. Click Database Add to create the new database and save it to the Ultricore BCS file system.

9. Load the database to ensure it is active before proceeding to customize.

Loading a Database
Each active database includes a unique setup saved to the Ultricore BCS file system. You must recall 
a database before you can configure the matrices, levels, sources and destinations, and soft panels 
for a particular setup. This also enables you to quickly recall a saved (configured) routing setup just 
by recalling a different database. 
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To load a saved database

1. In the Tree View, double-click the System Status node.

2. Select the Database tab.

3. From the Name menu in the Load Database area, select the database you want to load.

4. Click Load.

5. Verify the following to ensure the database was loaded:

• The Name, Levels, Sources, and Destination read-only fields in the Current Database area 
in the Database tab report the correct values.

• The Database node in the Tree View for the Ultricore BCS now reports the correct Database 
name. 

Defining the Levels in a Database
A level is a term used to describe a section or layer of the routing system (e.g. video level, audio 
level). Ultricore BCS uses level definitions for easy identification and control of various routing 
matrices or parts of the system. The levels defined in the Levels tab have a direct relationship with 
the Level columns found in other database tabs.

Before You Begin
Determining the amount of levels needed requires a little planning.

Ultricore BCS may operate with as little as a single level database to define control of an Ultrix SDI 
switching matrix. Ultrix also allows independent routing of SDI embedded audio channels as well as 
MADI channels. Using one single level of control will limit the independent selection of embedded 
audio and/or MADI streams. 

Any Ross NK series routers or other third-party routers attached to the Ultricore BCS system will 
require their own control level/s.

 The quantity of levels determines how many independent input/output ports (including 
embedded / MADI channels) may be grouped together as one source or destination selection.

Examples

A single control level can be used when there is limited independent embedded audio/MADI 
channel switching. 

 If AFV (audio-follow-video) is desired on a single level database, the Audio Bypass must be 
enabled for each input and output port or disable the Ultrimix function.

 A single level setup with NK-A64 analog audio router attached would require the following levels: 

ID Name
1 SDI

ID Name
1 SDI

2 AnAud L

3 An Aud R
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A setup using SDI with 4 embedded audio levels. This can allow independent switching of 4 of the 
embedded SDI channels and grouping of 4 MADI channels.The following levels would be required:

To define a level in the database

1. Double-click the Levels node located under the Database node.

The Levels tab opens.

2. Verify the ID field to specify the priority of the level.

 The ID field is a row number automatically defined by the routing system. This ID value 
corresponds to level numbers when used in Remote Control Panel (RCP) configurations and 
third-party communications.

3. To re-name a level:

a. In the Name column, type a unique identifier for the level. It is recommended to use words 
that describe the level such as 3G, Audio, etc.

b. Click Enter to update the name.

4. To select a unique color that will represent the level in the soft panels:

a. In the Color column, click the cell for the level you want to configure to display the Color 
Select dialog.

b. Select the hue from the provided vertical color grid in the Color Select dialog.

c. Use the Saturation options to specify the depth of the color.

d. Use the Lightness options to specify the amount of white or black mixed with the selected 
hue.

e. Confirm that the field beneath the color grid displays the correct color for the level.

f. Apply your changes using one of the following options:

• Click Live to preview the color scheme and apply it but not close the Color Select dialog; 
or

• Click OK to apply the new color to the level and close the Color Select dialog.

5. To provide additional information about the level:

a. In the Description column, type a brief summary of the level or provide additional 
information about the level use or purpose. This column is for identification purposes only 
and not required for operation.

b. Click Enter to update the description.

 Inserting a level in a working database can have destructive effects. It is recommended to insert 
below the last row to minimize this effect.

6. Click Apply to save your changes.

ID Name
1 SDI

2 A1

3 A2

4 A3

5 A4
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To create additional levels

1. Select a row in the Levels tab.

2. Click Edit.

 You can also copy and paste an existing level by clicking Copy > Paste from the Edit dialog.

3. To add a single level, select Add.

4. To add multiple levels:

a. Select Add Series to display the Add Rows dialog.

b. In the Prefix field, type the phrase. For example, if you want to create levels as AUDIO 1, 
AUDIO 2, etc., you would type AUDIO into the Prefix field.

c. In the Start Value field, type the first number to be used in the series.

d. In the End Value field, type the last number to be used in the series.

e. Click Apply.

To delete an entry from the Levels table

1. Select the row for the destination to delete in the Levels tab.

2. Click Edit > Delete.

 Ensure the ID numbers are correctly sequenced when deleting and inserting entries in the Levels 
table by selecting Edit > Reset All IDs.

Defining the Destinations in a Database
The Destinations tab allows the definition of names (labels) and physical sockets for your routing 
system outputs. When a database is initialized, default labels of Dest # are automatically filled in to 
the quantity specified by the database. These destination labels may be changed to suit your 
naming conventions.

The Destinations tab is organized into a table with each row representing a Destination and each 
column representing a Level.The table cells are the output sockets assigned to the Destination for 
that Level. Initially, the table cells are empty (e.g. the destination labels are not assigned to physical 
output sockets). These may be populated with the technique described in “To associate a physical 
output with a destination” or via the Advanced Fill tool.

The Advanced Fill tool is provided to create new destination labels that are automatically assigned 
to physical outputs depending on options set by the user. The audio routing features provided by 
Ultricore BCS can result in an extensive source and destination definition map requiring some time 
to manually enter. The Advanced Fill tool will speed the assignment of physical sockets greatly.

Various editing options are available from the editing menus, accessed via the Edit button located 
on the bottom toolbar of the tab. Refer to “Additional Dialogs, Menus, and Toolbars in the 
Database Interfaces” for details on these menus.

For More Information on...
• defining a database, refer to “Creating a New Database”.
• the Advanced Fill tool, refer to “Using the Advanced Fill Tool”.
• assigning Tally IDs to destinations, refer to “Assigning the Tally IDs to the Destinations”.

To specify a label for a destinations

1. Double-click the Destinations node located under the Database node.

The Destinations tab opens.
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2. Select the cell in the Name column of the label to alter.

3. Type the required label.

4. Press Enter to apply the change.

 Take care to limit the amount of characters as these labels are displayed on Remote Control 
Panels (RCPs) which have a limited display area.

5. Repeat steps 2 to 4 for each destination you want to specify a virtual label for.

6. Click Apply at the bottom of the Destinations tab to save your changes.

To associate a physical output with a destination

1. Double-click the Destinations node located under the Database node.

2. If desired, type a new name for the destination in the Name cell as outlined in the procedure 
“To specify a label for a destinations”.

3. In the Destinations tab, locate the column for the level you wish to include in the destination 
definition.

4. To associate a single output, perform one of the following:

• Select the cell of the row in the table to display a list of available output sockets. By default, 
the sockets are listed in the format of Frame.Slot.Port.Type.Channel unless they were 
re-named in the Port Labels interface.

• Choose an output from the available Matrix Outputs list and click Assign.

 Cell ranges may be horizontal as well as vertical. For example, a common operation would be to 
assign SDI embedded channels 1 to 16 to levels 2 to 17. The selected range would be horizontal 
across many levels but the selection would be vertical from the available outputs. The 
assignment operation will take the top most of the available outputs selection and assign it to the 
left most of the horizontal selection and so on through the selection range.

5. To associate a range of outputs:

a. Select the first cell in the table column.

b. Press and hold Shift.

c. Select the last cell in the table column. 

d. Select a range in the available Matrix Outputs list with the same click + shift-click method.
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e. Click Assign.

6. Click Apply at the bottom of the Destinations tab to apply the changes to the database.

To associate a series of outputs to the same level

1. In the table of the Destinations tab, select the first row in the series you want to define for the 
level.

2. Press and hold Shift.

3. Click the last row in the series to select a range of cells within a Level column.

4. Select a range of outputs as outlined in “To associate a physical output with a destination”.

5. Click Assign.

6. Click Apply at the bottom of the Destinations tab to apply the changes to the database.

To delete an entry from the Destinations table

1. Select the row for the destination to delete in the Destinations tab.

2. Click Edit > Delete.

 Ensure the ID numbers are correctly sequenced when deleting and inserting entries in the 
Destinations table. To re-order the Destinations ID numbers in the database, click Edit > Reset 
All IDs in the Destinations tab.

Configuring the Destination Follow Feature
The Destination Follow feature enables you to route a specific destination’s source signal to another 
destination. For example, set Dest 1 to follow Dest 6 so when Dest 6 is switched to a different 
source, Dest 1 is also switched to that same source. You can set multiple destinations to follow 
another single destination, or each following their own unique destination.

To configure the Destination Follow feature

1. Double-click the Destination Follow node located under the Database node.

The Destination Follow tab opens.

2. Locate the row for the destination to configure.

3. Use the Following menu to specify the output that the selected Destination will follow.
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In the example below, the user is configuring Dest1 to follow Dest6.

Defining the Sources in a Database
The Sources tab allows the definition of labels and physical sockets for your routing system inputs. 
When a database is initialized, default labels of Src # are automatically filled in to the quantity 
specified by the database. These source labels may be changed to suit your naming conventions.

The tab is organized into a table with each row representing a Source and each column 
representing a Level. At the top of the column is the name of the level. The table cells are the input 
sockets assigned to the source for that level.

Various editing options are available from the editing menus, accessed via the Edit button located 
on the bottom toolbar of the tab.

For More Information on...
• the Advanced Fill tool, refer to the sections “Using the Advanced Fill Tool”.
• assigning Tally IDs to sources, refer to the section “Assigning the Tally IDs to the Sources”.
• the Edit button, refer to the section “Additional Dialogs, Menus, and Toolbars in the Database 

Interfaces”

To specify a label for a source

1. Double-click the Sources node located under the Database node.

The Sources tab opens.

2. Select the cell in the Name column of the label to alter.
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3. Type the required label.

4. Press Enter to apply the change.

 Take care to limit the amount of characters as these labels are displayed on Remote Control 
Panels (RCPs) which have a limited display area.

5. Repeat steps 2 to 4 for each destination you want to specify a virtual label for.

6. Click Apply at the bottom of the Destinations tab to save your changes.

To associate a physical input with a source

1. Double-click the Sources node located under the Database node.

2. If desired, type a new name for the source in the Name cell as outlined in the procedure “To 
specify a label for a source”.

3. In the table of the Sources tab, locate the column for the level you wish to include in the source 
definition.

4. To associate a single input, perform one of the following:

• Select the cell of the row in the table to display a list of available input sockets. By default, the 
sockets are listed in the default format of Frame.Slot.Port.Type.Channel unless they were 
re-named in the Port Labels interface.

• Choose an input from the available Matrix Inputs list and click Assign.

 Cell ranges may be horizontal as well as vertical. For example, a common operation would be to 
assign SDI embedded channels 1 to 16 to levels 2 to 17. The selected range would be horizontal 
across many levels but the selection would be vertical from the available inputs. The assignment 
operation will take the top most of the available inputs selection and assign it to the left most of 
the horizontal selection an so on through the selection range.

5. To associate a range of inputs:

a. Select the first cell in the table column.

b. Press Shift.

c. Select the last cell in the table column. 

d. Select a range in the available Matrix Inputs list. 

e. Click Assign.

6. Click Apply at the bottom of the Sources tab to apply the changes to the database.

To associate a series of inputs to the same level

1. In the table of the Sources tab, select the first row in the series you want to define for the level.

2. Press and hold Shift.

3. Click the last row in the series to select a range of cells within a Level column.

4. Select a range of inputs as outlined in step 5 of the procedure “To associate a physical input 
with a source”.

5. Click Assign.

6. Click Apply at the bottom of the Sources tab to apply the changes to the database.

To delete an entry from the Sources table

1. Select the row for the destination to delete in the Sources tab.

2. Click Edit > Delete.
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 Ensure the ID numbers are correctly sequenced when deleting and inserting entries in the 
Sources table. To re-order the Sources ID numbers in the database, click Edit > Reset All IDs in 
the Sources tab.

Using the Advanced Fill Tool
The Advanced Fill operation is typically a tool used to initially set up an Ultricore BCS database. Edits 
and customization may then be performed after the Advanced Fill tool has done the bulk of the 
work.

The following examples are shown on a new database with only database default settings loaded.

 Take care when determining label names. While a long name may be nice and descriptive for the 
Source and Destination tabs, many control devices have limited screen space and labels may be 
truncated.

For More Information on...
• the settings and menus available in the Advanced Fill tool, refer to the section “Advanced Fill 

Tool”.

Create Source Labels with Assignments for SDI Video Levels
The objective of this example is to insert new labels and assignments for inputs for all routers on 
SDI Levels only.

To create source labels with assignments for SDI video levels

1. Define the levels as outlined in the section “Defining the Levels in a Database”.

2. Select an entry point in the Sources tab from where the new labels and assignments will begin.

a. Double-click the Sources node located under the Database node.

The Sources tab opens. 

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Breakaway Fill dialog opens.

3. If required, select Fill > Entire Device.

4. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.

5. From the AUX Port menu, define the router AUX ports. 

6. From the Slot menu, select the first slot in the router. (e.g. Ultrix.slot1)

7. From the Port menu, select the first IN port. (e.g. Ultrix.slot1.in[1])
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8. From the Starting Channel menu, select the first channel of the selected port. (e.g. 
Ultrix.slot1.in[1].sdi.ch1)

9. In the Levels table of the dialog, select the fully qualified Input assignment name from the I/O 
Assignment column.

10. Click Apply.

The dialog closes, and the Source tab updates with the newly created and insert labels with 
assignments.

 The Ultrix AUX ports are defined in the list. In this case, these would only be usable providing an 
SFP module that includes an SDI video input was installed into the relevant AUX port on the Ultrix 
rear panel.

Create Destination Labels with Assignments for SDI Video Levels
The objective of this example is to insert new labels and assignments for Ultricore BCS outputs for 
the SDI only level.

To create destination labels with assignments for SDI video levels

1. Define the levels as outlined in the section “Defining the Levels in a Database”.

2. Select an entry point in the Destinations tab from where the new labels and assignments will 
begin.

a. Double-click the Destinations node located under the Database node.

The Destinations tab opens. 

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Fill dialog opens.
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3. If required, select Fill > Entire Device.

4. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.

5. From the AUX Port menu, define the router AUX ports.

6. From the Slot menu, select the first slot in the router. (e.g. Ultrix.slot1)

7. From the Port menu, select the first OUT port. (e.g. Ultrix.slot1.out[1])

8. From the Starting Channel menu, select the first channel of the selected port. (e.g. 
Ultrix.slot1.out[1].sdi.ch1)

9. In the Levels table of the dialog, select the fully qualified Output assignment name from the I/O 
Assignment column.

10. Click Apply.

The dialog closes, and the Source tab updates with the newly created and insert labels with 
assignments.

 The AUX ports of the Ultrix router are defined in the list. These would only be usable providing an 
SFP module that includes an SDI video output was installed into the relevant AUX port on the 
router rear panel.

Create Source Labels with Assignments for SDI and Embedded Audio
The objective of this example is to create source labels and assignments for the SDI video and the 
first four embedded audio channels for an entire Ultricore BCS enabled slot. The remaining twelve 
audio channels are not used.
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To create source labels with assignments for the SDI video and embedded audio levels

1. Ensure that you have the Ultrimix licensed feature enabled for the slot. Refer to the Ultrix User 
Guide for details.

2. Define one level for SDI Video and 16 levels for the embedded audio as outlined in the Ultrix 
User Guide.

3. Select an entry point in the Sources tab from where the new labels and assignments will begin.

a. Double-click the Sources node located under the Database node.

The Sources tab opens. 

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Breakaway Fill dialog opens.

4. If required, select Fill > Entire Slot.

5. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.

6. From the AUX Port menu, define the router AUX ports.

7. From the Slot menu, select the Ultrimix enabled slot in the router. (e.g. Ultrix.slot1)

8. From the Port menu, select the first port of the Ultrimix enabled slot. (e.g. Ultrix.slot1.out[1])

9. From the Starting Channel menu, select the first channel in the series.

10. In the Levels table of the dialog, select a range of Level rows by clicking the first row level 
name, then holding the Shift button, click the last row level name. 

 Ensure to select the SDI Video level and the first four embedded audio levels.

11. Click Assign to automatically fill the I/O Assignment column for the selected levels.

The Breakaway Fill dialog updates but does not close.
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To set the unused audio channels to disconnect

1. From the Slot menu in the Breakaway Fill dialog, select Ultrix.slot0.

2. From the Port menu, select Ultrix.slot0.

3. From the Starting Channel menu, select Ultrix.slot0.disconnect[1].audio.ch1.

4. In the Levels table of the dialog, select the remaining twelve audio levels (e.g. A5-A16) from the 
I/O Assignment column.

5. Select Ultrix.slot0.disconnect[1].audio.ch1 from the I/O Assignment cell for the first selected 
row (e.g. A5).

The disconnect[1].audio will be applied to all the selected rows1.

6. Click Apply.

The dialog closes, and the Source tab updates with the newly created and insert labels with 
assignments.

1. Pass through may also be selected. Pass through has the effect of passing through any audio (silence or otherwise) 
on the channels A5 to A16. Disconnect effectively mutes those channels on the output stream.
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Creating Source Labels with Assignments for SDI and Embedded Audio, with 
Audio Breakaways
The objective of this example is to create and insert a series of labels with assignments for SDI video 
and embedded audio. Also, audio breakaway sources will be required to implement audio shuffling.

To enable the ability to shuffle audio (that is to take an audio channel and route into another 
stream in a different position within that stream), we need to define that audio channel as a source 
and assign it across all required levels.

For example, we may wish to take channel 3 audio from an input SDI stream, and route (just that 
individual channel) to channel 2 of an output SDI stream. To facilitate this, the following definitions 
are needed;

 If only four audio levels are defined as shown in Table 6, and assuming no other level definitions, 
the user can only route 'SDI 1 ch3' to any of the corresponding levels in the destination, i.e. 
cannot route 'SDI 1 ch3' to a destination stream channel 8 as Out[1].audio.ch8 is not defined in 
any of the destination levels.

To enact the previous example, the user selects the destination channel by selecting the 
appropriate level button on the control panel (in this case, the A2 level) before actuating the 
crosspoint switch (destination button SDIout1, then, source button SDI 1 ch1). The Advanced Fill 
tool can automate the creation of these audio breakaway sources saving a great deal of setup time.

To create source labels with assignments for SDI and embedded audio, with audio 
breakaways

1. Define one level for SDI Video and 16 levels for the embedded audio as outlined in the section 
“Defining the Levels in a Database”.

2. Select an entry point in the Sources tab from where the new labels and assignments will begin.

a. Double-click the Sources node located under the Database node.

The Sources tab opens. 

b. Select the cell of the row for the entry point. The new entries will be inserted below this row.

c. Click Edit > Fill.

The Breakaway Fill dialog opens.

Table 6  Example 1

SDI Level Level A1 Level A2 Level A3 Level A4
Source Name

SDI 1 ch3 <blank> In[1].audio.ch
3

In[1].audio.ch
3

In[1].audio.ch
3

In[1].audio.ch
3

Destination Name

SDI out1 Out[1].sdi.ch1 Out[1].audio.c
h1

Out[1].audio.c
h2

Out[1].audio.c
h3

Out[1].audio.c
h4
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3. From the Fill menu, select Entire Slot.

4. In the Name field, type a label prefix. Enter a trailing space to ensure a space between the 
prefix and the numerical counter.

5. From the Slot menu, select the Ultrimix enabled slot in the Ultrix router. (e.g. Ultrix.slot1)

6. From the AUX Port menu, define the router AUX ports.

7. From the Port menu, select the first port of the Ultrimix enabled slot. (e.g. Ultrix.slot1.out[1])

8. From the Starting Channel menu, select the first channel in the series.

9. In the Levels table of the dialog, assign physical ports to the levels. 

10. Select the BRK I/O box for the Levels assignment to be broken out to a separate 
label/assignment definition.

11. Select the BRK Level box for each level to be included in that label/assignment definition.

12. Click Apply.

The dialog closes, and the Source tab updates with the newly created and insert labels with 
assignments, and the audio breakaways definitions.

 Notice the chx automatic suffix to the label. This may be overridden by placing text in the BRK 
Suffix cell of the Breakaway Fill dialog.
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Creating Categories
You can assign each destination, source, and level to a specific category in the router database. 
Defining multiple categories enable you to filter the sources, destinations, and level and organize 
them into logical groups. Each database provides up to six categories that you can define.

For More Information on...
• managing the categories for your Ultricore BCS database, refer to the chapter “Using 

Categories”.

Managing your Databases
A database can be archived by saving it as a *.uda file to a specified location. This enables you to 
import and export an archived database which is useful for:

• creating a safe, off-frame copy of a default database configuration
• importing a copy of a reference database that can be tailored to a specific application
• duplicating a database from one system to another
• restoring a known backup copy of a database to an Ultricore BCS

 This feature requires DashBoard v8.2 or higher.

Overview
The following information is captured when you archive a database:

• Definitions of levels, sources, and destinations
• Salvos
• Category assignments
• Soft panels
• User assigned port labels
• Current crosspoint status

 The following information is not captured: hardware specifics, and license settings.

Exporting a Database
You create an archive of a database (as a *.uda file) using the options in the System Status > 
Transfer tab.

To export a database to the archive

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Click Ultricore Database.

4. Locate the Export area on the tab.

5. Use the Database field to specify the database to export.

6. Click Browse... to specify the location to save the *.uda file to.

The Archive read-only field updates with the selected path and database name.

7. Click Apply.

The Downloading Archive dialog opens to report the status of the export.
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Importing a Database
Once a database is imported from the archive to your system, you can select it from the list of 
databases to load in the System Status > Database tab.

 The database is not automatically loaded.You must follow the procedure “Loading a Database” 
to load the imported database.

To import a database to an Ultricore BCS

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Transfer tab.

3. Click Ultricore Database.

4. Locate the Import area on the tab.

5. Select the *.uda file you wish to import as follows:

a. Click Browse... 

The Open dialog opens.

b. Use the Open dialog to specify the *.uda file to import.

c. Click Open to close the dialog and load the file.

6. Click Apply.

The Uploading Archive dialog opens to report the status of the transfer.

7. Verify that the imported database is now available for selection in the System Status > 
Database tab.

Deleting a Database
 Ensure the database that you are about to delete is not currently loaded and in use by Ultricore 

BCS.

To delete a database

1. In the Tree View, double-click the System Status node.

The System interface displays in the DashBoard window.

2. Select the Database tab.

3. From the Delete Database Name menu, select the database you want to delete.

4. Click Database Delete.
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Tallies
The Ultricore BCS accepts TSL UMD tally messages, and passes tally status notifications to 
configured Ultriscape Heads.

Tally Types
Tally information may be associated with either routing system sources or destinations. Below is a 
summary of the implementations.

 Ultricore BCS does not support Unicode characters.

Source Association

Tally IDs associated with routing system sources may serve two purposes:

1. Trigger any Ultriscape Multi-Viewers to display tally status (this requires that the Ultrix router 
has at least one Ultriscape Head enabled and configured).

2. Enable the tally status to be mapped to other Tally IDs based on router crosspoint status (the 
destination must have a Tally ID associated and Tally Redirect enabled).

To associate Tally IDs to sources in the database:

• Use the Sources tab in the Database interface to associate the Tally IDs with logical sources in the 
Ultricore BCS database.

• Choose the UMD “Tally Level” using the Tally Status Level menu in the Levels tab.

Destination Association

A Tally ID may be associated with routing system destinations using the options in the Database > 
Destinations interface. Three modes of operation are available:

• Normal — The database name of the connected source is placed in the Display Data field of the 
destination Tally ID message (an outgoing connection is required; TSL v3.1 only). When the Tally 
ID is associated with an Ultriscape PiP (slotn.headx-pip[y] or slot0.pip[y]), any assertion on this 
Tally ID will directly control the PiP tally visual elements and override any Tally associated with the 
PiP video source.

• Redirect — The destination Tally ID follows the connected source Tally ID. For example, when a 
source is switched to a destination on the selected Tally Level, the Ultrix forwards the tally status 
of the source that is active on the destination, but the outbound TSL message has its display ID 
re-mapped to the display ID that is associated with the destination. An outgoing connection is 
required.

• Routed — The connected source Tally ID follows the destination Tally ID. Any configured 
Ultriscape PiPs showing this source will use destination Tally ID status to assert Tally Indicators or 
Tally Borders.

 Ensure the destination Tally IDs do not conflict with Tally IDs asserted by other devices.

Tally ID Format
Table 7 summarizes the format that the TSL protocol defines Display IDs that are associated with 
the tally displays.
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Keep the following in mind when using tally display IDs:

• TSL v3.1 and 4.0 protocol messages will always map to screen 0.
• When using TSL v5.0, the screen ID is assumed to be 0 if no screen ID is entered.
• If the controller is configured for either v3.1 or 4.0 protocol, it is not necessary to enter a screen 

ID.
• If the controller is configured for v5.0, it is only necessary to specify the screen ID if the tally 

controller is configured to send messages to tally displays on ‘screens’ other than the one with 
the screen ID of 0.

Router Tally Output Operation
Ultricore BCS will track current Tally Status messages sent by a controller via Tally Display IDs 
associated with router sources. When a source (with a Tally ID) is routed to a destination (with a 
Tally ID), the router will emit Tally Status messages that reflect the current tally status of the Tally ID 
associated with the source, but that target the Display ID associated with the destination.

 An outgoing connection point must be defined for Ultricore BCS to send the new status out.

Example

Consider the following source and destination configurations:

For the above configuration settings, the following states are possible: 

Table 7  TSL Protocol — Tally ID Format

TSL Protocol 
Version Tally ID Format Range

3.1 <displayID> 0 - 127

4.0 <displayID> 0 - 127

5.0 <screenID>:<displayID> 0 - 65535 : 0 - 65535

Table 8  Example of Sources and Destinations Assigned to Tally IDs

Name Tally ID Tally Status
Sources

Src 1 5 T1:on

Src 2 10 T1:off

Destinations

Dest 1 33 T1:xxx

Table 9  Example of Sources and Destinations Assigned to Tally IDs

Router Status Tally Status
Src 1 > Dest 1 TallyID 33 T1 = TallyID 5 T1 (on)

TallyID 33 Display Data = Src 1

Src 2 > Dest 1 TallyID 33 T1 = TallyID 10 T1 (off)
TallyID 33 Display Data = Src 2
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Tally Routed Mode

The Tally Routed mode associates a tally with a specific router destination. Ultricore BCS knows 
which input is routed to that output, and so can assert tally indicators wherever the input signal is 
displayed in an Ultriscape PiP. Refer to the Ultrix User Guide for details on this mode.

Getting Started
You must first perform the following in the active database:

1. If RS-232 or RS-422 communication is required, add a serial connection point for TSL protocol 
support.

2. Add an ethernet connection point for output TSL protocol support if not using serial as outlined 
in step 1.

3. Enable Tally ID support.

4. Assign the Tally IDs to the sources.

5. Assign the Tally IDs to the destinations.

6. Set the Tally mode to None.

Adding an Ethernet Connection Point
An Ethernet connection point must be added for outgoing TSL protocol support. Incoming Ethernet 
services are natively available. Refer to “Outgoing Ethernet Connections” for details on adding an 
Ethernet connection point to third-party devices.

Enabling Tally ID Support
To enable tally ID configuration in an active database, you must select the Enable Tally box on the 
System Status > Database tab, and then define the Status Level for tally operation.

Enabling Tally ID Support in the Active Database
Once support is enabled, the Source and Destinations tabs display a Tally column which is used to 
assign Tally IDs to sources and/or destinations in the active database.

To enable tally ID support in the active database

1. In the Tree View, double-click the System Status node.

The System interface displays in the DashBoard window.

2. Select the Database tab.

3. Verify that the active database is the one you wish to enable tally ID support for.

4. Select the Enable Tally box located in the Current Database area.

The Source and Destinations tabs automatically update to display the Tally column.

Defining the Status Level for Tally Operation
The Status Level specifies which level in the routing system is used to determine the current source 
switched to a given logical destination.

Generally this should be the main SDI Video level; which in most systems is the level to which the 
Ultriscape Head PiP and/or Router Video destinations are mapped in the system database.
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To define the status level for tally operation

1. Double-click the Levels node located under the Database node.

The Levels tab opens.

2. Use the Tally Status Level menu (located at the bottom of the Levels tab) to specify the Level 
in the active database that will determine the tally status.

Assigning the Tally IDs to the Sources
Assigning a Tally ID to an Ultricore BCS source enables configured Ultriscape displays to show tally 
information.

 Before proceeding, ensure you verify which TSL protocol you are using. The protocol determines 
how you must enter the information into the Tally cells of the Sources tab. Refer to Table 7 for 
details.

To assign a Tally ID to a source in the database

1. Double-click the Sources node located under the Database node.

The Sources tab opens.

2. Verify that the Tally column displays in the Sources tab. If it does not, refer to the section 
“Enabling Tally ID Support in the Active Database”.

3. Select the cell in the Tally column of the Sources tab to assign the Tally ID to.

4. Type the Tally ID you wish to assign to that source.

5. Press Enter to apply the change.

6. Repeat steps 3 to 5 for each source you wish to assign a Tally ID.

7. Click Apply at the bottom of the Sources tab to save your changes.

Assigning the Tally IDs to the Destinations
Assigning a Tally ID to an Ultricore BCS destination enables the pass-through of source tally status 
to a configured destination in the database. 

 An outgoing connection point (either ethernet server or RS232/422 port) is required for the 
router to emit tally information. Refer to “Connecting to Third-Party Devices” for details.

TallyID 41 is associated with Src 1 in the 
Ultricore BCS database. (TSL UMD v3.1 and v4.0)

Tally Screen 5, ID 41 is associated with Src 1 in 
the Ultricore BCS database. (TSL UMD v5.0)

Figure 6  Example of Sources with Assigned Tally IDs
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 Before proceeding, ensure you verify which TSL protocol you are using. The protocol determines 
how you must enter the information into the Tally cells of the Destinations tab. Refer to Table 7 
for details.

To assign a Tally ID to a destination in the database

1. Double-click the Destinations node located under the Database node.

The Destinations tab opens.

2. Verify that the Tally column displays in the Destinations tab. If it does not, refer to the section 
“Enabling Tally ID Support in the Active Database”.

3. Select the cell in the Tally column of the Destinations tab to assign the Tally ID to.

4. Type the Tally ID you wish to assign to that destination.

5. Press Enter to apply the change.

6. Select the Tally Redirect box to enable the connected source Tally ID to be directed to this 
destination Tally ID.

7. Repeat steps 3 to 6 for each destination you wish to assign a Tally ID.

8. Click Apply at the bottom of the Destinations tab to save your changes.

Tally ID 51 follows the connected source 
associated tally. This requires an 
established outgoing connection point. 
(TSL UMD v3.1 and v4.0 TallyID format). 

Tally Screen 4, ID 11 follows the 
connected source associate tally. This 
requires an established outgoing 
connection point. (TSL UMD v5.0 TallyID 
format).

The label of the source currently 
connected to DST 1 will be sent as TSL 
text on Tally ID 5. (TSL UMD v3.1 only).

When Tally ID 8 is asserted, any PiPs 
showing the same source as routed to 
DST 1 also have their tally asserted (if 
defined on the PiP). For example, if DST 1 
has source CAM 1 routed to it, and one or 
more UltriScape PiPs also had source 
CAM 1 displayed, the PiP would display 
tally data from Tally ID 8.

The label of the source currently 
connected to destination DST 1 will be 
output as text in a TSL 3.1 message with 
Tally ID 11. The UltriScape PiP displays the 
tally information from Tally ID 11 
regardless of the displayed source video. 

The UltriScape PiP displays tally 
information from the connected source 
associated Tally ID.

Figure 7  Example of Destinations with Assigned Tally IDs
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Using Categories
Category navigation enables you to organize the sources, destinations, and/or levels in a router 
database to defined categories. There are three types of categories each with independent 
interfaces:

• Group — allows a user to organize database resources (sources, destinations, and levels) into 
folders and sub-folders with arbitrary group name. Resources may be assigned to multiple 
groups if required.

• Cat/Index — allows a user to piece together or build up the final resource name from category 
names and index identifiers.

• Legacy — allows compatibility with earlier RCP-QE models. Note that this is not available as a soft 
panel.

Group Categories Overview
 Group category mode is only available when using an Ultrix router or Ultricore running software 

version 2.0 or higher.

Group Category allows the user to organize database resources (sources, destinations, and levels) 
into folders and sub-folders with arbitrary group names. The group name is not required to match 
the resource names (it is similar to setting up file folders). This group categorization is useful when 
you need to group resources based on their operational regions, events, personnel credentials etc.

Example of a Group Category Setup

A user wants to arrange sources and destinations based on the types of sports the network 
broadcasts: baseball and football. The resources available are: 

The resources need to be arranged into the following groups based on the sport type: 

Sources Destinations

Baseball Football
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The Group Category interface would be used to arrange the resources into group categories:

Figure 8  Example of Group Categories Arrangement Based on Sport Type

Once the group categories are defined, the user can perform switches, on a hard or soft panel, 
based on the group categories.

In the example below, the user uses RCP-QE18 to select the source labeled as HD 3.

Figure 9  RCP-QE18 — Selecting HD 3 via Category Mode

In the example below, the user uses a soft panel to select the destination labeled as SAT 1.

Baseball Football
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Figure 10  Ultricore BCS — Selecting SAT 1 via a Soft Panel

Configuring Group Categories
Group categories are arranged in a hierarchy and displayed in a tree view. This is similar to the file 
system on your PC where each group is represented as a folder or node, and the resources 
included in that group are nodes. Each type of resource is represented within the hierarchy as 
follows: sources are green, destinations are blue, and levels are red. (Figure 11)

Figure 11  Example of Group Categories Tree View

Configuring group categories requires:

1. Creating group names

2. Assigning destinations, sources, and/or levels to groups

3. Configuring a soft panel or a hard panel for use
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Creating Group Names
For each database, you can create multiple category groups and add sub-groups. For example, 
Figure 11 shows two main groups (MV, and SDI) where the SDI group also has four sub-groups 
(Slot1, Slot2, Slot3, and Slot4). Once you create your groups, resources can be added.

 Ultricore BCS does not support Unicode characters.

 By default, the groups are organized alphabetically in the tree view.

To create a category group

1. Double-click the Group Categories node located under the Database node.

The Group Categories tab opens.

2. Select the Group Categories: node.

3. Click Add.

The Add Group dialog opens.

4. In the Name field, type a unique identifier for the new group.

5. Click Apply.

The Add Group dialog closes and the new group is added as a child of the selected node.

In the example below, a new sub-group “Studio 1” was created below the SDI group.

6. Click Apply in the bottom right corner to apply your changes.

To create a category sub-group

1. In the Group Categories tree, select the group icon that you wish to add a sub-group to.

2. Click Add.

The Add Group dialog opens.

3. In the Name field, type a unique identifier for the new sub-group.
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4. Click Apply.

The Add Group dialog closes and the new sub-group is added to the Group Categories tree 
view.

In the example below, a new sub-group “Cameras” was created within the Studio 1 group.

5. Click Apply in the bottom right corner to apply your changes.

To move a group within the tree view

1. In the Group Categories tree, select the group you want to move.

The Move dialog opens. Notice that the dialog header displays the name of the selected group 
to move.

2. Use the tree view in the dialog to select where to move the group to.

In the example below the Audio sub-group was selected to move to the Studio 1 root.

3. Click Apply.

The Move dialog closes and the group displays in the selected position of the tree view.

4. Click Apply in the bottom right corner to apply your changes.

Auto Generating the Groups
You can also choose to create a group based on the levels, sources, and destinations in your 
database or a combination. This requires the virtual labels for each resource to be consistent. For 
example, if all destinations are labeled as Dest x, a group will be created called “Dest” with each 
destination listed as a separate node.

 Auto generating a group will delete the groups currently listed in the Group Categories tree view.
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To auto generate a group

1. Click Auto Generate.

The Auto Generate Groups dialog opens.

2. Select the box to include the resources in the group.

3. Click Apply.

The Auto Generate Groups dialog closes and the Group Categories tree updates.

4. Click Apply in the bottom right corner to apply your changes.

Assigning Resources to a Group
Once a group is configured, you can assign resources (destinations, sources, levels).

To assign a resource to a group

1. In the Group Categories tree, select the group you want to add a resource to.

The middle pane of the Group Categories interface updates to list the sub-groups or resources 
assigned to it.

In the example below the area is blank because nothing is assigned to the selected group.
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2. In the right pane, select the tab for the type of resource you wish to assign to the group.

In the example above, the Destinations tab was selected.

3. To assign a single resource, select the resource from the tab.

4.  To select a series of resources:

a. In the selected tab, select the first resource in the series you want to assign.

b. Press and hold Shift.

c. Click the last row in the series.

5. Click Assign.

The Group Categories tree updates to display the selected resources in the group.

In the example below, Dest 1 to Dest 6 were assigned to the Studio 1 group.

6. Click Apply in the bottom right corner to apply your changes.
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To move a resource to another group

1. In the Group Categories tree, select the resource you want to move.

2. Click Move.

The Move dialog opens.

3. Select the new location for the resource.

4. Click Apply.

The Move dialog closes.

The Group Categories tree updates to display the resource in the new location. Notice that the 
resource is now removed from the original group.

5. Click Apply in the bottom right corner to apply your changes.

To delete a resource from a group

1. In the Group Categories tree, select the specific resource you want to delete from the group.

2. Click Delete.

The Delete dialog opens.

3. Click Yes.

The Delete dialog closes.

The Group Categories tree updates to no longer display the resource in the group. 

4. Click Apply in the bottom right corner to apply your changes.

To delete a series of resources from a group

1. In the Group Categories tree, select the specific group you want to edit.

The middle pane of the Group Categories interface updates to list the sub-groups or resources 
assigned to it.

2. In the middle pane, select the first resource in the series you want to delete.

3. Press and hold Shift.

4. Click the last row in the series.

5. Click Delete.

The Delete dialog opens.

6. Click Yes.

The Delete dialog closes.

The Group Categories tree updates to no longer display the resource in the group. 

7. Click Apply in the bottom right corner to apply your changes.

Managing the Groups
 You cannot rename resources using the options in the Group Categories interface.

To rename a group

1. In the Group Categories tree, select the specific group you want to rename.

2. Click Rename.

The Rename Group dialog opens.

3. Use the Name field to enter a unique identifier for the selected group.
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4. Click Apply.

The Rename Group dialog closes.

The Group Categories tree updates to display the new name for the group. 

5. Click Apply in the bottom right corner to apply your changes.

To delete a group

1. In the Group Categories tree, select the group you want to delete.

2. Click Delete.

The Delete dialog opens.

3. Click Yes.

The Delete dialog closes.

The Group Categories tree updates to no longer display the group. 

4. Click Apply in the bottom right corner to apply your changes.

Cat/Index Categories Overview
Cat/Index category mode (also referred to as Category Index mode), allows alpha-numeric 
extensions to labels to 'build up' the final label selection. For example, VTR 1 - 6 may be expressed 
as a VTR label with numerical extensions 1 through 6. Similarly, alpha extensions may be used, for 
example, VTR A - E for VTRs A through E.

Destination and source names are split into substrings - the first substring traditionally referred to 
as the category, and subsequent substrings the indexes (e.g. Category VTR index 1 through 6). As 
source/destination names become more complex, an index may not be the final part of the 
selection name. For example, consider the source names CG TX 1 and CG TX 2; Cat/Index category 
mode may be configured so that a user selects CG, then TX, then either 1 or 2. This may be 
extrapolated to cover a large range of sources and destinations.

Example of a Cat/Index Category Setup

The resources available are: 

Sources / Destination Names
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The possible categories and indexes would be: 

Once the Cat/Index categories are defined, the user can perform switches, on a hard or soft panel, 
based on the categories.

In the example below, a RCP-QE18 is used to select the source labeled as CAM 1. Notice that only 
the sources are available for the second button selection. In this example, the user would need to 
select TAKE to make the switch.

Figure 12  RCP-QE18 — Selecting CAM 1 via Category Mode

Configuring a Cat/Index Category Setup
Configuring Cat/Index categories requires:

1. Assigning categories

2. Assigning indexes

3. Configuring a soft panel or a hard panel for use

Assigning Categories
You can assign each destination to a specific category or multiple categories in a database. Using 
multiple categories enable you to filter the destinations, and organize them into logical groups. By 
default, categories are organized in alphabetical order.

Categories Indexes

CAM_a

a.The “_” characters represents a blank space. This indicates the 
category will filter resources with a space in the name (e.g. the CAM_ 
category will allow resources named CAM 1, CAM 2 but not CAM3).

1 5 D

SAT_ 2 A E

CG_ 3 B RX_

EDIT_ 4 C TX_

VTR
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To auto generate categories based on a database

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Generate.

The Auto-Generate dialog opens.

3. Click Yes.

The Auto-Generate dialog closes.

All previous categories are deleted from the Categories pane and new ones are listed based on 
the resource labels in your database.

4. Click Apply.

To manually create categories

1. In the Cat/Index Categories tab, click Add.

The Add Category dialog opens.

2. Use the Name field to specify a unique identifier for the new category.

 The entry must match a resource name prefix.

Some example entries would be:

• “CG_” creates a category to categorize resources named CG_xxxx where xxxx is any index.
• “CG” creates a category to categorize resources named CGxxxx where xxxx is any index.
• “cg” will not categorize any resources as the category names are case sensitive.

3. Select the Insert trailing space box to represent a space character with the “_” symbol.

4. Click Apply.

The Add Category dialog closes.

The new category is listed in the Categories pane.

5. Click Apply.
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Assigning Indexes
An index for a category enables you to filter resources. For example:

• “TX_” creates a sub-index of TX, meaning further entry is required on the control panel. This will 
filter resources named <category name>TX_xxxx where xxxx is any index.

• “TX 1” creates an ‘end-point’ index, meaning TX 1 is the last substring and no further entry is 
required on a control panel. This will filter resources named <category name>TX 1. You cannot 
create an index of “TX 1” and a sub-index of “TX_”. You must choose one or the other.

As category names and indexes are entered, the affected Resources list in the interface will update 
to indicate which sources or destinations of a given category is accessible on a control panel. Select 
a category name in the categories list to see which source or destinations are in that category and 
filtered by the available Indexes list. 

To manually create categories

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens

2. Click Add (located next to the Categories pane).

The Add Category dialog opens.

3. Use the Name field to specify a unique identifier for the new category.

 The entry must match a resource name prefix.

For example:

• “CG_” creates a category to categorize resources named CG_xxxx where xxxx is any index.
• “CG” creates a category to categorize resources named CGxxxx where xxxx is any index.
• “cg” will not categorize any resources as the category names are case sensitive.

4. Select the Insert trailing space box to represent a space character with the “_” symbol.

5. Click Apply.

The Add Category dialog closes.

The new category is listed in the Categories pane.

6. Click Apply.

To create a category for a specific resource type

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Create for the resource type you wish to filter. 

The Create Category/Index dialog opens.

3. Use the Category Name field to specify the characters for the new index filter. 

 The entry must match a partial resource name.

4. Select the Insert trailing space box if you wish to include trailing spaces in the filter.

5. Click Apply.

The Create Category/Index dialog closes.

6. Click Apply.
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Assigning Index Filters
An index for a category enables you to filter resources. As category names and indexes are entered, 
the Affected Resources pane in the interface will update to indicate which sources or destinations 
of a given category is accessible on a control panel. Select a name in the Categories pane to see 
which source or destinations are in that category and filtered by the available Indexes pane. 

To assign an index filter

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Add (located next to the Indexes pane).

The Add Index dialog opens.

3. Use the Name field to specify a new index filter. 

 The entry must match a partial resource name.

For example:

• “TX_” creates a sub-index of TX, meaning further entry is required on the control panel. This 
will filter resources named <category name>TX_xxxx where xxxx is any index.

• “TX 1” creates an ‘end-point’ index, meaning TX 1 is the last substring and no further entry is 
required on a control panel. This will filter resources named <category name>TX 1.

• Note that you would not create an index of “TX 1” and a sub-index of “TX_”. You must choose 
one or the other.

4. Click Apply.

The Add Index dialog closes.

The new index filter is listed in the Indexes pane.

5. Click Apply.

To assign an index filter for a specific resource type

1. Double-click the Cat/Index Categories node located under the Database node.

The Cat/Index Categories tab opens.

2. Click Create for the resource type you wish to filter. 

The Create Category/Index dialog opens.

3. Use the Index Name field to specify a unique identifier for the new index filter.

 The entry must match a partial resource name.

4. Select the Insert trailing space box if you wish to include trailing spaces in the filter.

5. Click Apply.

The Create Category/Index dialog closes.

6. Click Apply.

Legacy Categories Overview
Legacy Category mode allows some category functionality on older RCP-QE control panels (17 
button). There is no soft panel for Legacy Category Mode. Legacy mode is similar in operation to 
Group category mode with some elements of the index functionality of the Cat/Index Category 
mode.



104 • Using Categories Ultricore BCS User Guide (v9.0)

Legacy mode limitations;

• A destination or source cannot be in more than one category
• Only numerical indexes are supported

For More Information on...
• the legacy category mode, refer to the RCP-QE User Guide.

Configuring Legacy Categories
Source and destination selection may be achieved in two ways: direct selection or numerical index 
entry. The setup of the Ultricore Category tables determines the operational functionality.

Category Direct Selection Mode
Figure 13 illustrates the Categories configured in the Ultricore database for direct selection mode.

Figure 13  Ultricore — Entries in the Categories Tab

Figure 14 illustrates direct destination entries and the resulting available destinations in the 
selected category.

Figure 14  Ultricore BCS — Resulting Operation

To set up direct selection in categories

1. Display the Categories tab in DashBoard for the Ultricore as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Categories node.

2. Click Destination or Source as required.

3. Type the text for a category name in column 'Category 1' for each row that is required to be in 
that category.

4. Copy the items in the name column to the Category 2 column. 

 You can use keyboard shortcuts such as Ctrl+C (copy) and Ctrl+V (paste) and Shift+click to select 
a range for ease of data entry.

This will result in those rows being within the category you named in column Category 1.
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Numerical Index Entry Mode
Figure 15 illustrates the Categories configured in the Ultricore database for numerical entry mode.

Figure 15  Ultricore — Entries in the Categories Tab

Because we have set the VTRs numbered 6 through 10 in Figure 15, the Ultricore BCS expects a two 
digit entry signified by the two underlines on the button next to the category name. As only 
numerals 1 or 0 are the only possible entries to make for the first digit, the Ultricore BCS has 
blanked the invalid entry keys. (Figure 16)

To select VTR 6, press 0 then the remaining available numbers will become available, then press 6 to 
finish the selection. 

Figure 16  Ultricore BCS — Resulting Operation

To set up numerical index selection in categories

1. Display the Categories tab in DashBoard for the Ultricore as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Categories node.

2. Click Destination or Source as required.

3. Enter a category name in the Category 1 column for each row that is required to be in that 
category. For example, in Figure 15 the user entered “VTR”.

4. Enter a number in the Category 2 column.

This will result in those rows being within the category you named in the Category 1 column. 
These destinations are accessible via entering the numerical extension of the required 
destination. For example, in Figure 15 the user entered “6” for row 5.

Creating a Soft Panel with Categories
Once you have defined your categories and tags for each level of a database, you can create a 
custom soft panel using the category settings as a basic for arranging the sources, destinations, and 
levels.

For More Information on...
• managing your Category panels, refer to “Using Category Panels”.
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Soft Panels in DashBoard
A soft panel is a software implementation of a physical remote control panel (RCP). The soft panel 
configurations are part of a database so any instance of DashBoard connecting to a given Ultricore 
BCS has the defined soft panels available. You can customize a soft panel by defining the sources, 
destinations, levels, and/or salvos that will be available on the panel interface. Ultricore BCS 
provides the following types of soft panels for control; 

• Matrix — the destinations and sources are organized into a grid layout.
• MultiBus — the destinations and sources are organized into separate a rows (buses) of buttons.
• Cat/Index Category — the resources are defined using a defined set of search criteria (indexes).
• Group Category — the destinations and sources are grouped by pre-defined categories.
• Ultritouch PB — the resources are organized into a customized layout that is pre-sized for an 

Ultritouch hard panel. Refer to the Ultritouch User Guide for details.
• Push Button — similar layout and features of the Ultritouch PB panel but sized for use on a 

computer monitor.
• Audio Mixer — Creates an audio mixer soft panel suitable for a desktop monitor where multiple 

rows of audio channel strips are possible. Refer to the Ultrix User Guide for details.
• Audio Mixer 4RU — Creates an audio mixer soft panel formatted for an Ultritouch-4 panel. Refer 

to the Ultrix User Guide for details.
• Audio Mixer 2RU — Creates an audio mixer soft panel formatted for an Ultritouch-2 panel. Refer 

to the Ultrix User Guide for details.

Before You Begin
Keep the following in mind when managing your soft panels in DashBoard:

• Soft panels require the setup of the database source/destinations/levels and port assignment to 
be complete.

• If the database changes (source/destination/level/salvo addition or deletion), you will need to edit 
the soft panel configuration to ensure the correct sources/destinations/levels/salvos are visible.

• Ultricore BCS does not support Unicode characters.

For More Information on...
• databases, refer to the chapter “Database Configuration”.

Soft Panels Overview
A soft panel is created using the options in the Panels interface for your database. Soft panels are 
listed as sub-nodes under the Soft Panels node in the Tree View of DashBoard. Double-click a 
sub-node to display the corresponding soft panel in the DashBoard window. The hierarchy of the 
nodes in the tree is determined by their Panel ID which is assigned when the soft panel is created in 
the database. In Figure 17 there are seven soft panels in the tree view.
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Figure 17  Example of a Soft Panels Tree View

A soft panel can be as simple or complex in its layout as you require. The Panels interface enables 
you to specify the number of destinations, sources, levels, and salvos displayed on your panel. You 
select a soft panel type and specify the elements of the soft panel including giving the panel a 
unique name. 

For More Information on...
• Matrix panels, refer to “Using Matrix Panels”.
• Multibus panels, refer to “Using MultiBus Panels”.
• Category panels, refer to “Using Category Panels”.
• Ultritouch PB panels, refer to the Ultritouch + Ultrix User Guide.
• Push Button panels, refer to “Using Push Button Panels”

Enabling Machine Control
Typically, the ports on a data router (such as the NK-M series routers) are bi-directional where there 
is both a transmit (input to output) and reciprocal receive connection that is made for each port. For 
example, a switch from port 1 to port 2 involves a forward path (from port 1 input to port 2 output) 
and the reciprocal connection from (port 2 input to port 1 output).

In some cases however, there is a need to connect on the port's input to several ports’ output (e.g. 
one device commanding many target devices) without making the reciprocal connection. This 
allows the commanding device to just broadcast commands and not receive from the many devices 
it communicates with. 

When configuring a soft panel, you have the option to add a Machine Control button to the panel. 
When selected on the panel, this Machine Control button sends a Take request directed to an NK-M 
series data router to automatically make the reciprocal port switch. On a video router, the 
connection is all one way from an input port to an output port (e.g. such as from IN 1 to OUT 2). 

Creating a Soft Panel
Soft panels are listed under the Soft Panels node in a hierarchy as determined by their Panel ID. 
When you create a new soft panel, you select from the three existing soft panel types: Matrix, 
MultiBus, and Categories. You then assign a Panel Name and ID to display in the tree view using the 
nomenclature “Panel Name [#]” where [#] is the Panel ID.

 A Default Panel is available that is a MultiBus style with 1 level, 4 destinations, and 4 sources.
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To create a soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. Click Edit > Add.

The Add Panel dialog opens.

3. Type a unique identifier in the Name field. This will be used to identify the panel in the tree 
under the Soft Panels node.

4. Use the Style menu to specify the type of panel to create. Choose from the following:

• Matrix — Creates a soft panel that organizes the destinations and sources in a grid layout.
• MultiBus — Creates a soft panel where destinations and sources are organized into separate 

buses.
• Category — Creates a soft panel where destinations and sources are arranged as 

determined by the Category tab. Refer to “Using Categories” for more information.
• Push Button — Creates a soft panel that organizes the destinations and sources in a distinct 

vertical layout.
• Ultritouch PB — Creates a soft panel that is used on an Ultritouch hard panel. Refer to the 

Ultritouch User Guide for details.

5. Click Apply to save your settings and close the Add Panel dialog.

The new panel name is added to the Save Panels list of the Panels tab and automatically 
selected in the tab for editing.

6. Select the Info tab.

7. Use the Panel ID menu to determine the position of the panel in the Soft Panels tree where a 
value of “1” is the highest priority (and listed at the top).

 Ensure that the new soft panel does not use the same Panel ID as a previously saved panel.

8. Use the Description field to provide a textual summary of the panel. 

9. Use the Protection Operation menu to provides options for preventing crosspoint switches. 
Choose from the following:

• Enable — The Lock, Protect, and Free buttons display on the soft panel. Refer to “Using 
Matrix Panels” or “Using MultiBus Panels” for a description of these buttons. 
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• Disables — The Lock, Protect, and Free buttons do not display on the soft panel. These 
protection options are not available for the soft panel.

10. Use the Take Operation menu to configure the Take button for the soft panel. Choose from 
the following:

• Confirm — Displays a Take button on the soft panel. You must select the Take button to 
perform a crosspoint switch.

• Direct — The soft panel does not display a Take button. A crosspoint switch occurs 
automatically after each destination/source selection made by the user on the soft panel.

11. If you selected MultiBus in step 4, use the Selection Operation menu to enable multiple 
crosspoint/level selections and display the Multi Select button. Choose from the following:

• Single — Disables this feature. The Multi Select button does not display on the soft panel.
• Multi — The Multi Select button displays on the soft panel.

12. Use the Machine Control menu to control whether a Take request directed to an Ross NK-M 
series data router automatically makes a reciprocal port switch. Choose from the following:

• Enable — Displays a Machine Control button on the soft panel. You must select the 
Machine Control button to enable the reciprocal port switch on the NK-M series router.

• Disable — The soft panel does not display a Machine Control button. This is the default 
setting.

13. If you set the Style to Push Button, proceed to “Configuring a Push Button Soft Panel”.

14. Click Apply to save your new soft panel.

The new panel displays in the Soft Panels tree. In the example below, there are seven panels in 
the tree view. Note that the Priority ID is the value displayed in the [#] brackets.

15. Continue to the next sections to add levels, destinations, sources, and salvos to your soft panel 
as required.

Levels for the Soft Panel
You can specify the total number of levels available on the soft panel to the user. For example, if 
you set the Viewable levels to 6 but have assigned 8 levels to the panel, only the first six levels in the 
Assigned list are displayed.

To specify the levels for the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Levels tab.

3. Use the Viewable levels field to specify the total number of levels for the soft panel.

4. To add a level to the soft panel:

a. From the Available list, select the level(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected level(s).
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5. To assign all the available levels in the database to the soft panel, click .

6. To assign multiple levels to the soft panel:

a. From the Available list, select the first level you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other level(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected levels.

7. Use the provided buttons beside the Assigned list to determine the order in which the levels 
are displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Destinations for the Soft Panel
You can create a soft panel with a specified number of destinations and determine the order in 
which they are displayed in the crosspoint row of the panel. For example, the database may have 32 
destinations but you only want to make the first 4 outputs selectable on the crosspoint row of your 
soft panel. You would then set the Viewable destinations to 4. You can also specify the order in 
which the destination buttons are displayed on the soft panel.

To specify the destinations for the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Destinations tab.



112 • Soft Panels in DashBoard Ultricore BCS User Guide (v9.0)

3. Use the Viewable destinations field to specify the total number of destinations for the soft 
panel.

4. To add a destination to the soft panel:

a. From the Available list, select the destination(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected destination(s).

5. To assign all the available destinations in the database to the soft panel, click .

6. To assign multiple destinations to the soft panel:

a. From the Available list, select the first destination you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other destination(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected destinations.

7. Use the provided buttons beside the Assigned list to determine the order in which the 
destinations are displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Sources for the Soft Panel
You can create a soft panel with a specified number of sources and determine the order in which 
they are displayed in the crosspoint row of the panel. For example, the router may have 64 sources 
but you only want to make the first 12 inputs selectable on the crosspoint row of your soft panel. 
You could set the Viewable sources to 12 or assign only those 12 inputs to the soft panel. You can 
also specify the order in which the source buttons are displayed on the soft panel.

To specify the sources for the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Sources tab.

3. Use the Viewable sources field to specify the total number of sources for the soft panel.

4. To add a source to the soft panel:
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a. From the Available list, select the source(s) you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).

5. To assign all the available sources in the database to the soft panel, click .

6. To assign multiple sources to the soft panel:

a. From the Available list, select the first source you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other source(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected sources.

7. Use the provided buttons beside the Assigned list to determine the order in which the sources 
are displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Salvos for the Soft Panel
Before you can add salvos to a soft panel, you must configure them as outlined in “Creating 
Salvos”.

To specify the salvos available on the soft panel

1. Double-click the soft panel name from the Panels list in the left toolbar of the Panels tab.

2. Select the Salvos tab.
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3. Use the Viewable salvos field to specify the total number of salvos for the soft panel.

4. To add a salvo to the soft panel:

a. From the Available list, select the salvo you wish to add to the soft panel.

b. Click .

The Assigned list updates to include the selected source(s).

5. To assign all the available salvos in the database to the soft panel, click .

6. To assign multiple salvos to the soft panel:

a. From the Available list, select the first salvo you wish to add to the soft panel.

b. Press Shift.

c. From the Available list, select the other salvo(s) you wish to add to the soft panel.

d. Click .

The Assigned list updates to include the selected salvos.

7. Use the provided buttons beside the Assigned list to determine the order in which the salvos 
are displayed on the soft panel.

8. Click Apply at the bottom of the Panels tab to save your settings.

Copying a Soft Panel
 Ensure the soft panel is currently not in use.

To copy a soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. From the Panels list in the left toolbar, select the soft panel to copy.

3. Click Edit > Copy.

4. Click Edit > Paste.

The Panels tab updates to display the settings for the selected soft panel. New soft panels are 
automatically named “New Panel #” where # is an auto-generated value.
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5. Select the Info tab.

6. Type a unique identifier in the Panel Name field. This will be used to identify the panel in the 
tree under the Soft Panels node.

7. Click Apply at the bottom of the Panels tab to save the new soft panel. This also helps to ensure 
that you do not mistakenly edit the original panel that you copied.

Editing a Soft Panel
Once you edit a soft panel, you must re-load the soft panel if it was in use prior to the edit.

 Ensure the soft panel is currently not in use.

To edit a soft panel

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. From the Panels list in the left toolbar, select the soft panel to edit.

The Panels tab updates to display the settings for the selected soft panel. 

3. Edit the settings for the panel using one of the following procedures:

 You cannot edit the Panel Style of a soft panel.

• “To specify the levels for the soft panel”
• “To specify the destinations for the soft panel”
• “To specify the sources for the soft panel”
• “To specify the salvos available on the soft panel”

4. Click Apply at the bottom of the Panels tab to save the new settings.

5. If a dialog opens to remind you that the affected soft panel is currently in use:

a.  Click OK to close the dialog.

b.  Perform the procedure “To re-load a soft panel”.

To re-load a soft panel

1. Close the newly edited soft panel as follows:

a. Locate the tab for the soft panel in the DashBoard client window.

b. Click  to close the tab.

2. In the Basic Tree View, expand the Soft Panels node for the Ultricore BCS.

3. Double-click the node for the newly edited soft panel.

The tab for the selected soft panel opens.

Deleting a Soft Panel from the Database
 Ensure the soft panel is currently not in use.

To delete a soft panel from the database

1. Double-click the Panels node located under the Database node.

The Panels tab opens.

2. Select the soft panel name from the Panels list in the left toolbar.

3. Click Edit > Delete.
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4. Click Apply at the bottom of the Panels tab.

Using the Lock and Protect Features
Whether your soft panel includes the Lock and Protect features depends on the panel type. The 
Matrix and Category panels can include the Lock, Protect, and Free buttons. The MultiBus panels 
can include only the Lock button. Soft panels that have their Protection Operation set to Enable 
also display these buttons (depending on the panel type).

For More Information on...
• the Protection Operation, refer to Table 60.

Using a Lock
If your soft panel includes a Lock button, you have the option to protect source/level and 
destination/level pairs. When another control panel or DashBoard client attempts to switch that 
combination, the request will be denied.

To lock a source/level pair

1. Display the soft panel in the DashBoard window.

2. Select the source/level pairs from the soft panel interface.

3. Click Lock.

The label on the button changes to Unlock and the button remains lit.

To lock a destination/level pair

1. Display the soft panel in the DashBoard window.

2. Select the destination/level pairs from the soft panel interface.

3. Click Lock.

The label on the button changes to Unlock and the button remains lit.

To clear a lock

• Click the Unlock button.
The label on the button changes to Lock and the button remains lit.

Using a Protect
A soft panel can be locked by clicking the Protect button. The button is lit until pressed again. A 
protect alarm message is displayed in the System Status tab when an output is protected.

This feature protects the currently selected destination/level pair from use by other sources, as well 
as from other linked panels. The Protect button is especially useful in instances where a 
destination must be held after a switch has been made.

To apply a protect

• Click Protect.
The button is lit. Selecting crosspoints will not take effect and the panel does not update when 
buttons are pressed.

To clear a protect

• Click Protect.
The button is no longer lit and crosspoint switches can be initiated.
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Using Matrix Panels
Matrix panels enable you to perform direct take transitions, and local salvo definitions using a grid 
of sources and destinations.

Panel Interface Overview
Each level is represented as a button in the color defined in the current database. Notice that the 
crosspoints are represented in the same color as the applicable level.

Figure 18  Example of a Matrix Panel 

1. Crosspoints

The number of Destinations and Sources available in the matrix is specified using the 
Destinations and Sources interfaces.Click within the matrix or click the Destination and Source 
buttons to select the crosspoints for switching the selected levels. In Figure 18 crosspoints were 
selected using the Advanced > Diagonal Presets option. 

2. Levels Button

Click a level button to include the level in the next crosspoint switch. A lit button indicates that the 
corresponding level will be included in the next transition. The color and name of the button are 
specified using the Levels interface. Figure 18 illustrates a Matrix panel with nine levels selected.

3. Follow Button

Click this button to select all crosspoints in the matrix. Clicking TAKE after clicking Follow will 
then switch all crosspoints at the same time on all available levels. 

4. TAKE Button

Click this button to execute the switch between crosspoints. If you are using a soft panel with the 
Take Operation set to Direct, a TAKE button is not displayed because the transitions will occur 
automatically after a crosspoint switch is selected.

5. Lock Button

Click this button to prevent switching of the selected crosspoints. If you are using a soft panel 
with the Protection Operation set to Disable, the Lock and Protect buttons are not displayed.

6. Protect Button

Click this button to prevent switching of the selected crosspoints except in the DashBoard client 
session the Protect was initiated in.
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7. Free Button

Click this button to end a lock or protect on the selected crosspoints.

8. Salvo Button

Click this button to display the Salvo menu. Refer to “Salvo Menus” for information on the menu 
options.

9. Advanced Button

Click this button to display the Advanced menu. Refer to “Advanced Menus” for information on 
the menu options.

10.Machine Control Button (not shown)

If you are using a soft panel with the Machine Control set to Enabled, the MACHINE CONTROL 
button is displayed. Refer to “Enabling Machine Control” for details on this button.

Status Quick Navigation
In multi-level systems, the status of any given crosspoint can often be such that a matrix style soft 
panel cannot show all levels. 

Figure 19  Example of Crosspoint Status in a Matrix Panel

In Figure 19, destination DST1 only shows status for the green level. It cannot show the red/blue 
levels status' as the relevant sources are outside the current view.

Right clicking the destination button/label will re-center the source buttons to the next level status. 
Subsequent right-clicking the destination button will cycle to the next level status indicator. (Figure 
20)

Figure 20  Example of a Cycled Status Indicator

Find Dialog
The Find dialog helps you to quickly navigate to known source or destination names. 
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Figure 21  Example of the Find Dialog

To access the Find dialog

1. Within the matrix panel control area, click Find.

The Find dialog opens.

2. From the Find in List menu, choose either Source or Destination as required.

3. Type the text to search for in the Find what field.

In Figure 19, the user entered out.

4. If an exact string match is required, select the Exact Match box.

5. If text case matching is required, select the Match Case box.

6. Click Next to begin the search.

The Matrix panel updates to the first match.

7. Click Next again to navigate to subsequent matches.

8. Click  to navigate to previous matches.

9. Click Close to close the dialog. 

The Matrix panel view will remain with the last match in the middle of the matrix panel view.

Filter Dialog
Use the Filter dialog to reduce the number of source and/or destinations visible in a matrix panel. 
This enable a user to filter a matrix panel view to only source/destinations that match entered text.

 The filter matches any consecutive characters and ignores the case. For example, typing at will 
match to CAT, hat, ATT etc.



120 • Soft Panels in DashBoard Ultricore BCS User Guide (v9.0)

Figure 22  Example of the Filter Dialog

To use the Filter dialog

1. To filter the destinations:

a. Enter the filtering text in the Destination field as required.

b. Click  to enable destination filtering.

The Matrix panel view updates to display only those destinations matching the entered text.

2. To filter the sources:

a. Enter the filtering text in the Source field as required.

b. Click  to enable source label filtering.

The Matrix panel view updates showing only those destinations matching the entered text.

3. Click  to clear the associated filter text field.

4. Click Clear All to clear both filter text fields.

5. Click Close to close the Filter dialog.

Crosspoint Switches via a Matrix Panel
Crosspoint selections can be made using the cross-hairs or clicking the required Destination and 
Source buttons on the panel. This section provides instructions using the cross-hairs for crosspoint 
selections.

To make a crosspoint switch using a single level

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore BCS.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select a level from the left toolbar.

The button is now lit.

4. Select the source and destination intersection inside the matrix.

The selection is represented as an icon set in the color that matches the level. In the example 
below, Level 2, Src 4 and Dest 2 are selected. The TAKE button is now lit.
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5. Click Take.

The icon on the matrix is solid in the color that matches the level and the TAKE button is no 
longer lit.

To make a crosspoint switch between multiple sources and destinations on a single level

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore BCS.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select a level from the left toolbar.

4. Select the first source and destinations inside the matrix.

5. Select the additional crosspoints to switch.

In the example below, Level 2 is selected but seven crosspoint switches are also selected (each 
is represented with a green icon on the matrix).

6. Click TAKE.

The icons on the matrix is solid in the color that matches the level and the TAKE button is no 
longer lit.
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To make a crosspoint switch on multiple levels

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore BCS.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select each level from the toolbar or select Follow to include all levels.

4. Select the first source and destination inside the matrix.

5. Select the additional crosspoints to switch.

When multiple levels are selected, the circle on the crosspoint is divided into colored sections 
with each section representing a level. In th example below, Levels 2, 4, and 6 are selected with 
multiple crosspoint selections on the matrix.

6. Click Take.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no 
longer lit.

To perform a crosspoint switch on multiple destinations with a single source

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore BCS.

2. Double-click the node for a matrix soft panel.

The Matrix Panel tab opens.

3. Select each level from the toolbar or select Follow to include all levels.

4. Click Select All located at the top left corner of the interface.

All the Dest buttons on the Matrix panel are now lit and selected. The Select All button is 
labeled Clear All.

5. From the top toolbar, select the Src button to switch.

The matrix updates to indicate the crosspoint switches that will occur on the next transition to 
the same source. The TAKE button is now lit. For example, Levels 2, 4 and 6 are selected and all 
destinations switch to Src 4.
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6. Click TAKE.

The icons on the matrix are solid in the color that matches the level and the TAKE button is no 
longer lit.

Using a Default Preset
The Advanced menu provides two pre-configured presets: Diagonal and R-Diagonal.

Diagonal Presets

Crosspoint selection is organized into a diagonal line that starts with the top left corner of the 
matrix (e.g. Src 1 and Dest 1), continues in single step intervals (e.g. Src 2 and Dest 2, Src 3 and 
Dest 3 etc.) and ends with the bottom right corner of the matrix (e.g. Src1 6 and Dest 16). 

To use the Diagonal Preset

1. Select each level from the toolbar or select Follow to include all levels.

2. Click Advanced > Diagonal Presets.

3. Click TAKE.
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R-Diagonal Presets

Crosspoint selection is organized into a diagonal line that starts with the top right corner of the 
matrix (e.g. Src 16 and Dest 1), continues in single step intervals (e.g. Src 15 and Dest 2, Src 14 and 
Dest 3 etc.) and ends with the bottom left corner of the matrix (e.g. Src 1 and Dest 16). 

To use the R-Diagonal Preset

1. Select each level from the toolbar or select Follow to include all levels.

2. Click Advanced > R-Diagonal Presets.

3. Click TAKE.

Creating an Automatic Switching Loop
The Automation feature enables you to set up a crosspoint and create a continuous switch loop 
using the specified crosspoints.

To set up an automated crosspoint selection loop

1. Click Advanced > Setup Automation.

The Automation Setup menu opens.

2. Use the Repeat Interval field to specify the number seconds the crosspoint switch will 
continuously loop for.

3. Use the Levels menu to specify the levels the crosspoint will include.

4. Use the Destinations menu to select the outputs on the router.
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5. Use the Sources menu to select the input signals to route to the output for the switch.

6. Click Start.

The menu closes and the crosspoint switch begins. The loop continues for the length of time 
specified in step 2.

 To stop the loop, click Advanced > Stop Automation.

Clearing the Matrix Selections
You can choose to clear all the crosspoint selections, or only the selected Destinations.

To clear all crosspoint selections on the matrix

• Click Advanced > Clear All Presets.

To clear only the Destination selections on the matrix

• Click Advanced > Clear Dest Presets, or
• Click Clear All.

Using MultiBus Panels
The MultiBus panel provides breakaway control and status monitoring of several destinations 
simultaneously.

Panel Interface Overview
Use the MultiBus Panel to send a source to multiple destinations.

Figure 23  Example of a MultiBus Panel

1. Destination Bus

Each button in this crosspoint row represents a configured output for the selected router. 
Selecting a button includes the destination in the next crosspoint switch. The number of 
destinations and label for each button is defined by its entry in the Destinations interface. A 
destination selected to be included in the next crosspoint switch will have a lit button. For 
example, Dest 2 is selected in Figure 23.
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2. Lock Button

Click this button to prevent switching of the selected crosspoints. If you are using a soft panel 
with the Protection Operation set to Disable, the Lock button is not displayed.

3. Take Button

Click this button to execute the switch between the selected crosspoints. If you are using a soft 
panel with the Take Operation set to Direct, a TAKE button is not displayed because the 
transitions will occur automatically after a crosspoint switch is selected.

4. Preset Button

When this button is lit, a new crosspoint switch is set up on the soft panel. At least one source, 
once destination, and one level are selected on the interface (the Dest and Src buttons are lit 
blue to indicate their inclusion in the next switch). 

When this button is not lit, the crosspoint switch setup is still valid but is no longer indicated on 
the soft panel.

If you are using a soft panel with the Take Operation set to Confirm, the crosspoint switch will 
take effect the next time the TAKE button is selected. If you are using a soft panel with the Take 
Operation set to Direct, a TAKE button is not displayed because the transitions occurred 
automatically (hot-punch operation).

5. Clear Button

Clicking this button clears the selections made for the next crosspoint switch in the soft panel 
interface.

6. Multi Select Button

Clicking this button enables you to perform a switch on multiple crosspoint combinations. If you 
are using a soft panel with the Selection Operation set to Single, a Multi Select button is not 
displayed.

7. Level Button(s)

Click a level button to include the level in a crosspoint that you are configuring in the matrix. A lit 
button indicates that the corresponding level will be included in the next transition. The color and 
name of the button are specified using the Levels interface. Figure 23 illustrates a MultiBus 
panel with three levels selected.

8. Follow Button

Click this button to select all levels in the matrix. If you are using a soft panel with the Take 
Operation set to Confirm, pressing Take after pressing Follow will then switch all crosspoints at 
the same time on all available levels.

9. Source Bus

Each button in this crosspoint row represents a configured input for the selected router. 
Selecting a button includes the source in the next crosspoint switch. The label for the button is 
defined by its entry in the Sources tab of the Database. A source selected to be included in the 
next crosspoint switch will have a lit button. For example, in Figure 23 the Src 1 is selected for the 
next transition while the Src 4 is the current source in use. 

10.Machine Control Button (not shown)

If you are using a soft panel with the Machine Control set to Enabled, the MACHINE CONTROL 
button is displayed. Refer to “Enabling Machine Control” for details on this button.
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Crosspoint Switches via a MultiBus Panel
The layout of a MultiBus panel is similar to a production switcher layout where the destinations are 
organized into a horizontal row of buttons near the top of the panel and the sources are on the row 
near the bottom. 

To make a crosspoint switch on a single level using a MultiBus Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore BCS.

2. Double-click the node for a MultiBus Panel.

The MultiBus Panel tab opens.

3. From the left toolbar, select the button for the level you want to perform the crosspoint switch.

4. Select a Src button from the Source bus located at the bottom of the interface.

The button is now lit.

5. Select the Dest button(s) from the Destination bus located at the top of the interface.

6. Select a Dest button from the Destination bus located at the top of the interface.

The Dest, Preset, and Take buttons are now lit.

In the example below, Level 2 is selected and Dest 4 will switch with Src 6. The Src 1 button is lit 
green to indicate that Source 1 was used in the last crosspoint switch.

7. Click Take.

To make a crosspoint switch using multiple levels

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore BCS.

2. Double-click the node for a MultiBus Panel.

The MultiBus Panel tab opens.

3. Select each level from the toolbar or select Follow to include all levels.

When multiple levels are selected, the center row of the panel reports the level status using a 
horizontal bar to represent the level.

4. Select a Src button from the Source bus located at the bottom of the interface.

The button is now lit.

5. Select the Dest buttons for the outputs to include in the crosspoint switch.

The Dest, Preset, and Take buttons are now lit. In the example below, Follow is selected and 
Dest 5 will switch with Src 4 on all levels.
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6. Click TAKE.

Using the Multi Select Function
A MultiBus panel displays a Multi Select button on the vertical toolbar of the panel.

To use the Multi Select 

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore BCS.

2. Double-click the node for a MultiBus Panel.

The MultiBus Panel tab opens.

3. Select the level(s) from the left toolbar.

4. Click Multi Select.

The Multi Select button is now lit.

5. Select the Dest buttons from the Destination bus located near the top of the interface.

The Dest buttons are now lit.

6. Select a Src button from the Source bus located near the bottom of the interface.

The Src, Preset, and TAKE buttons are now lit. In the example below, Levels 2 and 3 are 
selected, and Dest 2, 3, and 5 will switch with Src 6.

7. Click TAKE.
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Using Category Panels
Category panels organize sources, destinations and levels based on the settings in the Category tab. 
There are two types of category panels: group and classic. This section outlines both types.

For More Information on...
• legacy categories, refer to the RCP-QE User Guide.

Panel Interface Overview
The soft panel interface for each category type is similar in layout and available buttons. 

Figure 24  Example of a Group Category Soft Panel for an Ultricore BCS Router

1. Group Window

This area of the soft panel interface may include the following buttons:

› SOURCES, DESTINATIONS Buttons — Clicking one of these buttons updates the button matrix 
to display the sources or destinations available as per the selected category. The button labels 
update to display the source or destination labels.

› BACK Button — Click this button to return the navigation to the previous category selection 
(back one level).

› RESET Button — Click this button to clear all selections on the interface. This button is only 
available on the Classic Category soft panels.

› SELECT Button — This button is only available on the Classic Category soft panels.
› TOP Button — This button is only available on the Group Category soft panels.

When using a Group Category soft panel and the Info > Non-group Resources setting is set to 
Hide, only the resources assigned to a group are displayed on the soft panel.

2. Status Window

The bottom right corner of each soft panel includes a status window. For each level in the list of 
available levels, a corresponding status indicator display will indicate the current source for the 
currently selected destination.

The following buttons are located on the right-side of the soft panel interface:

› Individual Level Buttons — Click a level button to include the level in a crosspoint that you are 
configuring in the matrix. A lit button indicates that the corresponding level will be included in 
the next transition. The color and name of the button are specified using the Levels interface.
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› CURRENT button — This button updates the level display area to show the current status for 
all displayed levels.

› FOLLOW Button — Click this button to select all levels in the matrix. Clicking TAKE after clicking 
Follow will then switch all crosspoints at the same time on all available levels.

› PENDING button — This button updates the level display area to show status for the currently 
pending operation (if selected source has not been switched yet. e.g. before TAKE is pressed). 
The user may clear individual source selections by selecting the levels to be cleared, then 
pressing CLEAR SRC SEL button.

› CLEAR Button — Click this button to clear all selections on the interface.
› USER button — This button shows current lock/protect status of each levels (and the soft panel 

name that is currently owned it). Since the soft panel does not recognize the names of remote 
control panels (RCP) to retrieve their name, a “owner #” name is used. 

3. TAKE Control Area

The bottom toolbar of the soft panel interface includes the following buttons:

› PROTECT Button — Click this button to prevent switching of the selected destination except by 
the panel that initiated the protect. If you are using a soft panel with the Protection Operation 
set to Disable, the Protect button is not displayed.

› LOCK Button — Click this button to prevent switching of the selected destination by an control 
device. If you are using a soft panel with the Protection Operation set to Disable, the Lock 
button is not displayed.

› VIEW Button — Click this button to display the VIEW dialog. This dialog lists the current TAKE 
commands in the queue. Individual items may be removed from the queue via the options in 
the VIEW dialog.

› CLEAR Button — Click this button to clear the current TAKE queue.
› PRESET Button — This button is used to queue up multiple TAKE commands. Select a 

destination/source combination, then click PRESET. Select another destination/source 
combination then click PRESET. A following TAKE command will execute all the PRESET 
switches. To view the switch commands queued by the PRESET, click VIEW.

› TAKE Button — Click this button to execute the switch between the selected crosspoints. If you 
are using a soft panel with the Take Operation set to Direct, a TAKE button is not displayed 
because the transitions will occur automatically after a crosspoint switch is selected.

Figure 25  Status Protected — Destination Figure 26  Status Protected — User
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Crosspoint Switches via a Category Panel
The buttons and options in a Category soft panel are dependent on the categories defined for the 
current database, and how the soft panel was defined in the Panels tab. Instead of having access to 
all sources, destinations, and levels at one time, a Category soft panel provides access based on the 
categories and the tags you have created.

To make a crosspoint switch using a Group Category Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore BCS.

2. Double-click the node for the Category Panel.

The Category Panel tab opens.

3. From the status window, highlight the level(s) you wish to include in the crosspoint switch.

• Selected levels highlight in the level defined color.
• Non-selected levels are indicated by a gray button with white text.

4. To select a destination:

a. Click DEST from the category navigation tools.

b.  Navigate to the desired group using the displayed groups in the main group window. 

Only groups containing destination assignments will be displayed unless the Non-group 
Resources option for this soft panel is set to Show.

c. Select a DEST button from the available category destinations located in the main group 
window.

The status title bar (if enabled) reports the currently selected destination. In the example 
below, the user has selected Level A1 and destination EDIT 3 from the EDIT group.

5. To select a source:

a. Click SRC from the category navigation tools.

b. Select a SRC button from the Source bus located in the middle of the interface.

 If your Category soft panel was created with the Take Operation set to Confirm, the TAKE button 
is lit. Otherwise the crosspoint switch automatically occurs.
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6. Click TAKE.

Using Push Button Panels
 This soft panel type is not suitable for use on an Ultritouch hard panel. To control the Ultricore 

BCS via an Ultritouch, you must create and load an Ultritouch PB soft panel as outlined in the 
Ultritouch + Ultricore BCS User Guide.

Panel Interface Overview
The Push Button soft panel is organized into three distinct windows. The order and width of each 
window can be customized using the options in the Panels > Home View interface.

Figure 27 is an example of a Push Button soft panel set to portrait.

Figure 27  Example of the Default Push Button Soft Panel — Portrait

Figure 28 is an example of a Push Button soft panel set to landscape.
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Figure 28  Example of the Default Push Button Soft Panel — Landscape

1. Destinations Area

The Destinations area displays the available destinations for router control. Select a 
Destination button to arm that destination for subsequent panel operations. Beneath each 
destination button is displayed the current source for that destination.

This area also includes the Filter field. A filter is available to match destination names against the 
entered text:   

• Enter text in the Filter field.

• Click  (or press Enter). The destinations area updates to display only those destinations 
starting with the filter text.

• To clear the active filter, click .

2. Sources Area

The Sources area displays the available sources for router control. Select a Source button to 
control the crosspoint for the currently selected destination.

This area also includes a Filter field. A filter is available to match source names against the 
entered text:

• Enter text in the field provided

• Click  (or press Enter). The sources area updates to display only those sources starting 
with the filter text.

• To clear the active filter, click .

3. Current Destination

The currently selected destination label is displayed here. All subsequent panel operations 
operate on this destination until a new destination is selected.

›  — the current status is not the same for all levels (ie a breakaway switch has occurred).

›  — the current destination is locked. No switches can be made on this destination.
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›  — the current destination is protected. Only the panel that initiated the protect may 
switch this destination.

4. Levels Area

The Levels area displays the available router levels as individual buttons. The current source for a 
given router level is displayed each level button. Select a Level button to include this level in the 
next source selection operation. Select the button again to toggle the level selection setting.

› FOLLOW Button — toggles the selection for all displayed levels.
› CLEAR Button — toggles the currently active level buttons.

5. Operation Area

This area provides buttons for soft panel and router control.

› PROTECT Button — protect the current destination. The following occurs:
• The destination button displays a blue border.

• The Current Destination area displays . When a destination is protected, only the 
panel that initiated the protect can change the destination status.

• The PROTECT button is now labeled as UNPROTECT. Toggle the button to disable the 
protect.

Only the panel that initiated the protect may change the protect status.

› LOCK Button — locks the current destination. The following occurs:
• The destination button displays a red border.

• The current destination display area displays . When a destination is locked, no panel 
may change the destination status.

• The LOCK button is now labeled as UNLOCK.

Only the panel that initiated the lock may change the lock status.

› VIEW Button — displays the current crosspoint switch requests currently in the preset list. 
Individual crosspoints may be removed via the list view.

› CLEAR Button — clear the preset list of all crosspoint selections.
› PRESET Button — adds the current destination/source/level selection to a preset list. A 

crosspoint is added to the list for every level selected. This enables the user to add more 
switches and execute them all with a single take operation. The preset function is only available 
when the Take Mode is set to Confirm.

› SALVO Button — reveals a list of predefined salvos. A salvo may be executed from the dialog. 
The salvo button is visible only when the panel configuration has one or more salvos assigned.

› TAKE Button — is lit when the current destination/source selection is ready to be requested of 
the router. The Take operation is a configurable option and will only be activated if the soft 
panel Take Mode is set to Confirm.

Configuring a Push Button Soft Panel
The Push Button soft panel provides additional configuration options in addition to those outlined 
in “Creating a Soft Panel”.

To configure a Push Button soft panel

1. Create a new soft panel as outlined in “To create a soft panel”.

2. Select the Home View tab.
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3. Use the Display Icons menu to specify whether buttons will display the default icons based on 
window type (Enable) or will only display the label text as determined by the database 
(Disable).

4. Use the Orientation menu to specify the layout on the monitor. Choose from the following:

• Portrait — orients the soft panel in a horizontal layout, where the soft panel is taller than it is 
wide.

• Landscape — orients the soft panel in a vertical layout, where the soft panel is wider than it 
is tall.

5. Specify the order that the windows will display in the completed soft panel layout as follows:

 By default, the windows are organized in the following order (left to right): Destinations, Sources, 
and Status.

a. In the Home Windows table, select the row for the window you want to move to a different 
position on the soft panel layout.

b. Use the buttons in the toolbar to move the row to the desired position.

In the example below, the user moved the Status window to the top of the table so it will 
display on the far left of the soft panel.

6. Adjust a window size as follows:

• Use the Percent field to specify the size of the window as a percentage of the total soft panel 
area.

• Use the Rows field to specify the number of button rows the window will display.
• Use the Columns field to specify the number of button columns the window will display
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7. Click Apply to save your changes.

Crosspoint Switches via a Push Button Panel
The buttons and options in a Push Button soft panel are dependent on the current database, and 
how the soft panel was defined in the Panels tab. You can also use the Filter fields in the 
Destinations and Sources area of the panel to provides access based on the search criteria entered 
into each Filter field.

To make a crosspoint switch on a single level using the Push Button Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore BCS.

2. Double-click the node for the Push Button Panel.

The Push Button Panel tab opens.

3. Select the Level you want to perform the crosspoint switch.

4. Select a DEST button from the Destinations window.

The Status field reports the selected DEST button. In the example below, the user selected 
Level 6 and Dest 54.

5. Select a SRC button from the Sources window.

 If your soft panel was created with the Take Operation set to Confirm, the TAKE button is lit. 
Otherwise the crosspoint switch automatically occurs.
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6. Click TAKE.

To make a crosspoint switch on multiple levels using the Push Button Panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore BCS.

2. Double-click the node for a Push Button Panel.

The Push Button Panel tab opens.

3. Select each level from the Levels window or click Follow to include all levels.

The Level buttons are lit in the toolbar.

4. Select a DEST button from the Destination window.

The Status area updates to display report the selected DEST button. In the example below, the 
user selected Levels 2, 6, 8 and 11, then Dest 40.

5. Select a SRC button from the Source window.
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The Status area updates to display only the selected SRC button. In the example below, Src 6 is 
selected.

 If your soft panel was created with the Take Operation set to Confirm, the TAKE button is lit. 
Otherwise the crosspoint switch automatically occurs.

6. Click TAKE.
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Using Salvos
Salvos are a selected series of crosspoints to switch in the matrix that can be saved and later 
recalled for use.

Creating Salvos
The Salvos tab enables you to create, delete, re-name, and manage your salvos in an interface that 
is off-line. The Salvo tab layout is similar to the Matrix Panel layout where crosspoints are arranged 
in a grid layout with sources in columns and the destinations in rows. 

To create a salvo

1. In the Basic Tree View, expand the Database node for the Ultricore BCS.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Create a new salvo in the database as follows:

a. Click Edit > Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Apply.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected.

4. Select the Level(s) button for the level(s) to include in the salvo.

The Level(s) buttons are lit.

5. To create a single crosspoint switch, use the cross-hairs to select the source/destination 
combination on the grid.
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6. To assign multiple destinations to the same source.

a. Click the button(s) in the Destination toolbar for each destination to include in the switch; or 
click Select All to include all the available Destinations.

b. Click the button in the Source toolbar for the source to use for the switch.

The grid updates to indicate the new selections. Notice that each level is represented by a 
corresponding slice of the crosspoint indicator. In the case below, there are seven crosspoint 
switches selected that will affect two levels.

7. Select the Follow button to enable the levels to automatically follow the switches.

 Click Advanced > Clear Dest Presets to cancel the destination selections or click Advanced > 
Clear All Presets to clear the workspace.

8. Click Apply.

The salvo settings are updated.
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Saving the Current Crosspoint Status as a New Salvo
The Advanced menu in the Salvos tab provides the option to capture the current state of the 
crosspoint selections and save them as a salvo.

To create a salvo based on the current destination status

 This procedure captures the status of all destinations.

1. Verify the current crosspoint state using one of the soft panels in your database. Refer to “Soft 
Panels in DashBoard”.

2. In the Basic Tree View, expand the Database node for the Ultricore BCS router.

3. Double-click the Salvos node.

The Salvos tab opens.

4. Create a new salvo in the database as follows:
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a. Click Edit > Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Apply.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected.

5. Click Advanced > Capture System Status.

The matrix in the Salvos tab updates to reflect the current crosspoint state as verified in step 1.

6. Click Apply.

To create a salvo based on selected destinations

 This procedure captures the status of selected destinations.

1. Verify the current destination crosspoint states using one of the soft panels in your database. 
Refer to “Soft Panels in DashBoard”.

2. In the Basic Tree View, expand the Database node for the Ultricore BCS router.

3. Double-click the Salvos node.

The Salvos tab opens.

4. Create a new salvo in the database as follows:

a. Click Edit > Add. 

The Add Salvo dialog opens.

b. Type a unique identifier in the Name field for the new salvo.

c. Click Apply.

The Add Salvo dialog closes and the Salvos list updates with the new salvo selected.

5. Click Advanced > Capture Dest Status.

The matrix in the Salvos tab updates to reflect the current Destination states as verified in step 
1.

6. Select the Level(s) button for the level(s) to include in the salvo.
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The Level(s) buttons are lit.

7. Select the source(s) to use in the crosspoint switch.

8. Click Apply to update the salvo settings.

Copying and Pasting a Salvo
You can create a copy of a saved salvo and edit its settings or add crosspoint selections separately 
from the original salvo.

To copy and paste a salvo

1. In the Basic Tree View, expand the Database node for the Ultricore BCS router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Select the salvo to copy from the Salvos list.

4. Click Edit > Copy.

5. Click Edit > Paste.

A new salvo displays at the bottom of the Salvos list in the Salvos tab. By default, the salvo is 
named Salvo # where # is an automatically assigned value.

6. Give the new salvo a unique identifier as outlined in the procedure “To re-name a salvo”.

7. Edit the settings of the new salvo as outlined in the procedure “To edit a salvo”.

Editing a Salvo
Once a salvo is created in the database, you can edit its crosspoint selections, 

To edit a salvo

1. In the Basic Tree View, expand the Database node for the Ultricore BCS router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Select the salvo from the Salvos list.

The grid updates to display the crosspoint selections currently saved for the salvo.

4. Perform steps 4 to 7 as outlined in the procedure “To create a salvo”.

5. Click Apply to save your changes.

To re-name a salvo

1. In the Basic Tree View, expand the Database node for the Ultricore BCS router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. Select the salvo from the Salvos list.

The grid updates to display the crosspoint selections saved for the salvo.

4. Click Edit > Rename.

The Rename Salvo dialog opens.

5. Type a new name for the salvo in the Name field.

6. Click Apply.
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The Rename Salvo dialog closes and the salvo displays with the new name in the Salvos list.

Deleting a Salvo
Deleting a salvo removes it from the database. The corresponding button on any soft panels for the 
deleted salvo are also no longer displayed.

To delete a salvo from the database

1. In the Basic Tree View, expand the Database node for the Ultricore BCS router.

2. Double-click the Salvos node.

The Salvos tab opens.

3. From the Salvos list, select the salvo to delete.

4. Click Edit > Delete.

5. Click Apply to close the dialog.

The salvo no longer displays in the Salvos list to the left of the workspace. If the salvo was 
assigned to a button in a soft panel, the button is automatically deleted from the panel.

Recalling a Salvo
Once you have saved a salvo, you can recall it for use on a soft panel in DashBoard.

 You cannot recall salvos from a Category soft panel.

For More Information on...
• adding salvos to customized soft panels, refer to “Creating a Soft Panel”.

To recall a salvo from a Matrix panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore BCS router.

2. Double-click the node for a Matrix Panel.

The Matrix Panel tab opens.

3. Click Salvo.

4. Click Recall.

The Execute Salvo dialog opens. Notice that the Active column reports whether the salvo is 
currently in use (ON) or not (OFF).

5. Select the salvo to recall.

6. Click Apply to close the dialog.

7. Click Take to apply the salvo.
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To recall a salvo from a MultiBus panel

1. In the Basic Tree View, expand the Soft Panels node for the Ultricore BCS router.

2. Double-click a MultiBus Panel node.

The MultiBus Panel tab opens. The salvo buttons are located at the bottom of the soft panel 
interface. If a salvo button is lit green, it is currently in use. 

3. Click the button for the salvo you wish to recall.

The salvo button and Take buttons are now lit on the soft panel.

4. Click Take to apply the salvo.

The crosspoint switch is made, and the salvo button is no longer lit.
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Tielines
This chapter outlines how to define a distributed routing system using the Tieline Builder feature of 
the Ultricore BCS.

 This feature requires that the Ultricore BCS and Ultrix routers run software version 4.2.0 or 
higher and an ULTRICORE-TLX license is enabled.

What are Tielines?
A tieline is a method of connecting two routers together so that they may share sources and 
destinations. How many inputs and outputs that can be shared depends on how many tielines have 
been provisioned, if the tielines are in use, or if a user has permissions to use them. Figure 29 
represents a two-way tieline connection between routers where one (or more) outputs of Ultrix 1 
are connected to the inputs of Ultrix 2, and one (or more) outputs of Ultrix 2 is connected to the 
inputs of Ultrix 1. 

Figure 29  Example of a Distributed Routing System Work Flow with Tielines

Figure 30 illustrates a work flow where Ultrix 2 needs a source that is only present on Ultrix 1. The 
Ultricore BCS routes the requested source to a destination that is configured as a tieline, and on 
Ultrix 2, it will route the tieline source to the user selected Destination. 

 Tielines do not have to be bi-directional as represented in Figure 29 and Figure 30.
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Figure 30  Example of Tielines in a Work Flow

In Figure 30 the following occurred:

1. An RCP-QE36 panel, with access rights, made a request for a source on Ultrix 1 to be connected 
to a destination on Ultrix 2.

2. The Ultricore BCS determined the ‘path’ knowing it has to use a tieline. 

3. The Ultricore BCS had a free tieline and enabled:

a. The Ultrix 1 requested source to switch to the tieline.

b. The Ultrix 2 tieline input to switch to the requested destination.

Setup Work Flow
Figure 30 summarizes the steps required to set up and configure tielines for the Ultricore BCS.

Figure 31  Requires Steps for Tieline Setup

Physical Setup
This section outlines the physical setup needed before configuring tielines on the Ultricore BCS.

RCP-QE36

1 2 3 4IP: ###.###.##.### 1 2 3 4IP: ###.###.##.###

Requested
Source

Requested
Destination

Tielines

RCP-QE36

RCP-QE36

Connect Tieline
Cables between

the Routers

Set the Routers
to Remote 

Controller Mode

Create a
Database
on BCS

Add Connection
from BCS
to Routers

Define the
Tielines in the
BCS Database



Ultricore BCS User Guide (v9.0) Tielines • 149

1. Connect the signal cable(s) from the output(s) on Ultrix 1 to the input(s) of Ultrix 2. 

2. If bi-directional tieline management is required, connect the signal cable(s) from the output(s) of 
Ultrix 2 to the input(s) of Ultrix 1.

3. Take note of the physical address of the connectors used for the tieline signal cables as this 
information will be required when configuring the tielines in DashBoard.
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Add the Routers to Ultricore BCS Control
This section assumes that each router is configured in DashBoard.

 Two or more physical routers are required for tieline setup. Tielines within the same router are 
not supported.

1. Ensure each router has a unique Device Name assigned to it. This makes it easy to identify the 
router in the Ultricore BCS database. To assign a name to a router:

a. Display the System Status interface in DashBoard for the router. 

b. Select the Setup tab.

c. Use the Device Name field to assign a unique identifier to the router.

2. Set each Ultrix router to Remote Controller mode as follows:

a. Display the System Status interface in DashBoard for the router.

b. Select the Database tab.

c. Select the Remote Controller Mode box.

3. Reboot each Ultrix device by clicking the Reboot button on the System Status interface.

4. Create a connection point between the Ultricore BCS and each router as outlined in 
“Connecting to an Ultrix Router”.

To add Ultrix to the Ultricore BCS

1. Display the Database nodes as outlined in “To access the Database interfaces in DashBoard”.

2. Double-click the Connections sub-node.

The Connections tab displays.

3. Select Edit > Add.

The Add Connection dialog opens.

4. Specify the type of connection as follows:

a. Set the Protocol to Ultrix.

b. Set Type to tcp.

c. Set Count to 1 (for one Ultrix connection).

d. Click Apply.

The Add Connection dialog closes.

5. Locate the new entry in the Outgoing Connections table for the connection defined in step 4.

6. If required, enter a unique identifier for the new connection in the Name and DeviceID 
columns.

7. Click the [...] button in the new row to display the Communication dialog.

8. In the Address field, type the IP Address for the Ultrix you want to connect to.

9. Set the Port to 15000.

10. Click Apply to close the Communication dialog.

11. In the Control column for the row, select enabled.

12. Click Apply at the bottom of the Connections tab.

The Ultrix resources are now available for database creation.
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Create a Database for the Ultricore BCS
Tieline definition starts with the database. Tielines may only be configured to work with outputs of a 
router that are not defined as regular destinations. To enable a physical output to be used as a 
tieline, any reference to that physical port must be removed from the Destination table of the 
database. This deletion of an output from the list of logical destinations serves to prevent a 
mis-configured system from directly controlling a tieline by directly routing to it.

 An output port must be either a regular destination or a tieline. It cannot be both. 

To create a database to utilize the resources presented by the connected routers

1. Create a database for the Ultricore BCS as outlined in “Using the Database Builder”.

2. Edit the database to identify tieline sources, destinations, and free sources as outlined below.

To delete a logical destination definition

1. Display the Database nodes as outlined in “To access the Database interfaces in DashBoard”.

2. Double-click the Destinations node located under the Database node.

The Destinations tab opens.

3. Locate the Destination row that includes the physical port name of the output port to be used 
as a tieline. 

 By default, the Ultrix routers use the nomenclature of 
framename.slotnumber.out[socket].type to reference a physical output socket. 

4. Select any cell within the row.

5. Click Edit.

The Edit dialog opens.

6. Click Delete.

7. Repeat this for each output that is to be used for a tieline.

 Any audio channels associated with the main SDI output socket reference must be removed from 
the destination table also.

Define a Free Source for each Router
Tieline control requires the definition of a router input as a “parked” or “free source” on each router 
within the tieline enabled system. This free source supplies a dedicated source for destinations that 
were previously fed via a tieline, but the tieline has now been freed or was re-assigned. This section 
outlines how to define a local parked source on a router.

 Each router within the tieline system requires a Free Source definition. If a Free Source is not 
defined, a destination will remain connected to the tieline, even after being released. 

To define a free source on a router

1. Make note of a physical IN port on the Ultrix router that provides a known and valid signal.

This would typically be a test signal, station logo or similar. Ultrix routers also have the ability to 
define a 'disconnected' source. This signal is used when the tieline is “parked” or not in use.

2. Navigate the database source definition page and edit (or create if not already defined) the 
source name as outlined in the Ultrix User Guide.

3. Assign a name to this new source following the convention of FreeSource-<RouterName> where 
<RouterName> is the name of the Ultrix router. For example, if the router name is Ultrix23, then 
the Free Source label will be FreeSource-Ultrix23.

 An Ultrix router device name may be read from the Ultrix > System Settings > Setup tab.
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4. Ensure to assign and add the physical router port from step 1 to this new source in the Ultrix 
database.

Using the Ultricore BCS Tieline Builder
Once you have defined the connection points and database for your routing system, you can define 
the routers and available I/O ports for use in tielines. For each tieline you must define where the 
tieline starts (by selecting an output from a device) and where it will end (by selecting an input from 
another device).

The Ultricore BCS provides two interfaces for creating and managing tielines:

• Tieline Builder — creates tielines based on the routers and ports available to the Ultricore BCS 
within the current database and routing system.

• Tieline Runtime — reports the sources and destinations for each defined tieline, enables the 
user to manage and monitor the switch requests using the define tielines.

To define a tieline on the Ultricore BCS

1. Display the Database nodes as outlined in “To access the Database interfaces in DashBoard”.

2. Double-click the Tieline Builder sub-node.

The Tieline Builder interface opens in the DashBoard window.

3. To define the start point for a tieline:

a. Locate the From Device table in the interface.

b. Use the From Device menu to specify the router that will provide the start point for the 
Ultricore BCS tieline. In Figure 30, this would be Ultrix 1.

The Output Ports area updates to display a list of available output ports on the selected 
router.

 The From Device Output ports that display (Used for <dst name>)cannot be used for tieline 
start points.

4. From the Output Ports area, select the port that will be the Ultricore BCS tieline start point. 

 The port was noted during the “Physical Setup”.

5. To define the end point for a tieline:
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a. Locate the To Device table in the interface.

b. Use the To Device menu to specify the router that will be the end point for the Ultricore BCS 
tieline. In Figure 30, this would be Ultrix 2.

The Input Ports area updates to display a list of available input ports on the selected router.

6. From the Input Ports area, select the port that will be the endpoint for the Ultricore BCS tieline. 
This is the physical input where the tieline cable was connected during “Physical Setup”.

7. Click Add Tieline.

The Existing Tielines table updates to include the new tieline.

A created tieline automatically takes the default name Tie x where x is a numerical identifier. 

 A tieline can be renamed. Highlight the tie line row to be renamed, and click the Rename button 
at the bottom of the Tieline Builder interface.

8. Repeat steps 3 to 7 for each tieline that the Ultricore BCS will manage in your routing system.

9. Click Apply to commit these changes to the Ultricore BCS database.

Using the Tieline Runtime
Once your tielines are defined, you will need to verify the routing system sources and destinations 
that the Ultricore BCS will use to determine the best path for the tieline between its start and end 
points. 

Viewing the Tieline Details
The Tieline Runtime interface enables you to view the sources and destinations available for each 
existing tieline, 

To view the tieline details

1. Display the Database nodes as outlined in “To access the Database interfaces in DashBoard”.

2. Double-click the Tieline Runtime sub-node.
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The Tieline Runtime interface opens in the DashBoard window.

3. In the Existing Tielines table, select the row for the tieline you wish to verify.

4. Click View Tieline Details.

Parking a Tieline using a Free Source
When a tieline resource is no longer required, it should be parked or released. This ensures 
subsequent uses of the tieline do not inadvertently route a new signal to the previous tie-line 
destination selection. 

An entire tieline route may be released (Release Tieline function) or specific destinations using that 
tieline may be released (Release Destination function).

To park an entire tieline

 This will park all destinations currently using the selected tieline.

1. Display the Database nodes as outlined in “To access the Database interfaces in DashBoard”.

2. Double-click the Tieline Builder sub-node.

The Tieline Builder interface opens in the DashBoard window.

3. Select the tieline to park from the Existing Tielines table.

4. Click Release Tieline.

To park a specific destination

1. Display the Database nodes as outlined in “To access the Database interfaces in DashBoard”.

2. Double-click the Tieline Builder sub-node.

The Tieline Builder interface opens in the DashBoard window.

3. Select the destination path from destinations using Tielines table.

4. Click Release Destination.
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Operation with Ross Devices
The Ultricore BCS Central Controller connects to Ross NK series routers and Remote Control Panels 
(RCPs). Ross NK series routers and RCP series devices may connect directly to the T-Bus port on the 
Ultricore BCS, or via an NK-IPS/NK-NET over Ethernet. The Ross RCP-ME and RCP-QE panels 
communicate with Ultricore BCS via Ethernet.

 It is recommended for optimum performance to minimize device connections to the NK-NET.

For More Information on...
• defining connection points between Ultricore BCS and external devices, refer to the chapter 

“Device Communication Setup”.

Connection Diagram
Figure 32 provides an example of a routing system with an Ultricore BCS, an NK-IPS, and several 
Ross NK devices. Communication between the NK-IPS and the Ross NK devices is over T-Bus, while 
the Ultricore BCS communicates with the NK-IPS via Ethernet.
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Figure 32  Connection Example with an NK-IPS

RCP-NK Series Remote Control Panels
When adding the Ultricore BCS router to an existing system with one or more RCP-NK devices, each 
remote control must:

• have the Virtual routing enabled on their Configuration page
• have the Comms Retry Delay Factor set to 80ms or greater
• ensure that the level numbers correspond to the Ultricore BCS Level ID number

Be aware that the RCP-NK devices do not:

• support Ultricore BCS salvos
• automatically get source and destination labels from the Ultricore BCS. They must be entered 

manually or via a global labels file.
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Ross NK Series Routers
Introducing an Ultricore BCS to an existing Ross NK system requires specific configuration to enable 
the Ultricore BCS to manage the devices in the routing system. All Ross NK routers are automatically 
discovered1 and appear in the available matrix list ready for label assignment.

Ross NK Series routers can utilize two methods of connection to the Ultricore BCS: Direct T-Bus 
connection and Ethernet connection via an NK-IPS or NK-NET.

Keep the following in mind:

• The NK-IPS requires version 2.23 or greater to communicate with an Ultricore BCS.
• The SCP/A is not supported.
• The SCP/K2 is not supported.
• NK-A64 control level is not supported.
• Ross NK router partitioning not supported. The logical mapping of the Ultricore BCS control 

system is far more capable and should be implemented there if required

Table 10 outlines the nomenclature that Ultricore BCS automatically uses for Ross NK devices.

Using Ross Analog Audio Devices (NK-A16, NK-A32, NK-A64)
The Ross NK Analog Audio devices (NK-A16, NK-A32, NK-A64) will present as two matrices: Left and 
Right respectively.

Adding Ross NK Series Routers to the Ultricore BCS
Add a Ross NK series device to the Ultricore BCS requires the following steps:

1. Define a connection point between Ultricore BCS and each NK-IPS or NK-NET. Refer to 
“Connecting to Ross NK Series Devices” for details.

2. Review the port label matrices for the Ultricore BCS database by selecting Ultricore BCS > 
Database > Port Labels.

3. Assign outputs to the logical destinations in the database as outlined in “To associate a 
physical output with a destination”.

4. Assign inputs to the logical sources in the database as outlined in “To associate a physical 
input with a source”.

1. Once an Ethernet connection point has been established for Ethernet connections.

Table 10  Default Ultricore BCS Naming for Ross NK Devices

Ross NK Device Matrix Name Port Name
NK-3Gxxx deviceName.SDI deviceName.slot1.in/out[socket number].SDI.ch1

NK-Axxx deviceName.An Aud L deviceName.slot1.in/out[socket number].An Aud 
L.ch1

deviceName.An Aud R  deviceName.slot1.in/out[socket number].An Aud 
R.ch1

NK-Dxxx deviceName.AES deviceName.slot1.in/out[socket number].AES.ch1

NK-Mxx deciceName.Machine 
Control

deviceName.slot1.in/out[socket number].Machine 
Control.ch1

NK-MDxxx deviceName.SDI deviceName.slot1.in/out[socket number].SDI.ch1

NK-Vxxx deviceName.An Vid deviceName.slot1.in/out[socket number].An Vid.ch1
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Integrating Ross RCP-ME/RCP-QE Panels with Ultricore BCS
RCP-QE and RCP-ME Ethernet series remote control panels connect to Ultricore BCS via the facility 
network. The panels offer some extra features not available to RCP-NK series control panels;

• automatic source and destination labeling
• automatic level and salvo labeling
• the ability to trigger system wide salvos
• Category index source/destination selection method

Adding a Ross RCP-ME or RCP-QE Panel to the Ultricore BCS
The Connection Editor interface for an RCP-ME or RCP-QE enables you to configure the connection 
point from the panel to Ultricore BCS. You will need DashBoard installed and running to access the 
Connection Editor interface.

To add an RCP-ME or RCP-QE

1. Connect the RCP to facility network and configure the network settings as outlined in the user 
guide for your remote control panel.

2. Open the Connection Editor in DashBoard for your panel as follows:

a. In the Basic Tree View of DashBoard, expand the tree view for the remote control panel.

b. Double-click the Connection icon within the device tree.

The Connection Editor opens.

3. Locate the Servers to connect to area.

4. In a row of the provided table:

a. Type the IP Address of the Ultricore BCS you want to establish a connection to.

b. Press Enter to confirm the new value.

 Ultricore BCS may operate in a dual redundant controller mode. When operating in this mode, 
the IP address of the secondary Ultricore BCS is entered in the second row of the Servers to 
Connect to table. This enables the RCP to fail over to the secondary Ultricore BCS unit if the 
primary goes off-line.

5. Upon a successful connection and a refresh of the current DashBoard view (click the Refresh 
button), a check mark displays next to the successful connection. In the above example, an IP 
Address is entered for Server 1.

6. Verify in the Connections area that a connection is establish.

7. Configure the Remote Control Panel layout as outlined in the user guide for your panel.
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Machine-Control (RS-422) Logical Mapping
Connecting an NK-M series router to Ultricore BCS requires some special consideration.

Machine control routing requires two crosspoints for a point to point connection due to the 
bi-directional nature of the signal. Each physical socket contains a transmit/receive pair. This can be 
thought of as a source-destination combination and is known as a port. 

It is necessary to configure the input and output of the machine control port on the same row ID on 
the logical mapping tables.

Figure 33  Destination Mapping

Figure 34  Source Mapping

It does not matter where the machine control is mapped (either row 3 or 300), but the input and 
outputs physical ports must be mapped to the same row ID.

Conditions for Machine Control
Three conditions must be met before machine control can be switched.

1. The NK machine control router is attached and configured within Ultricore BCS (level, 
destination. and source maps).

2. Selected breakaway or level must include the machine control level.

3. Machine control reciprocal must be enabled on the controller.

Operation with an Ultrix Router
Keep the following in mind when operating an Ultrix router within the Ultricore BCS routing system:

• The Ultrix hardware is configured on the Ultrix router in DashBoard. Device specific functions 
such as hardware setup, installed license keys, and Ultriscape setup remain in the DashBoard 
node of the Ultrix router. 

• The Ultriscape (Multiviewer) licensed feature is configured on the Ultrix router in DashBoard.
• All crosspoint changes (including salvos) must originate from the master Ultricore BCS database.
• All routing commands are sent to and executed by the master Ultricore BCS. This includes any 

third-party communications (GVG, Probel, TSL, etc.). The Ultrix router will ignore any routing 
commands not originating from the master Ultricore BCS database while in this connected mode.

• If more than one Ultrix router is to be controlled from the Ultricore BCS, ensure that you assign 
unique device names for the Ultrix routers via the front panel. This will help to quickly identify the 
routers within the Ultricore BCS system. Refer to “Connecting to an Ultrix Router” for details.

• Each Ultrix router must be configured for remote control mode.
• All Remote Control Panels (RCP) must be configured to connect with the master Ultricore BCS.
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Figure 35  Example Setup Using an Ultricore BCS and an Ultrix
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Setting up a Redundant System
This chapter outlines how to configure two Ultricore BCS panels into a single standby redundant 
system.

General Overview
The Ultricore BCS includes an option to set up a standby (backup) redundant system with two 
identical Ultricore BCS panels. The second panel backs up the first panel when it detects that the 
first panel fails. This enables reliable switching. 

When configured in redundant mode, the two panels share the same IP address. 

Figure 36  Example of Two Ultricore BCS Panels in a Redundant System
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Before You Begin
Ensure you have the following before setting up your Ultricore BCS redundant system:

• two Ultricore BCS panels each configured with a unique IP address on the same network subnet, 
and both panels accessible via DashBoard

• a unique IP address is required for the units to share when in redundancy mode. This IP address 
must be on the same network subnet as the Ultricore BCS panels.

Cabling Requirements
The first Ultricore BCS must be physically cabled to the second Ultricore BCS via the ENET2 ports on 
each unit. This section briefly outlines the required cabling method.

To connect the first Ultricore BCS to the second Ultricore BCS

1. Plug one end of an RJ45 1GbE network cable into the ENET2 port of the first Ultricore BCS.

2. Plug the other end of the same cable to the ENET2 port of the second Ultricore BCS. 

 The two Ultricore BCS panels must be directly connected via their ENET2 ports. Do not use a 
network switch or router between the two panels.

Figure 37  Cabling — Connecting Two Ultricore BCS Panels for Redundancy

Notes about Connecting
 Do not disconnect the tether (ethernet connection between the Ultricore BCS panels) once a 

redundancy connection is established. Redundancy will be lost and both will try to assume the 
master/primary role resulting in unpredictable behavior. 

If the tether is disconnected:

1. Power down the secondary Ultricore BCS panel. 

2. Reconnect the tether.

3. Wait 1 minute.

4. Power on the secondary Ultricore BCS panel.

 Do NOT reconnect the tether if both Ultricore BCS panels remain active. 
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Enabling Redundancy
When BCS Redundancy is enabled via DashBoard, the two Ultricore BCS panels will share a virtual 
(third) IP address. While in redundancy mode, DashBoard will connect to both panels using the 
shared IP address but only show one panel (the primary unit) in the Tree View of DashBoard.

There are two methods of creating a redundant system:

• Configuring a new redundancy system using two newly installed Ultricore BCS panels.
• Replacing an Ultricore BCS panel in a redundancy system already configured and running.

Both methods are outlined in this section.

Configuring a New Ultricore BCS Redundant System
Configuring a new Ultricore BCS redundant system requires you to:

1. Create a new redundant pair in DashBoard using the options in the System Status > BCS 
Redundancy tab.

2. Remove each Ultricore BCS node from the Tree View and power cycle each panel.

3. Add the Ultricore BCS redundant pair to the DashBoard Tree View.

4. Verify the Ultricore BCS pair connection is valid.

To create a new Ultricore BCS redundant pair

1. Locate the node for the first Ultricore BCS in the Tree View of DashBoard.

2. Expand the first Ultricore BCS node.

3. Double-click the System Status node.

The System Interfaces display in the DashBoard window.

4. Select the BCS Redundancy tab.

5. Select the BCS Redundancy Enabled box.

The Enable BCS Redundancy dialog opens.

6. Use the Create or Join Existing Pair menu to specify Create New Redundant Pair.

The options in the Enable BCS Redundancy dialog update.

7. Use the Secondary BCS IP Address field to specify the IP address of the second Ultricore BCS 
panel.

8. Use the Shared IP Address field to specify the unique IP address that the two Ultricore BCS 
panels will share.

9. Click Apply.

The Enable BCS Redundancy dialog closes.

The fields in the BCS Redundancy tab update with the new values.
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To remove the Ultricore BCS nodes from the Tree View

1. Locate the Basic Tree View pane in the DashBoard window.

2. Remove the first Ultricore BCS node as follows:

a. Right-click the node for the first Ultricore BCS.

b. Select Remove.

The Confirm tree item removal dialog opens.

c. Click OK.

The Confirm tree item removal dialog closes and the first Ultricore BCS node is deleted 
from the Tree View.

3. Repeat step 2 for the second Ultricore BCS.

4. Power cycle each Ultricore BCS panel.

To add the Ultricore BCS Redundancy System to the DashBoard Tree View

1. In the Basic Tree View toolbar of DashBoard, click .

The Add New Connections dialog opens.

2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.
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5. Use the IP Address field to specify the Shared IP Address for the Ultricore BCS Redundancy 
System.

 The shared IP Address is the same value you entered in step 8 of the previous procedure.

6. Use the Display Name field to specify a unique name for the Ultricore BCS Redundancy 
System. 

7. Set the Protocol to JSON.

8. Set the Port to 5354.

9. Click Finish. 

The Ultricore BCS Redundancy System node displays in the Tree View. 

To verify the Ultricore BCS Redundancy System is valid using DashBoard

1. Locate the node for the Ultricore BCS Redundancy System in the Tree View of DashBoard.

2. Expand the Ultricore BCS Redundancy System node.

3. Double-click the System Status node under the Ultricore BCS Redundancy System node.

The System Interfaces display in the DashBoard window.

4. Select the BCS Redundancy tab.

5. Review the information reported in the read-only fields of the tab.

Replacing an Ultricore BCS Panel in an Existing Redundancy System
Use the procedures in this section should you need to replace an Ultricore BCS panel in a 
configured redundancy system.

 The replacement Ultricore BCS panel must be configured with its own IP Address and directly 
connected to the functioning panel as described in “Before You Begin”.

To replace an Ultricore BCS in an existing redundancy system

1. Disable the Redundancy Mode on the currently active master panel as described in “Disabling 
the Ultricore BCS Redundancy Mode”. 

2. Create a new redundant pair as described in “Configuring a New Ultricore BCS Redundant 
System”.

To verify the Ultricore BCS Redundancy System is valid

1. Locate the node for the Ultricore BCS Redundancy System in the Tree View of DashBoard.

2. Expand the Ultricore BCS Redundancy System node.

3. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

4. Select the BCS Redundancy tab.

5. Review the information reported in the read-only fields of the tab.

Monitoring the Ultricore BCS Redundancy System
An alarm may be set to trigger when Ultricore BCS redundancy fails.

To enable Standby BCS alarm

1. Locate the node for the Ultricore BCS Redundancy System in the Tree View of DashBoard.

2. Expand the Ultricore BCS Redundancy System node.

3. In the Tree View of DashBoard:
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a. Select the Devices sub-node.

b. Select Controllers/Matrices > UltricoreBCS.

4. Click Alarms.

 The Alarms table displays.

5. In the Type column of the Alarms table, select a row marked None.

A drop-down menu opens.

6. Select Standby BCS.

 

Forcing a Failover Switch
You can force a switch from one Ultricore BCS panel to the second in a redundancy system via 
DashBoard.

 Failover occurs immediately for remote control panels (RCPs) and third-party controls. All 
instances of DashBoard may take up to a minute for control to be restored.

To disable redundancy mode on the first Ultricore BCS panels

1. Locate the node for the Ultricore BCS Redundancy System in the Tree View of DashBoard.

2. Expand the Ultricore BCS Redundancy System node.

3. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

4. Select the BCS Redundancy tab.

5. Click Force BCS Active/Standby Failover.

6. Verify that the switch occurred by checking the values in the Shared IP Address and Active IP 
Address fields in the BCS Redundancy tab,

Disabling the Ultricore BCS Redundancy Mode
Disabling the redundancy mode between two Ultricore BCS panels requires you to:

1. Disable the redundancy mode in DashBoard.

2. Reset the IP address on each Ultricore BCS panel.

3. Manually add each Ultricore BCS panel to the Tree View in DashBoard.

To disable redundancy mode

1. Locate the node for the Ultricore BCS Redundancy System in the Tree View of DashBoard.

2. Expand the Ultricore BCS Redundancy System node.

3. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.



Ultricore BCS User Guide (v9.0) Setting up a Redundant System • 167

4. Select the BCS Redundancy tab.

5. Clear the BCS Redundancy Enabled box.

To manually add the first Ultricore BCS to the Tree View in DashBoard

1. In the Basic Tree View toolbar of DashBoard, click .

The Add New Connections dialog opens.

2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Enter the IP Address for the first Ultricore BCS in the IP Address field.

6. Click Detect Frame Information.

7. Click Finish. 

The first Ultricore BCS now displays in the Tree View. 

To manually add the second Ultricore BCS to the Tree View in DashBoard:

1. In the Basic Tree View toolbar of DashBoard, click .

The Add New Connections dialog opens.

2. Expand the openGear/DashBoard Connect node.

3. Select TCP/IP DashBoard Connect or openGear Device.

4. Click Next >.

The TCP/IP DashBoard Connect/openGear Device dialog opens.

5. Enter the IP Address for the second Ultricore BCS in the IP Address field.

6. Click Detect Frame Information.

7. Click Finish. 

The second Ultricore BCS now displays in the Tree View. 
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System Integration Examples
There are many aspects of Ultricore BCS that you can configure to suit the needs of your 
organization. The properties that you are able to configure depends on your user permissions. Note 
that the information provided is for illustration purposes only, and the requirements for your 
facility may differ from what is presented.

Adding Ultricore BCS to Legacy Systems
In this example, you have legacy NK routers without remote control panels but you want to add the 
Ultricore BCS as a system controller.

You can use Ultricore BCS and a series of NK-NETs to provide Ethernet connectivity for T-Bus based 
legacy systems.

Figure 38  Adding Ethernet Communications via an Ultricore BCS
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Integrating Third Party Routers with an Existing System
Ultricore BCS integrates supported third-party routers using GVG protocol translation. In this 
configuration, the Ultricore BCS or the Ross router is the system master. 

Figure 39  Integrating Third-Party Routers with an Ultricore BCS
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Adding Third Party Control to Existing Systems
If you have an existing Ross routing system, you can add an external controller, such as an 
automation device, that is compatible with a supported third-party protocol. In this example, the 
Ultricore BCS acts as the system controller and provides a protocol translation for the external 
third-party control device. 

To add the third-party controller to your router system, connect the external controller to Ultricore 
BCS and configure Ultricore BCS to translate between the third-party controller and the rest of your 
Ross routing system. 

Figure 40  Adding Third-Party Control with an Ultricore BCS
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External Control
This chapter lists the third-party protocol commands the Ultricore BCS supports.

Ultricore BCS Control with Third-Party Systems
Ultricore BCS may be controlled by third-party control or automation systems via the GVG Native 
Series 7000 or Probel SW-P-08 protocols.

The Ethernet interfaces to these protocols are automatically started with Ultricore BCS and no 
further configuration is necessary. However, you must configure your external control systems to 
match the settings outlined in Table 3. 

For More Information on...
• defining an Ethernet connection between Ultricore BCS and an external device, refer to 

“Incoming Ethernet Connections”.

Third-Party Matrix Control with Ultricore BCS
The Ultricore BCS control system is able to control third-party matrix devices. Two popular routing 
protocols are available to enhance compatibility: GVG Series 7000 and Probel SW-P-08.

To configure third-party matrix control

1. Create an outgoing connection point from the Ultricore BCS to the third-party matrix device.

2. Define the external matrix.

3. Mapping the external matrix inputs and outputs.

4. Define the Ultricore BCS operating level.

5. Assign external matrix to the Ultricore BCS source and destination levels.

The following sub-sections outline each step required to configure third-party matrix control.

Create an Outgoing Connection Point
You must define an interface for the system to access third-party matrix devices. The connection 
point must be compatible with the settings of the external device you are trying to control.

Before proceeding, ensure that you have the following connection specifics:

• Communication protocol (GVG Native Series 7000 or Probel SW-P-08)

• Communication type (TCP/IP or serial1)

Refer to “Connecting to Third-Party Devices” details.

Figure 41  Example of an Outgoing Connection

1. Only available natively on the Ultricore BCS Central Controller. Serial connections from Ultrix requires an external 
USB-serial converter.
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Defining the External Matrix
The system does not automatically know the details of any connected third-party matrix. The user 
must manually define the size and operating level within the Ultricore BCS database. 

For example, Figure 42 defines a 16x16 router connected via the out-going connection DeviceID 
called 'gvg'. The router is configured to respond to commands on level 5 (protocol level 5, not 
Ultricore level 5).

Figure 42  Example of a Third-party Matrix

Creating a Logical Matrix for an External Device

Once you establish a valid connection point between the Ultricore BCS router and an external 
device, you can create logical matrices in an Ultricore BCS database using the device inputs and 
outputs. Creating a logical matrix from the external device enables Ultricore BCS to include the 
inputs and outputs for selection in the Sources and Destination tabs of the Ultricore BCS database.

 The input/output range and level you specify in the Ultricore BCS database must match the 
settings within the external matrix. 

To create a logical matrix from an external device

1. Expand the Database node.

2. Double-click the Third Party Matrices node located under the Database node.

The Third Party Matrices tab opens. 

3. Click Edit > Insert to display the Insert Matrix dialog.

4. In the Name field, type a unique identifier for the third-party matrix. This name is used to 
identify the matrix within the Ultricore BCS database.

5. Click Apply to close the Insert Matrix dialog and add a blank row to the Third Party Matrices 
table.

In the example below, a new matrix named “Matrix 2A” was added.



Ultricore BCS User Guide (v9.0) External Control • 175

6. From the Device ID drop-down menu, select the device you want to define the logical matrix 
for. This is the name given to the device when you established a connection point with it on the 
Connections tab.

 The Device ID menu lists only the third-party devices that have a valid connection point with the 
Ultricore BCS router.

7. Define the matrix size as follows:

a. Use the First Output and Last Output fields to define the range of destinations from the 
device within the Ultricore BCS database.

b. Use the First Input and Last Input fields to define the range of sources from the device 
within the Ultricore BCS database.

 These created inputs and outputs will use the nomenclature DeviceID.Slot.Port.Type.Channel 
where DeviceID represents the Name assigned to the external device on the Connections tab.

8. Use the Level field to specify the number of levels for the device within the Ultricore BCS 
database.

9. Use the Type field to specify the signal type for the matrix. 

10. Click Apply to save the new matrix to the database and add it to the list of available matrices in 
the Port Labels tab.

Mapping the External Matrix Inputs and Outputs
Once the connection point and matrix are defined in the Ultricore BCS database, you can map the 
external matrix inputs and outputs in the same manner as we do with Ross device matrices. 
However, you will instead select an external matrix output from the Outputs list (or an external 
matrix input from the Inputs list) in the database interfaces. The available inputs and outputs will 
display in the format of DeviceID.slot#.in[x].Type.ch# or DeviceID.slot#.out[x].Type.ch#. 

 It may be necessary to create a new level in the Ultricore BCS database for the assignment of 
inputs and outputs to logical labels. Refer to “Defining the Levels in a Database” for details.

For More Information on...
• assigning destinations, refer to “Defining the Destinations in a Database”.
• assigning sources, refer to “Defining the Sources in a Database”.

Using Index Numbers
Some protocols refer to source and destinations with a numerical index number. This number is 
listed in the ID column of the Source and Destination tabs of the Ultricore BCS database.

For example, the GVG protocol reference to destination ‘00h’ correlates to Ultricore BCS destination 
ID 1 in the case shown below for the Dest 1 entry in the table.

Figure 43  Example of ID Numbers Listed in a Destinations Tab
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GVG Series 7000 Native Protocol Commands
Ultricore BCS supports the GVG Series 7000 Native protocol and is available over an RS-422 or 
RS-232 serial connection, as well as Ethernet connection. 

Table 12 summarizes the settings in the Protocol Options dialog for the GVG Series 7000 Native 
protocol.  

Table 13 lists the GVG Native Protocol commands the Ultricore BCS supports.

Table 11  Default GVG Native Connection Types

Setting
Serial
Connection Type RS422 or RS232

Baud 38400

Data Bits 8

Parity None

Stop Bits 1

Ethernet

Port 12345a

a. Port 12345 is the default value but is user 
configurable.

Table 12  Protocol Options — GVG Series 7000 Native

Option Setting Notes
L4 Echo Yes Send command acknowledgments on 

protocol layer 4 (Ethernet only)

No Do not send acknowledgments. This 
is the default.

Table 13  GVG Native Protocol Commands

Message
NotesCommand Description

BK[,parameter]
BK,D Force next QD command to 

return status of all destinations
Clears the flags associated with the D,no_parameter 
command. After BK,D is sent, the next QD,no_parameter 
command will result in destination statuses or all 
destinations being returned.

BK,E Request status of level 4 echo 
setting

BK,E,ON Set level 4 echo to on An err=00 response will be returned for successful 
commands that do not generate their own response (eg. 
Take commands).
This is a per session setting.

BK,E,OFF Set level 4 echo to off (default) No response will be given for commands that do not 
generate their own response.

PR,dest_name,level_bitmap Protects a specific destination 
from having its source changed

ER error-code response is currently not supported.

QC[,dest_name] Query Combined Destination 
status by name
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For More Information on...
• these commands, refer to the GVG protocol documentation.

QD[,dest_name] Query Destination status by 
name

No information is returned for unmatched destination levels

Qd[,dest_name] Query Destination status by 
name

Sets response src_name to NO_XPT for unmatched 
destination levels

QI,destIndex,lvlIndex Query Destination status by 
indexa

Qi,destIndex,lvlIndex Query Destination status by 
indexa

The srcIndex returned will be 0xfffe if an error condition 
applies to the crosspoint being reported.

QJ[,destIndex] Query Destination status by 
indexa

No information is returned for unmatched destination levels

Qj Query Destination status by 
indexa

Sets response srcIndex to 0xFFFe for unmatched destination 
levels

QN,parameter
QN,S Query source names/labels

QN,D Query destination names/labels

QN,L Query level names/labels

QN,IS Query names via source indexa

QN,ID Query names via destination 

indexa

QN,V Query salvo name

QT Query date and time

TA,dest_name,nbr_sources,src_name_
entry1[,...src_name_entryn]

Takes sources (on specified 
levels) to specified destination, by 
name rather than index

Src_name_entryn = src_name,level_bitmap

TD,dest_name,src_name_entry Takes same source to all or 
specified levels

Src_name_entryn = src_name[,levelbitmap]
No levelbitmap=all destination levels

TI,destIndex,srcIndex[,levelIndex] Request take by index with level 
indexa

TJ,destIndex,nbr_sources,srcIndex,leve
l_bitmap[,...,srcIndex,level_bitmap]

Takes sources (on specified 
levels) to specified destinations 
by index rather than name; allows 
breakaways

TS,salvo_name Request Take Salvo

UP,dest_name,level_bitmap Removes Protect from specified 
destination

ER, error-code response is currently not supported.

a. Zero-based hex logical index numbering.

Table 13  GVG Native Protocol Commands

Message
NotesCommand Description
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RossTalk Commands
The RossTalk protocol is a plain text based protocol that allows control of Ross Video equipment.

 Each command should be terminated by a carriage return and a line feed (CR/LF).

To send RossTalk commands to Ultricore BCS

1. Create a network connection to the Ultricore BCS router on Port 7788.

2. At the prompt, enter the commands you wish to send. Refer to Table 14 for a list of supported 
commands.

Table 14  RossTalk Protocol Commands

Message
Notes

Command Description
GPI ## Execute the salvo number corresponding 

to the numerical ## extension of the 
command

For example, GPI 04 triggers the salvo <salvo_name>[4] as 
listed in the Ultricore BCS database

TIMER ##:RUN Request Timer ID to start/resume

TIMER ##:STOP Request Timer ID to stop

TIMER ##:PAUSE Request Timer ID to pause

TIMER ##:END Request Timer ID to end

TXTLABEL ID:<id>; TEXT:<text>; 
BGCLR:<bgcolor>; TXTCLR:<textcolor>

Where:
• <id> is a unique "rosstalk id" associated 

with an Ultriscape RossTalk display 
object. This field is compulsory.

• <text> is the text to be displayed. This 
field is optional.

• <bgcolor> is the background color of the 
text label. Specified in comma 
separated RGB format using 2 byte hex 
values (eg RR,GG,BB). This field is 
optional.

• <textcolor> is the text color of the text 
label. Specified in comma separated 
RGB format using 2 byte hex values (eg 
RR,GG,BB). This field is optional.

There is a 20 character maximum.
Messages with only the id field will be ignored. 
The following is an example of a message:
TXTLABEL ID:25; TEXT:CAM1; BGCLR:00,00,00; 
TXTCLR:FF,FF,FF

Note that <bgcolor> and <textcolor> are specified as R,G,B 
triplet. For example:
• 255,255,255 or 0xff,0xff,0xff is white

• 0,0,0 or 0x0,0x0,0x0 is black

• 255,0,0 or 0xff,0x0,0x0 is red 

XPT D:<dest> S:<source> I:<user_id> 
[L:<levels>]

Crosspoint command for a router TAKE 
where:
• <dest> is the logical destination ID from 

the active database (1-based)

• <source> is the logical source ID from 
the active database (1-based)

• <user_id> is the numeric user/panel ID 
that will be used to request the switch

• <levels> is an optional parameter 
specifying comma-separated list of 
1-based level IDs to switch (for 
breakaway, e.g. L:1,2,4). If no levels are 
specified, a follow switch (all valid levels) 
is requested. 

• <levels> supports ranges specified by 
two numbers separated by dash (e.g. 
L:1-16)

Range start value must be less than the end value
Single levels and ranges can be mixed in the list (eg. 
L:1,3,4-8,12-17)
There are no spaces between numbers or ranges
Invalid numbers or improperly specified ranges will be 
ignored 
An argument is separated from its value using a single colon 
(:)
Command arguments are separated single spaces
The arguments may be specified in any order, (e.g. these are 
equivalent: XPT D:1 S:4 I:2 and XPT S:4 I:2 D:1)
Examples:
• ID 7 requesting to switch Dest 2 to Source 1 on Levels 1,3,5 

and 12-16

• XPT I:7 D:2 S:1 L:1,3,5,12-16
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Probel SW-P-08 Protocol Commands
Ultricore BCS supports the Probel SW-P-08 protocol and is available over an RS-422 or RS-232 serial 
connection, as well as ethernet connection. Table 15 provides the default values for this protocol. 

When Ultricore BCS is the controller, Probel SW-P-08 System 1 is implemented. When Ultricore 
BCS is not the controller, Probel SW-P-08 System 3 is implemented (where equipment functions 
exist). 

Table 16 summarizes the settings in the Protocol Options dialog for the Probel SW-P-08 protocol.  

Table 17 lists the Probel SW-P-08 Serial Protocol commands the Ultricore BCS supports.

Table 15  Default Probel SW-P-08 Connection Types

Setting
Serial
Connection Type RS422 or RS232

Baud 38400

Data Bits 8

Parity None

Stop Bits 1

Ethernet

Port 8910a

a. Port 8910 is the default value but is user configurable.

Table 16  Protocol Options — Probel SW-P-08 protocol

Option Setting Notes
Protocol Variant Non-extended Use non-extended commands only

Extended Use extended commands only

Use Last Request Use command set as per last received 
command format (e.g. if received a 
non-extended command, reply in a 
non-extended format). This is the 
default.

Matrix Mode Yes Swap matrix and level fields

No Do not swap matrix and level fields. 
This is the default.

Unused Field # Send number (0-15) in either Level or 
Matrix field - which ever is not used as 
per Matrix Mode setting. The default 
is 0.

Table 17  Probel SW-P-08 Native Protocol Commands

Request Message Response Message

Notes
Cmd 

ID
Description Cmd 

ID
Description

01 Crosspoint Interrogate 03 Crosspoint Tally Get single crosspoint status

02 Crosspoint Connect 04 Crosspoint connected Take single crosspoint
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10 Protect Interrogate 11 Protect Tally Get destination protect 
status

12 Protect Connect 13 Protect connected Set destination protect

14 Protect Disconnect 15 Protect dis-connected Turn off destination protect

17 Protect Device Name Request 18 Protect Device Name Response Get name of device that hold 
protect

19 Protect Tally Dump Request 20 Protect Tally Dump Get all protect status

21 Crosspoint Tally Dump Request 22, 23 Crosspoint Tally Dump Get all crosspoint status
Cmd22: Byte max dest 191
Cmd23: Word max. dest. 
65535 

97 Implementation Request 98 Implementation Status Get list of commands 
supported

100 All Source Names Request 106 Source Name Response Get all source names (8 char. 
max.)

101 Single Source Name Request 106 Source Name Response Get single source names (8 
char. max.)

102 All Destination Association Name 
Request

107 Destination Association Name 
Response

Get destination names (8 
char. max.)

103 Single Destination Association Names 
Request

107 Destination Association Name 
Response

Get single destination name 
(8 char. max.)

104 All UMD Labels Request 108 UMD Label Response Only one set of labels is 
currently supported. UMD 
Labels replicate source 
labels. (16 char. max.)

105 Single UMD Labels Request 108 UMD Label Response Get single source label (16 
char. max.)

120 Crosspoint Connect On Go Group Salvo 122 Crosspoint Connect On Go Group Salvo 
Acknowledge

Add crosspoint to preset 
group

121 Crosspoint Go Group Salvo 123 Crosspoint Go Done Group Salvo 
Acknowledge

Switch/clear preset group

124 Crosspoint Salvo Group Interrogate 125 Crosspoint Group Salvo Tally Preset group status

EXTENDED
129 Extended Crosspoint Interrogate 131 Extended Crosspoint Tally Get crosspoint status

130 Extended Crosspoint Connect 132 Extended Crosspoint Connected Take single crosspoint

138 Extended Protect Interrogate 139 Extended Protect Tally Get destination protect 
status

140 Extended Protect Connect 141 Extended Protect Connected Protect a destination

142 Extended Protect Disconnect 143 Extended Protect Disconnected Turn off protect for a 
destination

147 Extended Protect Tally Dump 148 Extended Protect Tally Dump Message Get all protect status for 
given level

149 Extended Crosspoint Tally Dump 151 Extended Crosspoint Tally Dump Word 
Message

Get destination status for 
given level

228 Extended All Source Names 234 Extended Source Name Response Get source names (8 char 
max.)

229 Extended Single Source Name 234 Extended Source Name Response Get single source name (8 
char max.)

230 Extended All Destination Association 
Names

235 Extended Destination Association 
Names Response

Get all destination names (8 
char. max.)

231 Extended Single Destination 
Association Name

235 Extended Destination Association 
Names Response

Get single destination name 
(8 char. max.)

Table 17  Probel SW-P-08 Native Protocol Commands

Request Message Response Message

Notes
Cmd 

ID
Description Cmd 

ID
Description
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Communication Options in DashBoard 
When setting the protocol to SWP-08 protocol in DashBoard, the following menu options are 
available: Protocol Variant and Use Matrix Instead.

Figure 44  Communication Dialog — SWP-08 Options

Protocol Variant

This menu option selects standard messaging or extended messaging. Extended messaging allows 
for matrix sizes greater than 1024. Choose from the following:

• Use Last Req. — Ultricore BCS will respond in the same message format (either standard or 
extended) as the request format

• Non Extended — Ultricore BCS will respond using the standard message format.
• Extended — Ultricore BCS will respond using the extended message format.

Use Matrix Instead

This menu option allows external devices to refer to Ultricore BCS database levels as a matrix 
number rather than a level number. Ultricore BCS will map the database levels 1 to 1 in the matrix 
numbering scheme of the protocol.

NVISION Commands
Ultricore BCS supports the NVISION NP16 Ethernet protocol.

 Ensure that the Ultrix router has the Ultricore-NVISION license installed. Refer to the Ultrix User 
Guide for details.

232 Extended Single UMD Label Request 236 Extended UMD Labels Response Get all source labels (16 char. 
max.)

233 Extended Single UMD Label Request 236 Extended UMD Labels Response Get single source label (16 
char. max.)

248 Extended Crosspoint Connect On Go 
Group Salvo

250 Extended Crosspoint Connect On Go 
Group Salvo Acknowledge

Preset group acknowledge

124 Crosspoint Group Salvo Interrogate 253 Extended Crosspoint Group Salvo Tally Preset group status

Table 17  Probel SW-P-08 Native Protocol Commands

Request Message Response Message

Notes
Cmd 

ID
Description Cmd 

ID
Description
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Table 16 summarizes the settings in the Protocol Options dialog for the NVISION protocol.  

NVISION NP16 Ethernet Protocol
Ultricore BCS supports the NVISION NP16 Ethernet protocol. Table 19 outlines the default values 
for the Ultricore BCS when using NP16.

NP16 Commands

The NP16 protocol defines the message format: Protocol ID | Sequence Number | byte count | 
Command

Each field consists of a 32bit number where:

•  Protocol ID — 0x0000000C (Router Control Protocol)
•  Sequence number — controller generated and added to Ultricore BCS response message
•  byte count — total number of bytes in message including header (<8176)
•  Command — refer to Table 20

 The protocol is zero based, meaning that destination 0 in the protocol relates to destination ID#1 
in Ultrix. This is true for sources, destinations, and level values.

Refer to Table 20 for a list of supported NP16 commands.

NVISION NP0010 Serial Protocol
Ultricore BCS supports a limited sub-set of the NVISION serial NP0010 protocol.

Table 18  Protocol Options — NVISION protocol

Option Setting Notes
Offset 0 The Ultricore BCS level matches the 

NVISION level

1 The Ultricore BCS level is the NVISION 
level plus 1

Table 19  Default Connection Types — NVISION NP16

Setting
TCP Port 5194

Table 20  NP16 Protocol Commands

Message
Notes

Command Description
0x0000 0050 Performs a TAKE

0x0000 0051 Set Output LPR Sets or releases a lock or protect on a 
destination

0x0000 0052 Get Status of Outputs Retrieves the crosspoint status

0x0000 0059 Router Partition Information

0x0000 005E Crosspoint Tally Retrieves the crosspoint status

0x0000 0070 Machine Control Take Format 1 only
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Table 21 outlines the default values for the Ultricore BCS for an NP0010 serial connection.

Refer to Table 22 for a list of supported NP0010 commands. 

TSL UMD Protocol v3.1 Commands
Table 23 outlines the default values for the Ultricore BCS when using TSL UMD v3.1.

Protocol Implementation
Ultricore BCS implements the protocol with the following structure: DisplayID | Control | 
DisplayData.

Table 24 lists the TSL UMD Protocol v3.1 commands the Ultricore BCS supports.

Table 21  Default Connection Types — NVISION NP0010

Setting
Connection Type RS232, RS422

Baud 9600, 19200, 38400, 56700, 115200

Data Bits 8

Parity No

Stop Bits 1

Table 22  NP0010 Protocol Commands

Message
Notes

Command Description
0x50 Take Non-timestamped version only

0x51 Destination status Get destination status

0x55 Lock destination Assert a destination lock

0x56 Protect destination Assert a destination protect

0x58 Release destination lock/protect Releases the destination lock and protect

0x66 Destination LPR state Get destination locked/protect/released 
status

Table 23  Default Connection Types — TSL UMD v3.1

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet

TCP Port 5727

UDP Port 4490
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TSL UMD Protocol v4.0 Commands
 Table 25 outlines the default values for the Ultricore BCS when using TSL UMD v4.0.

Protocol Implementation
Ultricore BCS implements the protocol with the following structure: Header | Control | DisplayData 
| VBC | XData.

Table 26 lists the TSL UMD Protocol v4.0 commands the Ultricore BCS supports.

Table 24  TSL UMD Protocol v3.1 Commands

Protocol 
Breakdown Description Ultriscape System Use

Display Address 0 - 126 display identification enumeration DisplayID associated with source or 
destination

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Tally 1 (Red)a

a. Green/Red may be swapped by configuring the Global Tally Settings in the Ultriscape Head 
interface for an Ultrix router. Refer to the Ultrix User Guide for details on these settings.

Bit 1 Tally 2 status Tally 2 (Green)

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bits 4-5 Brightness value Not used

Bit 6 Reserved Not used

Bit 7 0 Not used

Display Data 16 ASCII display characters (20h-3Eh) UMD Display Text

Table 25  Default Connection Types — TSL UMD v4.0 

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet

TCP Port 5728

UDP Port 4491

Table 26  TSL UMD Protocol v4.0 Commands

Protocol 
Breakdown Description Ultriscape System Use

Header 0x80 + 0 - 126 display address DisplayID associated with source or 
destination
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TSL UMD Protocol v5.0 Commands
Table 27 outlines the default values for the Ultricore BCS when using TSL UMD v5.0.

Control Byte

Bit 0 Tally 1 status (1=on, 0=off) Not used

Bit 1 Tally 2 status Not used

Bit 2 Tally 3 status Not used

Bit 3 Tally 4 status Not used

Bit 4-5 Brightness value Not used

Bit 6 0=display data, 1=command data Display data only (0)

Bit 7 0 Not used

Display Data 16 ASCII display characters (20h - 7Eh) UMD display text

VBC

Bits 3-0 Byte count of XData

Bits 6-4 Minor protocol version (v4.0=0)

Bit 7 0

XData1

Bits 0-1 Right Hand tally valuea Not implemented

Bits 2-3 Text display valuea Sets PiP label (UMD) text background color

Bits 4-5 Left hand tally valuea Displayed in either border or text 
background; can be either or both

Bit 6 Reserved

Bit 7 0

XData2

Bits 0-1 Right Hand tally value Not implemented

Bits 2-3 Text display value Not implemented

Bits 4-5 Left hand tally value Not implemented

a. Where 0=off, 1=Red, 2=Green, 3=Amber

Table 27  Default Connection Types — TSL UMD v5.0

Setting
Serial
Connection Type RS422

Baud 38400

Data Bits 8

Parity Even

Stop Bits 1

Ethernet

TCP Port 5729

UDP Port 4492

Table 26  TSL UMD Protocol v4.0 Commands

Protocol 
Breakdown Description Ultriscape System Use
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Protocol Implementation
Ultricore BCS implements the protocol with the following structure: PBC | Ver. | Flags | Screen | 
DMSG (Index, Control, Length, Text).

Table 28 summarizes the settings in the Protocol Options dialog for the TSL UMD v5.0 protocol.  

Table 29 lists the TSL UMD Protocol v5.0 commands the Ultricore BCS supports.

Table 28  Protocol Options — TSL UMD v5.0 protocol

Option Setting Notes
Wrapping Yes Wrap commands for TCP mode

No Do not wrap commands (UPD mode). 
This is the default.

PBC in Count 
Value

Yes Include the Packet Byte Count field 
when calculating the byte count value

No Do not include the Packet Byte Count 
field in the byte count value. This is 
the default.

Table 29  TSL UMD Protocol v5.0 Commands

Protocol 
Breakdown Description Ultriscape System Use

PBC Total byte count of packet

Ver. Minor version number (0=v5.00)

 Flags

Bit 0 0=ASCII strings, 1=UTF-16LE

Bit 1 0=display data, 1=screen control Display data only (0)

Bits 2-7 Reserved (0) Not used

Screen 16bit Screen ID ScreenID associated with source or 
destination

DMSG

Index 16bit Display Address DisplayID associated with 
source or destination

Control Minor protocol version (v5.0=0)

Bits 0-1 Right hand tally valuea

a. Where 0=Off, 1=Red, 2=Green, 3=Amber

Sets right-hand tally indicator color 
(Ultriscape configuration dependent)

Bits 2-3 Text display valuea Sets text background and border color

Bits 4-5 Left hand tally valuea Sets left-hand tally indicator color

Bits 6-7 Brightness value (0-3) Not implemented

Bits 8-14 Reserved (0)

Bit 15 0=display data, 1=command data Display data only (0)

Length Byte count of text

Text Text as defined by Flag 0 setting UMD display text
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Communication Options in DashBoard 
When setting the protocol to TSL UMD v5.0 protocol in DashBoard, there is the option of enabling a 
wrapping where:

• Packet start is delimited by the sequence DLE/STX.
• Any occurrence of the DLE character in the packet is byte stuffed to DLE/DLE.
• DLE is defined as 0xFE
• STX is defined as 0x02

Figure 45  Communication Dialog — TSL UMD v5.0 Options

Enabling SNMP Support
Ultricore BCSs running software version 3v4 or higher provide optional support for remote 
monitoring and control of your router using SNMP (Simple Network Management Protocol). This 
protocol is compatible with many third-party monitoring and control tools. 

 The MIB file provides SNMP traps for the configurable alarms on Ultricore BCS as well as on the 
power supplies and fans.

Enabling SNMP Support
The SNMP monitoring and control feature for your Ultricore BCS is a software option that you 
enable in the System Status > Network tab.

To enable SNMP support on the Ultricore BCS

1. Verify that the SNMP license key is installed for the router. Refer to “Installing a License Key” 
for details.

2. In the Tree View of DashBoard, double-click the System Status node under the Ultricore BCS 
node.

The System Interfaces display in the DashBoard window.

3. Select the Network tab.

4. Locate the SNMP area of the tab.
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5. Select the Enable SNMP box.

6. Ensure that the Alarms you want to monitor via SNMP are also enabled on the Ultricore BCS 
router.

• “Monitoring the Hardware”
• “Monitoring the Communications”
• “Monitoring the Signals”

Configuring the SNMP Agent using DashBoard
The SNMP Agent on the Ultricore BCS uses SNMP version 2 to allow queries of the configured 
system alarms, and state changes to configured alarms will be sent out as SNMP traps to the 
specified Trap Destination IP Address(es).

Whenever the options in the SNMP area are edited, the SNMP Agent is restarted. It can take up to 
10 seconds for all monitored states to be updated. This latency only applies once on startup.

To configure the SNMP Agent using DashBoard

1. In the Tree View of DashBoard, double-click the System Status node under the Ultricore BCS 
node.

The System Interfaces display in the DashBoard window.

2. Select the Network tab.

3. Locate the SNMP area of the tab.

4. Use the SNMP Community Name field to specify the SNMP password for GET requests. For 
example, public.

5. Use the SNMP Trap Destination IP Address field to specify the target address to which traps 
should be sent.

An example of a valid target is provided in the SNMP area.

 A maximum number of six strings are displayed in the SNMP Trap Destination IP Address field 
at one time. If at the maximum number, you must select a string from the field and delete it 
before adding a new target entry.

6. Press [Enter] to apply the changes.

Ember+ Registration and Discovery
This section provides information on the setup and operation for the Ultricore BCS to communicate 
with a third-party control system via the Ember+ media distribution protocol.
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Establishing a Connection
To establish a connection between the Ember+ client and the Ultricore BCS

1. Configure your network streams.

2. Configure your router database.

3. Install the Ultricore-EMBER+ license on the Ultricore BCS. This enables the Ultricore BCS to start 
an Ember+ server and listen to incoming connections.

4. Add the Ultricore BCS in the Ember+ control system interface using the IP Address assigned to 
the Ultricore BCS.

5. In the Ember+ controls system, set the TCP port to 9000 for the Ultricore BCS.

Specifying the Operation Mode
Ultricore BCS can be controlled via Ember+ in two modes: Virtual Mode (table mapped IO) or 
Physical Mode (direct socket control). 

To specify the Ember+ operation mode on the Ultricore BCS

1. Display the Connections tab for Ultrix as follows:

a. Expand the Database node in the Tree View.

b. Double-click the Connections node.

2. Click Options in the Protocol Servers area.

The Server Options dialog opens.

3. Use the Ember Plus menu to specify the operation mode required by your Ember+ control 
system. Choose from the following:

• Virtual Mode — each level is represented by a Matrix and the Labels will be the one defined 
in the Destinations and Sources tabs.

• Physical Mode — the whole router is represented as a single Matrix and the physical socket 
labels are used. The external control system using Ember+ commands bypasses the virtual IO 
mapping and directly controls the Ultrix physical socket connections. Therefore the Ultrix 
should not be switched by any other devices.

4. Click Apply to close the dialog.

5. Click Apply at the bottom of the Connections tab to apply the new setting.

Supported Commands
We support the Get Directory and Connect commands. The router is represented using the 
Ember+ Matrix object including Labels. This allows the Ember+ control system to see the number of 
levels, number of sources and destinations and their labels, the per destination status, and issue 
switch commands.

 If you make changes to the router database (such as Levels, Destinations and Sources) after 
establishing communications, you may need to refresh/reload/reconnect the connection.
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Monitoring
The status of the Ultricore BCS may be monitored via its fields in the DashBoard client software or 
the LEDs located on the front panel of the chassis.

Enabling Logging for the Ultricore BCS
The Ultricore BCS records events in non-volatile memory. Each event includes a timestamp, and 
information about the event. The following events and conditions are recorded in the logs:

• Configuration changes that affect the routing path.
• Input state changes such as video presence, audio presence, video formats. In the case of audio 

inputs, the log entry also includes the associated audio cluster.
• Power-on or reboot cycles.
• Error conditions reported by DashBoard.

 You can also monitor the overall routing system status via 

To enable the Ultricore BCS to log events

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Setup tab.

3. Select the Logging box.

Monitoring the Network Status
The Ethernet ports on the Ultricore BCS rear panel are used to connect to an Ethernet network for 
communications.

To verify the Ethernet redundancy status via the System Status interface

1. In the Tree View of DashBoard, double-click the System Status node.

The System Interfaces display in the DashBoard window.

2. Select the Network tab.

3. Refer to Table 33 for a summary of the possible messages displayed in the Network tab.

Using the System Logs in DashBoard
An entry in each log includes a timestamp, a code number, and a description. Messages are written 
to the log when significant changes occur in the operation of the Ultricore BCS. These could include: 
changes to video, reference, audio or time inputs; power-on or reboot cycles; configuration changes 
that can have an effect on the routing path; alarm conditions.

To access the system logs in DashBoard

1. Double-click the System Status node.

2. Select the Logs tab.

3. To view the communication log for the Ultricore BCS only, select the System Log option.

4. To view the log for communications between the Ultricore BCS and other devices, select the 
Controller Communications Log option.



192 • Monitoring Ultricore BCS User Guide (v9.0)

5. To view the log for executed tasks in DashBoard for the Ultricore BCS, select the DashBoard 
Communications Log option.

6. Click Refresh to update the entries for the currently selected log.

Saving the Current Settings for the Ultricore BCS
You can save the Ultricore BCS settings to a configuration file that can be used by Ross Technical 
Support for troubleshooting. Use this procedure only under the guidance of Ross Technical 
Support.

To save your setup a new file

1. In the Tree View of DashBoard, right-click the node for the Ultricore BCS that you want to save 
the settings for.

2. Select Save Configuration to File.

The Save Configuration to File dialog opens.

3. Navigate to the folder on your DashBoard computer in which you want to save the 
configuration file.

 The default location is Desktop\My Documents. 

4. Click Save.

Monitoring the Devices in a Routing System
Devices with an established and valid communication point with Ultricore BCS are reported in the 
System Monitor interface in DashBoard and the front panel display. The Ultricore BCS enables you 
to check the overall health of your routing system, allowing you to notice when a steady increase of 
values in the Memory, Disk Space, and/or System 

Monitoring via DashBoard
Ultricore BCS aggregates all the devices in a system under the System Monitor interface to provide 
system wide monitoring capabilities.

To monitor the external devices communicating with an Ultricore BCS via DashBoard

1. Double-click the System Monitor node located under the Database node.

The System Monitor tab opens.

2. Locate the Incoming Connections and Outgoing Connections areas.
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3. Notice that each row in the Incoming and Outgoing Connections area reports a count of the 
number of devices currently communicating with the Ultricore BCS in the form of x /y where x 
represents the number of connected devices and y represents the maximum number of 
connections allowed (licenses installed).

4. Use the Memory, Disk Space, and System Utilization fields to monitor traffic and 
communication between the devices in your routing system. The status bars in each field report 
when values are rising (yellow) to critical (red). 

Monitoring via the Front Panel
The Ultricore BCS front panel reports the same information as the System Monitoring tab in 
DashBoard.

Figure 46  Ultricore BCS — Example of the Front Panel Display

For More Information on...
• the front panel display, refer to “Front Panel Overview”.

Troubleshooting
Use the Memory, Disk Space, and System Utilization fields of either the hard panel or the 
DashBoard interface to observe the routing system for a period of time when troubleshooting. 
While some variation in values is expected (Memory and System), the values should return to 
acceptable levels after a while. If the values steadily increase or remain at peak levels for extended 
periods, consider the following:

Memory Utilization Disk Space UltilizationDB Clients 8
RCP Panels 3
3RD Party Control 1
Ross IP-Video 3/4
Ross IP-Audio 1/2
IP-Video 1/1
IP-Audio 1/1

188_5RU        13.62.18...
145_5RU        13.62.14...
209_5RU        13.62.20...

System Utilization

IP: 12.32.123.235

Version: x.x.x

Name: UltricoreBCS-2AE75D

Uptime: 22h 38m 19s 

Redudant Mode: active

Shared IP: 12.32.123.237

default
Active Database

25% 15% 5%
Outgoing Connections

Incoming Connections
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• Investigate the traffic in your network.
• Remove outdated or obsolete copies of system databases.
• If the value in the Memory field is high, you may wish to minimize size of the active system 

database by removing extra blank entries.

 Contact Ross Technical Support with a copy of the system logs if you need assistance. 

Monitoring the Ethernet LEDs on the Rear Panel
Each RJ45 connector on the Ultricore BCS rear panel include two LEDs that report the Ethernet 
communication activity and speed. Refer to Figure 47 for LED locations on the Ultricore BCS rear 
panel.

Figure 47  ENET Ports on Rear Panel — LEDs

Table 30 provides basic LED descriptions.

If you have any questions pertaining to the installation or operation of Ultricore BCS, please contact 
us at the numbers listed in “Contacting Technical Support”. Our technical staff is always available 
for consultation, training, or service.

Table 30  ENET Port LEDs

LED Status Description
ENET # - 
Link/Activity

Green When lit green, this LED indicates a valid link is established 
on the specified ENET port.

Flashing When flashing green, this LED indicates communication 
activity is occurring on the specified ENET port.

Off When unlit, this LED indicates an invalid link is detected on 
the specified ENET port. Verify the cable connection on the 
rear module port and your network connections.

ENET # - Port 
Speed

Green When lit green, this LED indicates the ENET Port 
communication speed is at 1Gbps.

Yellow When lit orange, this LED indicates the ENET Port 
communication speed is at 100Mbps.

Off When unlit, this LED indicates the ENET Port 
communication speed is at 10Mbps.

ENET Port 1 Speed LED

ENET Port 1 Link/Activity LED

ENET Port 2 Speed LED

ENET Port 2 Link/Activity LED
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Upgrading the Software
Ultricore BCS is upgraded through the DashBoard client. To obtain the most recent upgrade 
package, contact Ross Technical Support.

 Ensure that you are running DashBoard software version 8.0.0 or higher and that the computer 
running the DashBoard client is located on the same network as the Ultricore BCS panel.

To upgrade the Ultricore BCS software

1. Contact Ross Technical Support for the latest software version file.

2. Ensure the Ultricore BCS has a valid ethernet connection.

3. Launch DashBoard by double-clicking its ion on your computer desktop.

4. Locate the Ultricore BCS in the Tree View of DashBoard.

5. Expand the node for the Ultricore BCS to display a list of sub-nodes in the Tree View.

6. Double-click the System Status node.

The System Status tabs display in the DashBoard window.

7. Click Upload, located near the bottom of the tab.

The Select File to Upload dialog opens.

8. Navigate to the *.bin file you want to upload.

9. Click Open.

10. Click Finish to start the upgrade.

11. Monitor the upgrade.

An Upload Status dialog enables you to monitor the upgrade process.

 Avoid clicking Reboot until the Ultricore BCS has successfully completed the file upload process 
and the OK button, located in the bottom right corner of the dialog, is enabled.

12. Click OK to reboot the Ultricore BCS. 

The Reboot Confirm dialog opens, indicating the Ultricore BCS will reboot.

13. Click Yes to continue the upgrade process. 

 Ultricore BCS is temporarily taken off-line during the reboot process. The process is complete 
once the status indicators for the Ultricore BCS return to their previous status.
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DashBoard Interface Overview
The DashBoard client software enables you to monitor, configure, and operate your Ultricore BCS 
Central Controller. Using the interfaces provided via the DashBoard client software, you can:

• Configure the network connection for your Ultricore BCS
• Configure the connections to Ross NK Series routers via NK-NET or NK-IPS devices
• Configure the connections to Ross Ethernet routers and remote control panels
• Specify which attached routing devices or matrices to use
• Configure system levels and assign level names
• Assign physical router inputs and outputs to logical sources and destinations
• Configure source and destination labels
• Perform crosspoint preset/takes
• Monitor the status of multiple levels
• Create and use salvos

Ultricore BCS in DashBoard
Ultricore BCS groups the configuration, monitoring, and operating options as buttons in a toolbar in 
the DashBoard window. Each button gives access to the configuration options for your system.

Figure 48  Example of the Ultricore BCS Interface in a DashBoard Window

Ultricore BCS includes the following interfaces, as separate nodes, in the DashBoard Tree View.

System Status

Double-clicking the System Status node displays two types of tabs within the same DashBoard 
window: Status (read-only) tabs located on the left, and a series of Configuration tabs located on the 
right. This interface is similar to an openGear® card tab system.
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Database

Expanding the Database node enables you to configure the connection points, matrices, 
destinations, sources, groups, levels, soft panels, and salvos for the system. The settings are saved 
locally on the Ultricore BCS.

Devices

The sub-nodes under Devices provide a list of external devices in the routing system currently 
communicating with the Ultricore BCS.

Soft Panels

The Soft Panels tree provides access to the Matrix, MultiBus, and Category soft panels for the 
Ultricore BCS. From these panels you can perform crosspoint switches, and manage salvos via a 
DashBoard interface.

Terminology
Throughout the DashBoard interface, actual sockets (inputs and outputs) of a router (or matrix) are 
referred to by hierarchical dotted notation: Frame.Slot.Port.Type.Channel where:

• Frame identifies the physical router/device housing the matrix/matrices.
• Slot identifies which slot of the matrix is located.
• Port identifies the physical input or output socket.
• Type identifies the generic signal type (e.g. SDI, audio).
• Channel identifies the audio channel within a stream.

These designators may be assigned more user friendly names if required by editing the Port Labels 
interface.

System Status Interfaces
The System Status interface provides hardware information, IP Address settings, and general 
database management for your Ultricore BCS. The interface is organized into two distinct areas in 
the DashBoard window: Status tabs (located on the left), and Configuration tabs (located on the 
right).

Status Tabs
The Status tabs display read-only information about the Ultricore BCS hardware and software.

Product Tab

Table 31 summarizes the read-only information displayed in the Product tab.

Table 31  Product Tab

Item Parameters Description
Product Indicates the Ultricore BCS product name

Vendor Indicates the supplier/manufacturer of the 
device

System Version Indicates the build version of the Ultricore 
BCS panel
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Other Tab

Table 32 summarizes the read-only information displayed in the Other tab.

Configuration Tabs
The Configuration tabs of the DashBoard window provide network setup options for the Ultricore 
BCS panel and managing the Ultricore BCS databases.

BCS Redundancy
The BCS Redundancy tab enables you to establish a failover system between two physical Ultricore 
BCS panels. Refer to “Setting up a Redundant System” for details on using this tab.

Serial Number Indicates the serial number of the Ultricore 
BCS panel

Uptime #h #m #s Indicates the number of hours since the last 
reboot of the Ultricore BCS panel

System Time DD mm dd yyyy 
hh:mm:ss

Indicates the current date based on the 
Ultricore BCS internal clock where:
• DD represents the calendar day
• mm represents the month
• dd represents the day
• yyyy represents the year
• hh:mm:ss represents the current local 

time

Table 32  Other Tab

Item Parameters Description
Frontend SW Rev # Read-only information used by Ross 

Technical Support.Backend SW Rev #

Device FW Rev #

Table 31  Product Tab

Item Parameters Description
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Figure 49  Example of the BCS Redundancy Tab

Network Tab

Table 33 summarizes the fields and menus displayed in the Network tab. The options in the 
Network tab are organized into two sections: Settings (editable fields), and Ethernet Redundancy 
(read-only fields).

Table 33  Network Tab

Item Parameters Description
Information

Active ENET ENET # Indicates which Ethernet port on the rear panel 
is the primary Ultricore BCS network connection

ENET # LINK Connected            
(x, y)

Indicates that a valid network link is configured 
on the specified Ethernet port of the Ultricore 
BCS rear panel where:
• x represents the speed in number of Mbps
• y represents the link type (e.g. full duplex)

Not Connected Ethernet communications for the Ultricore BCS 
are invalid. The Ethernet cable may be 
disconnected on the rear panel or the Ethernet 
network may be down or experiencing 
problems.

ENET MAC 
(read-only)

# Indicates the MAC Address for the Ultricore BCS 

Settings

Address # Specifies the IP address for the Ultricore BCS 
panel

Subnet Mask # Specifies the subnet mask for the Ultricore BCS 
panel

Gateway # Specifies the gateway for communication 
outside of the local area network (LAN)

Apply Updates the Address, Subnet Mask, and Gateway settings
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Cancel Ignores any unsaved changes made to the Address, Subnet Mask, 
and Gateway settings and reverts back to the current running 
values.

Services

SSH Selected Enables system administrators to securely log 
onto remote systems and execute commands 
over an unsecured network via the Secure Shell 
(SSH) Login client-server protocol

Cleared Disables this service

FTP Selected Enables devices to transfer of files over a 
network connection

Cleared Disables this service

Walkabout Selected The Walkabout configuration software can be 
used to configure the basic network 
communications settings for the Ultricore BCS

Cleared Disables this service

Change Click this button to edit the services

SNMP

Enable SNMP Selected Enables the SNMP Agent on the Ultricore BCS

Cleared Disables the SNMP Agent on the Ultricore BCS

SNMP Community 
Name

# Specifies the SNMP Agent identifier for 
communications

SNMP Trap 
Destination IP 
Address

# Specifies the target address the Ultricore BCS 
sends SNMP traps to

Permitted Clients

DashBoards: # Lists the IP Address of each DashBoard client 
that is allowed to communicate with this 
Ultricore BCS

Add Enables you to add a new DashBoard client to the Permitted 
Clients list

Delete Deletes the selected DashBoard client from the Permitted Clients 
list

Delete All Clears all entries in the Permitted Clients list

Edit Enables you to modify the selected entry in the Permitted Clients 
list

Cancel Ignores any unsaved changes made to the Permitted Clients list 
and reverts back to the current running values. 

Apply Updates the Permitted Clients list settings

Table 33  Network Tab

Item Parameters Description
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Database Tab

Table 34 summarizes the fields and menus displayed in the Database tab. The options in the 
Database tab are organized into two sections: Current Database, and Database Management.

Table 34  Database Tab

Item Parameters Description

Current Databasea

Remote Controller 
Mode

Selected This Ultricore BCS will be controlled by a remote 
(primary) Ultricore BCS router. You must reboot 
this Ultricore BCS before the change can take 
effect.

Cleared This Ultricore BCS is a standalone or is the 
primary system controller for the routing 
system.

Name <name> Indicates the database currently loaded in 
Ultricore BCS

Levels Indicates the number of levels the database is 
configured for

Sources Indicates the number of inputs the database is 
configured for

Destinations Indicates the number of outputs the database is 
configured for

Enable Tally Selected Select this box to enable Ultricore BCS to read 
tally identifiers from the input signals. This 
information is passed through to any assigned 
outputs.
Selecting this box also updates the Sources and 
Destinations tabs with a new column “Tally” that 
is used to assign Tally IDs to sources and/or 
destinations.

Cleared Tally information from the input signals is not 
read into the database.

I/O Ports Refresh Updates the Matrix Inputs and Outputs lists in 
the Sources and Destinations tabs respectively

Crosspoint Status Refresh Updates the Status field located directly below 
this button

Status (read-only) Loaded The active database was successfully loaded. 

Errorb One of the following has occurred:
• the selected database is no longer available
• an attempt was made to delete a non-existent 

database
• an attempt was made to save a database with 

an existing name

Database Management - Load Database

Name <name> Selects the database to load for the Ultricore 
BCS
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Transfer Tab

The Transfer tab is organized into 5 sub-tabs: Ultricore Database, Ultricore Credentials, Ultricore 
Profiles, Ultriscape Layout, and Ultrix Frame Settings. Table 35 summarizes the options displayed in 
each Transfer sub-tab. 

Database Load Loads the specified database to the Ultricore 
BCS

Database to RCPs Send Forces the currently loaded database settings to 
the connected Remote Control Panels (RCPs)

Database Management - Add Database

Name <name> Provides a unique identifier for the new 
database (up to 32 characters)

Levels # Specifies the total number of levels the 
database will make available

Sources # Specifies the total number of sources the 
database will make available

Destinations # Specifies the number of levels the database will 
make available

Database Add Uses the settings in the Database Management 
fields to create a new database

Database Management - Delete Database

Name <name> Selects the database to delete

Database Delete Deletes the currently selected database

a. The Levels, Sources, and Destinations fields indicate the initial values when the database was created. 
Levels, Sources, and Destinations can be removed from or added to the database on their respective 
configuration tabs. Doing so will not alter the fields in the Database tab.

b. This message displays for a maximum of 10 seconds only.

Table 35  Transfer Sub-tabs

Item Parameters Description
Export

Database: <database 
name>

Selects the database to be exported

Save As: *.uda Automatically updates with the name of the 
database archive

Browse... Enables you to save or re-name the database to a specific location. 
The default location is

Apply Click to begin exporting the file to specified location

Import

Archive File: *.uda Indicates the last file that was imported

Browse... Enables you to specify the database to import

Table 34  Database Tab

Item Parameters Description
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Setup Tab

Table 36 summarizes the options displayed in the Setup tab.

Logs Tab

This tab includes the System Log, Controller Communications Log, and DashBoard Communications 
Log. The read-only information displayed in the logs is used by Ross Technical Support for 
diagnostic purposes.

Ultricore-IP Tab

The Ultricore-IP tab only displays when the Ultricore BCS is installed with the Ultricore-IP software 
license. This tab is organized into three areas: a top toolbar, a middle interface, and a bottom 

Retrieve Database 
As:

<database 
name>

Indicates the file currently selected for 
importing

Apply Click to begin the import

Table 36  Setup Tab

Item Parameters Description
Device Identification

Device Name <name> Provides a unique identifier for the Ultricore BCS in the 
Tree View

System 
Name

<name> Provides a unique identifier for the routing system

Log Settings

Logging Selected Enables the Ultricore BCS to update the entries in the 
System Logs interface

Cleared Disables this feature

Output 
Debug 
Messages

Selected Only use this feature under the guidance of Ross 
Technical Support.Cleared

DashBoard Interface

DashBoard 
Timeout

10-300s Sets the maximum number of seconds that DashBoard 
waits until it queries the Ultricore BCS. The default is 
10 seconds. This value is reset after a power-cycle.

Update Applies the new value in the DashBoard Timeout menu.

Status

mm/dd/yy ERROR: Duplicate 
device name [abc] for ID [#]

Reports when multiple devices, with the same name, 
are communicating with the Ultricore BCS where:
• mm/dd/yy represents the date of the error
• [abc] represents the device name
• [#] represents the ID number assigned to the device

Clear Clears the Status field entry

Table 35  Transfer Sub-tabs

Item Parameters Description
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toolbar. The information that displays in the middle interface is determined by what is selected in 
the top toolbar.

Figure 50  Example of the Ultricore-IP > Advanced Options

Table 37 summarizes the read-only fields displayed in the top and middle areas of the Ultricore-IP 
tab. The items displayed in the middle area change depending on what item is selected in the top 
toolbar.

Table 37  Ultricore-IP Tab — Top and Middle Areas

Item Parameters Description
Main

Create Connection 
with this Device

A unique identifier for the device within the NMOS communication 
system

Name The Node ID assigned to the device for NMOS communication

Description A brief description for identifying the device

IP The IP Address of the IS-04 API reported by the device

Audio Senders The total number of advertised audio sender streams from this 
device 

Video Senders The total number of advertised video sender streams from this 
device 

Receivers The total number of receiver streams available from this device

Xcup The number of active NMOS connections on this device

Status A summary of the alarms detected on the device. The most severe 
alarm is noted and the total number of alarms is also reported.

Events A list of relevant actions that Ultricore-IP is aware of such as new 
devices found, if a device/stream was created, or a stream was 
updated.

Hide The device is no longer displayed in the interface. 

Connections
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Connection Usage A summary of how many audio and video connections (a 
connection on this case is when a sender is joined to a receiver). 
There are two types: Ross connections (such as Ultrix-IP, NEWT-IPX, 
and IGGY-MADI) and third-party devices.
This information reflects the options in the License tab for the 
Ultricore BCS.

Connections A list of all connections that are created on the system which 
includes:
• what device this connection belongs to
• the ID of the receiver and sender
• any alarms that might be present on that connection
• option to destroy any connection

Status

Device ID The ID assigned to the device for NMOS communications

Device IP The IP address the device is located at

Domain The PTP domain used by the device

Gmid The PTP Grandmaster ID

Ofm PTP offset from the Grandmaster. When Slave mode is enabled, 
this should be different than 0. Ultricore-IP indicates the current 
value, an average, the minimum, and the maximum values for the 
field.

Ethernet The number of Ethernet interfaces and their Adminstrative status

Streams The total number of advertised streams detected at the devices

Alarms The total number of alarm messages found on the device

Events

Time Timestamp of when the event was originated

Type Brief description of the event

Device ID The NMOS ID assigned to the specific device

Session The NMOS ID for the sender or receiver that the event was 
originated

Description A summary of the activity with the specific device at the indicated 
timestamp

Hidden

Lists the devices that were hidden using the option in the Main interface

Debug

NMOS RDS

This area lists all the Registration and Discovery Service (RDS) currently found on the 
same network as the Ultricore BCS.

Name The reported identifier of the detected RDS

Table 37  Ultricore-IP Tab — Top and Middle Areas

Item Parameters Description
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Table 38 summarizes the fields, buttons, and menus displayed in the bottom toolbar of the 
Ultricore-IP tab. 

PRi The RDS priority (selected from a range of 0 to 99 where 0 is the 
highest priority). 
Note that when there is more than one RDS with the same priority, 
problems may arise on the network because devices and 
controllers cannot differentiate RDS with the same priority and 
they might connect to different ones, generating situations where 
the controllers do not see the devices.

IP The IP Address of the detected RDS

Port The UDP port of the detected RDS

Secure An indication if the RDS is using HyperText Transfer Protocol 
(HTTPS) and Web Services Security (wss) for its Application 
Programming Interface (API)

Versions Supported Indicates the NMOS version the RDS can support for 
communications

Statistics

This area reports the resources found on the RDS it is connected to and how many of 
those devices the Ultricore BCS was able to parse as valid.
If the device type or the resource type is not valid or not recognized by the Ultricore BCS, 
the Total Valid Found field will report smaller numbers than the line reporting the 
numbers found on the RDS.

Open Web Sockets

Ultricore-IP connects to the RDS using web sockets. This area lists the detected open 
connections. For example, if you select Advanced Options and set the NMOS IS-04 
version to v1.2 and v1.3, this field reports the entries for each version connected.

Advanced Options

NMOS IS-04 version Specifies the version of NMOS the Ultricore BCS will use to 
communicate with devices

Table 38  Ultricore-IP Tab — Bottom Toolbar

Item Parameters Description
Ultricore-IP

Status (read-only) active • Ultricore-IP is running
• If an RDS is present on the network, 

Ultricore-IP will connect to it and show the 
content found for the selection NMOS 
versions it is configured to

inactive Ultricore-IP does not detect an RDS running on 
the network

Start Communication is established between Ultricore BCS and devices 
in the NMOS system of your network. The menus and fields in the 
Ultricore-IP tab will be automatically updated.

Table 37  Ultricore-IP Tab — Top and Middle Areas

Item Parameters Description
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Database Interfaces
The Database interfaces enable you to configure devices in your routing system and configure 
control aspects for Ultricore BCS. Note that the currently active database name is displayed in 
parentheses in the tree view. For example, Figure 51, the CHK_BCS database is currently loaded. 
Unicode names are also supported so that names may be defined in other languages or writing 
systems.

Figure 51  Expanded Database Node in the Tree View

Most of the interfaces are organized into a table format with a row of buttons at the bottom of the 
interface. You can select individual cells, columns, or rows of entries to define. (Figure 52 and 
Figure 53)

Stop Stops communication between Ultricore BCS and devices in the 
NMOS system. The menus and fields in the Ultricore-IP tab are no 
longer updated.

Restart Disconnects and re-connects communication between Ultricore 
BCS and the devices in the NMOS system.

RDS Service

Status (read-only) active The RDS instance for this Ultricore BCS is 
running and waiting for devices to register

inactive The RDS instance for this Ultricore BCS is 
disabled and not available for use

Start Communication is established between Ultricore BCS and RDS in 
your network. The menus and fields in the Ultricore-IP tab will be 
automatically updated. 

Stop Stops communication between Ultricore BCS and RDS in your 
network. The menus and fields in the Ultricore-IP tab are no longer 
updated.

Restart Disconnects and re-connects communication between Ultricore 
BCS and the RDS in your network.

Table 38  Ultricore-IP Tab — Bottom Toolbar

Item Parameters Description
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Figure 52  Example of Filling a Column of Entries

Figure 53  Example of Filling a Row of Entries

 A summary of each interface is provided in the following sub-sections.

Tieline Builder Tab
The Tieline Builder creates tielines based on the routers and ports available to the Ultricore BCS 
within the current database and routing system.
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Figure 54  Example of the Tieline Builder Tab

Table 39 summarizes the options displayed in the Tieline Builder tab. 

Table 39  Tieline Builder Tab

Item Description
Existing Tielines

Tieline Name Indicates the unique identifier assigned to the tieline

From Device Indicates the router that the tieline will use as the source (start 
point)

Output Port Indicates the physical port that the tieline will use to switch the 
signal

To Device Indicates the router that the tieline will use as the destination 
(end point)

Input Port Indicates the physical port that the tieline will use to pass the 
signal through during the switch

Rename Applies a new identifier to the tieline

Remove Removes the tieline from the list and deletes it from the router 
system

From Device: Use this menu to display a list of available routers that the user 
can assign as the start point for a new tieline

Output Ports: Indicates the physical ports on the selected device that are 
available as sources for the tieline

To Device: Use this menu to display a list of available routers that the user 
can assign as the end point for a new tieline

Input Ports: Indicates the physical ports on the selected device that are 
available as destinations for the tieline

Add Tieline Adds the tieline defined using the From Device and To Device 
tables. The Existing Tielines table updates to include the new 
tieline as a row entry.
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Tieline Runtime Tab
The Tieline Runtime reports the sources and destinations for each defined tieline, enables the 
user to manage and monitor the switch requests using the define tielines.

Figure 55  Example of the Tieline Runtime Tab

Table 40 summarizes the options displayed in the Tieline Runtime tab. 

Table 40  Tieline Runtime Tab

Item Description
Existing Tielines

Tieline Name Indicates the unique identifier assigned to the tieline

From Device Indicates the router that the tieline will use as the source (start 
point)

Output Port Indicates the physical port that the tieline will use to switch the 
signal

To Device Indicates the router that the tieline will use as the destination 
(end point)

Input Port Indicates the physical port that the tieline will use to pass the 
signal through during the switch

Sources Reports the available signals on the From Device via the selected 
Output Port

Destinations Reports the available signals on the To From Device via the 
selected Input Port

Release Tieline Disables the selected tieline. It is no longer available for switching 
signals in the routing system

View Tieline Details Provides more information on the selected tieline

Destinations Using Tielines

Destination Specifies a specific destination in use by the tieline

Source Specifies a specific source in use by the tieline

Path to Source Indicates how the signal is passed through the routing system via 
the selected tieline
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Database Builder
The Database Builder interface helps you to quickly create a database by grouping basic controls on 
four pages: Quick Start, Levels, Destinations, and Sources. The same controls are available as 
sub-nodes of the Database interface.

Quick Start

The Quick Start options display by default when the Database Builder displays in DashBoard. From 
this page you can define the database properties including: type of signals (video, audio) the 
number of Ultricore BCS routers that the database includes, the audio elements of the database, 
and basic UltriScape parameters.

Figure 56  Example of the Database Builder — Quick Start Page

Table 42 summarizes the fields displayed in the options in the Quick Start page. 

Release Destination Removes the selected destination as an option for the tieline. 
This destination can no longer be used for a switch via the tieline.

View Destination 
Paths

Reports the route that the Ultricore BCS has chosen to pass the 
selected source to the end point (destination) as defined by the 
selected devices, ports, and signals.

Show Take Errors Indicates whether any error conditions are present during the 
switch the tieline

Table 41  Database Builder — Quick Start

Item Parameters Description
Database name <name> Assigns a unique identifier for the device in the 

routing system. This name is also used when 
matrices are defined in the Ultricore BCS system.

Frame select table Displays a list of detected routers in your network. 
Select a box to apply the database to the specified 
router.

Table 40  Tieline Runtime Tab

Item Description
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Levels

Once you defined the options on the Quick Start interface, you can proceed to preview and 
customize the levels, destinations, and sources this database will include. Clicking Next on the 
Quick Start page displays the Levels page. (Figure 57)

The options in the Levels page are organized into a table where each row represents a level and the 
columns provide the options for configuring that level. From this page you assign a unique name to 
each level, a color that represents the level to make it easier to identify the level in a soft panel. 

Include AUX ports None Do not create entries for AUX ports in the database

Insert at slot Create AUX port entries as they are physically 
located within the Ultricore BCS chassis (e.g. ports 
17 and 18).

At the end Create AUX ports after BNC entries

Video support Yes Creates a database that includes video and audio 
signals

No Creates an audio-only database

Audio channels # Specifies the quantity of audio channels (levels) 
required

Breakaway source 
support

Yes Create sources for audio breakaways/shuffles

No Audio breakaways are not included in this database

SDI audio per 
channel

Creates audio breakaway sources using the 
selected audio channel grouping size

MADI channels per 
source

Creates MADI sources using the selected audio 
channel grouping size

Disconnect source? Yes Creates a source that will disconnect (mute) SDI and 
audio channels

No This option is not included in the database

Passthrough 
source?

Yes Configures a source that may be routed to 
destinations so that embedded audio from 
connected SDI source is passed through without 
changes

No This option is not included in the database

Ultriscape support? Yes Enables Ultriscape heads and PiPs to be included in 
the database

No Ultriscape heads and PiPs are not included in the 
database

Number of 
Multiviewer heads

# Specifies the number of Ultriscape heads the 
database will support

Number of 
Multiviewer pips per 
head

# Specifies the maximum number of PiPs available 
per layout

Include detected 
Multiviewer layout

Creates sources for detected Ultriscape layouts to 
enable layout changing from control panels

Table 41  Database Builder — Quick Start

Item Parameters Description
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Figure 57  Example of the Database Builder — Levels Page

Destinations

Clicking Next on the Levels page displays the Destinations page. (Figure 58)

The Destinations page enables the assignment of logical labels (used by remote control panels and 
soft panels) to physical outputs of the attached matrices or routers. The options in the Destination 
page are organized into a table where each row associates a name of the destination with one or 
more logical matrix output sockets. 

Figure 58  Example of the Database Builder — Destinations Page

Sources

Clicking Next on the Destinations page displays the Sources page. (Figure 59)

The Sources page enables the assignment of labels (used by remote control panels and soft panels) 
to inputs of the attached matrices or routers. The options in the Sources page are organized into a 
table where each row associates a name of the source with one or more logical matrix input 
sockets.
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Figure 59  Example of the Database Builder — Sources Page

Connections Tab
Ross Video devices are automatically discovered and available for connection in this tab. Third-party 
devices that are not discoverable via their protocol must be manually added. This tab is divided into 
two tables: Clients and Servers.

Figure 60  Example of Entries in a Connections Tab

Clients Table

The Clients table lists the connection details of remote client devices (e.g. external devices 
connecting to this Ultricore BCS) currently communicating with the Ultricore BCS. 
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Table 42 summarizes the read-only fields displayed in the Clients table in the Connections tab. 
Table 42  Connections Tab — Clients

Item Parameters Description
Device ID <name> Specifies the external device for the 

connection point

Name <name> Assigns a unique identifier for the device in 
the routing system. This name is also used 
when matrices are defined in the Ultricore 
BCS system.

Protocol 
(read-only)

GVG Native The device uses the third-party GVG 
protocol to communicate.
Refer to “GVG Series 7000 Native Protocol 
Commands”.

NVISION This device communicates via the 
third-party NVISION protocol. Refer to 
“NVISION Commands”.

OGP This device uses the openGear Protocol to 
communicate with Ultricore BCS.

Probel SW-P-08 The device uses the third-party protocol 
known as Probel SW-P-08.

Protocol 
(read-only)

Ross NK The device uses the Ross NK protocol to 
communicate. Refer to “Ross NK Series 
Routers”.

TSL UMD v3.1 The device uses TSL UMD protocol version 
3.1

TSL UMD v4.0 The device uses TSL UMD protocol version 
4.0

TSL UMD v5.0 The device uses TSL UMD protocol version 
5.0

Ultrix The device uses the Ross Ultrix protocol to 
communicate (TCP only).

Communication type: t-bus The device is physically connected to a 
T-BUS port on the Ultricore BCS rear panel. 
Communication is via the Ross T-BUS 
protocol.

type: tcp The device is communicating over a 
network connection. Note that the 
DashBoard client computer, the Ultricore 
BCS, and the external device must be on the 
same network.

type: serial The device is physically connected to a COM 
port on the Ultricore BCS rear panel. The 
device is communicating with the Ultricore 
BCS via a serial protocol.

ip: 
###.###.###.###

Specifies the IP Address of the device on the 
network

ip: localhost Indicates that the device is the one you are 
currently configuring



Ultricore BCS User Guide (v9.0) DashBoard Interface Overview • 217

Servers Table

The Servers table lists the connection details of external devices that Ultricore BCS has established 
a connection point to (e.g. devices that are controlled by this Ultricore BCS). Entries in the Servers 
table are managed by the user as outlined in “Device Communication Setup”. 

Communication port:###.###.###.
###

Specifies the ethernet port the device is 
associated with on the network.

... This button opens a dialog allowing further 
connection point setting adjustments such 
as specifying an IP address, IP port, etc.

Details Provides additional information on the 
device such as device type, and firmware 
version

Table 43  Connections Tab — Servers

Item Parameters Description
ID # Auto-numbered field (read-only).

Device ID <name> Specifies the external device for the 
connection point

Name <name> Assigns a unique identifier for the device in 
the routing system. This name is also used 
when matrices are defined in the Ultricore 
BCS system.

Enabled Enable Direct communication is established 
between Ultricore BCS and the device.

Disable Communication between Ultricore BCS and 
the device is unavailable.

Connected 
(read-only)

Connect A valid connection is established between 
the device and the Ultricore BCS on your 
network. This box is automatically selected 
when communication is established.

Disconnect The connection is invalid or absent between 
the device and the Ultricore BCS on your 
network.

Protocol 
(read-only)

GVG Native The device uses the third-party GVG 
protocol to communicate. Refer to “GVG 
Series 7000 Native Protocol Commands”.

NVISION This device communicates via the 
third-party NVISION protocol. Refer to “GVG 
Series 7000 Native Protocol Commands”.

Probel SW-P-08 The device uses the third-party protocol 
known as Probel SW-P-08.

Table 42  Connections Tab — Clients

Item Parameters Description
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Third Party Matrices Tab
The Third Party Matrices tab configures/lists third party matrix devices. Once defined, the matrices 
are ready for mapping to source and destination labels.

Protocol 
(read-only)

Ross NK The device uses the Ross NK protocol to 
communicate. Refer to “Connecting to 
Ross NK Series Devices”.

TSL UMD v3.1 The device uses TSL UMD protocol version 
3.1

TSL UMD v4.0 The device uses TSL UMD protocol version 
4.0

TSL UMD v5.0 The device uses TSL UMD protocol version 
5.0

Ultrix The device uses the Ross Ultrix protocol to 
communicate (TCP only).

Communication type: t-bus The device is physically connected to a 
T-BUS port on the Ultricore BCS rear panel. 
Communication is via the Ross T-BUS 
protocol.

type: tcp The device is communicating over a 
network connection. Note that the 
DashBoard client computer, the Ultricore 
BCS, and the external device must be on the 
same network.

type: serial The device is physically connected to a COM 
port on the Ultricore BCS rear panel. The 
device is communicating with the Ultricore 
BCS via a serial protocol.

ip: 
###.###.###.###

Specifies the IP Address of the device on the 
network

ip: localhost Indicates that the device is the one you are 
currently configuring

port:###.###.###.
###

Specifies the ethernet port the device is 
associated with on the network.

... This button opens a dialog allowing further 
connection point setting adjustments such 
as specifying an IP address, IP port, etc.

Table 43  Connections Tab — Servers

Item Parameters Description
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Figure 61  Example of Entries in a Third Party Matrices Tab

Figure 61 shows a third party matrix called gvg router configured to use the connection DeviceID 
of “gvg”. It is configured to provide 16 inputs and 16 outputs and responds to switch commands on 
level 5.

Table 44 summarizes the options displayed in the Third Party Matrices tab. 

Table 44  Third Party Matrices Tab

Item Parameters Description
ID # Auto-numbered field (read-only).

Name <name> Assigns a unique identifier for the imported 
third party matrix to be used by the 
Ultricore BCS database. 

First Output # Specifies the first destination for the device 
within the Ultricore BCS database

Last Output # Specifies the last destination for the device 
within the Ultricore BCS database

First Input # Specifies the first source for the device 
within the Ultricore BCS database

Last Input # Specifies the last source for the device 
within the Ultricore BCS database

Level # Specifies the control level the device will 
respond to (e.g. matches the level 
configuration of the device). This is not the 
Ultricore BCS level value.

Type Specifies the signal type of inputs and 
outputs this device provides within the 
Ultricore BCS database

Device ID Specifies the DeviceID connection to use as 
entered on the Database > Connections tab
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Port Labels Tab
The Port Labels tab lists the matrices discovered by the connection points on the Connections tab 
and imported via the Third Party Matrices tab. A matrix (or router) socket is identified via the 
Frame.Slot.Port.Type.Channel nomenclature. Custom labels may be applied to the ports if 
required. These may be also known as actual labels in other terminology (the name the cable would 
be assigned). This re-naming is not necessary for operation, but it may make your assignment of 
source and destination labels easier when using your internal cable naming conventions.

Figure 62  Example of Entries in a Port Labels Tab

Table 42 summarizes the options displayed in the main area of the Port Labels tab (from left to 
right on the interface). 

Table 45  Port Labels Tab

Item Description
Matrix: Provides a list of configured matrices for the currently loaded database. 

Double-click an item in the list to update the table in the Port Labels 
tab.
By default, each router is represented by a read-only matrix in this list. 
This read-only matrix lists all the SDI signals available to the Ultricore 
BCS via that router. If you have multiple routers, each router is 
represented with a separate read-only matrix with the device name in 
the matrix name (e.g. NK-3G16.SDI [read-only], or NK-3G144.SDI 
[read-only]).

Port Indicates the physical socket on the external device that is included in 
the currently selected logical matrix using the nomenclature 
Frame.Slot.Port.Type.Channel.

Label Provides a text label that identifies the physical port in other interfaces 
of the database. This virtual label is used instead of the 
Frame.Slot.Port.Type.Channel format. For example, you might 
re-name port NK-S34.slot1.in[1].SDI.ch1 to NK-234 SDI IN 1-1.
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Bottom Toolbar

Refer to Table 70 for a summary of the buttons displayed in the Bottom toolbar of the Database 
interfaces.

Levels Tab
A level is a specific grouping of signal input and output ports, that may be controlled separately 
from other groups (a breakaway). Typically a level is associated with input/output ports that are 
used with sets of similar or related signals, such as SDI Video, AES Audio, Analog Video, Analog 
Audio, Timecode, or Machine control, and often include routing matrices that are dedicated to 
controlling that specific type of signal.

The options in the Levels tab are organized into a table where each row represents a level and the 
columns provide the options for configuring that level. From this tab you can assign a unique name 
to each level, a color that represents the level, and a textual description of the level to make it easier 
to identify the level in the soft panels.

Figure 63  Example of Entries in a Levels Tab

Destinations Tab
The Destination tab enables the assignment of labels (used by control panels) to outputs of the 
attached matrices or routers. The options in the Destination tab are organized into a table where 
each row associates the name of the destination with one or more logical matrix output sockets. 
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Figure 64  Example of Entries in a Destinations Tab

Table 46 summarizes the options displayed in the Destinations tab. 

For More Information on...
• the buttons located on the bottom toolbar for the Destinations tab, refer to Table 70.

Table 46  Destinations Tab

Item Parameters Description
ID # Auto-numbered field (read-only).

Tally TSL v3.1 <displayID> Displays the TSL protocol Tally ID entry. The 
Enable Tally box is selected in the Database 
tab. TSL 4.0 <displayID>

TSL v5.0 <screenID>:<displayID>

Tally 
Redirect

Enables/disables the re-direction of connected source Tally ID to destination Tally 
ID as set by the Tally field

Name <name> Assigns a unique identifier for the 
destination in the routing system. This 
name is also used when matrices are 
defined in the Ultricore BCS system.

Description Provides additional information or user entered notes about the output

Level # Specifies the physical output port associated with the destination and assigns it 
to the specified level. Unless you have given the port a different label via the Port 
Labels tab, the port is labeled as Frame.Slot.Port.Type.Channel.

Matrix 
Outputs

# Lists all the physical output ports available 
that can be assigned as a destination in the 
routing system

Assign Click this button to add the selected physical output port(s) to the list of 
Destinations for the database
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Sources Tab
The Sources tab enables the assignment of labels (used by remote control panels and soft panels) 
to physical input sources to specific sources based on the routers connected to the Ultricore BCS 
(and listed in the Database interface). The rows in the table are dependent on the database that is 
currently loaded. The Sources tab is organized into a table where each row associates a name of the 
source with one or more logical matrix input sockets.

Figure 65  Example of Entries in a Sources Tab

Table 47 summarizes the options displayed in the Sources tab. 

Table 47  Sources Tab

Item Parameters Description
ID # Auto-numbered field (read-only).

Tally <displayID> or 
<screenID>:<displaydI
D>

Displays the TSL protocol tally ID entry. The 
Enable Tally box is selected in the Database 
tab.

Name <name> Assigns a unique identifier for the source in 
the routing system. This name is also used 
when matrices are defined in the Ultricore 
BCS system.

Description Provides additional information or user 
entered notes about the input

Level # Specifies the physical input port associated 
with the source and assigns it to the 
specified level. Unless you have given the 
port a different label via the Port Labels tab, 
the port is labeled as 
Frame.Slot.Port.Type.Channel.
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Cat/Index Categories Tab
The Cat/Index Categories tab enables you to categorize sources, destinations, and levels via a 
hierarchal system of tags. You can use categories to filter sources, destinations or levels into 
manageable groups for a Category soft panel. Refer to “Using Category Panels” for details.

Figure 66  Example of Entries in a Cat/Index Categories Tab

Categories Area

Table 48 summarizes the options displayed in the Categories area of the Cat/Index Categories tab. 

Affected Resources Area

Table 49 summarizes the options displayed in the Affected Resources area of the Cat/Index 
Categories tab. 

Matrix 
Inputs

# Lists all the physical input ports available 
that can be assigned as a source in the 
routing system

Assign Click this button to add the selected physical input port to the Source 
label in the database

Table 48  Cat/Index Categories — Categories Area

Item Parameters Description
Categories: Lists the category tags defined for this database

Add Adds a category tag

Delete Deletes the selected tag

Delete All Deletes all tags listed in the Categories: pane

Generate Automatically generates category tags based on the entires in your 
database

Table 47  Sources Tab

Item Parameters Description
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Indexes Area

Table 50 summarizes the options displayed in the Indexes area of the Cat/Index Categories tab. 

Inaccessible Resources Area

Table 51 summarizes the options displayed in the Inaccessible Resources area of the Cat/Index 
Categories tab. 

Table 49  Cat/Index Categories — Affected Resources Area

Item Parameters Description
Destinations: <text> Lists the destinations that are tagged

Find Performs a search for destinations in the 
database to add to the category

Sources: <text> Lists the sources that are tagged

Find Performs a search for sources in the 
database to add to the category

Levels: <text> Lists the levels that are tagged

Find Performs a search for level in the database 
to add to the category

Table 50  Cat/Index Categories — Indexes Area

Item Parameters Description
Indexes: Creates search terms to define category tags

Add Adds a new entry to the Indexes list

Delete Deletes the selected entry from the Indexes list

Delete All Deletes all entries from the Indexes list

Default Creates indexes 0-9 and A-F

Table 51  Cat/Index Categories — Inaccessible Resources Area

Item Parameters Description
Destinations: <text> Lists the destinations in the current 

database that are not included in any 
Cat/Index categories

Generate Automatically generates category tags 
based on the destinations in your database

Create Enables you to create a new Cat/Index filter 
for Destinations

Sources: <text> Lists the sources in the current database 
that are not included in any Cat/Index 
categories

Generate Automatically generates category tags 
based on the sources in your database

Create Enables you to create a new Cat/Index filter 
for Sources
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Group Categories Tab
The Categories tab enables you to categorize sources, destinations, and levels via a hierarchal 
system of tags. You can use categories to filter sources, destinations or levels into manageable 
groups for a Category soft panel. Refer to “Group Categories Overview” for details.

Figure 67  Example of Entries in a Group Categories Tab

The Group Categories tab is organized into three panels and a bottom toolbar.

Table 52 summarizes the options displayed in the left panel of the Group Categories tab. This panel 
displays all the created groups and sub-groups, and/or resources in a top-down hierarchy. Note 
that the nodes are sorted by type and then by alphabetical order.

Levels: <text> Lists the levels in the current database that 
are not included in any classic categories

Generate Automatically generates category tags 
based on the levels in your database

Create Enables you to create a new Cat/Index filter 
for Sources

Table 52  Group Categories Tab — Left Panel

Item Description
Group Categories: Displays the groups as folders arranged in a tree view

Find Displays the Find dialog that enables you to search for a category or 
resource name

Move Displays the Move dialog that enables you to move a selected group 
and its contents to another group

Rename Renames a selected group; the resource type will be not re-named

Delete Deletes a selected group and all of its contents

Add Adds a new group to the selected group

Table 51  Cat/Index Categories — Inaccessible Resources Area

Item Parameters Description
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Table 53 summarizes the options displayed in the middle panel of the Group Categories tab. This 
panel shows the assigned contents (groups and/or resources) of the currently selected item from 
the tree view (in the left panel). 

 

Table 54 summarizes the options displayed in the right panel of the Group Categories tab. This 
panel displays the available destinations, sources, and levels that can be arranged into group 
categories.

 

Table 55 summarizes the bottom toolbar.

Legacy Categories Tab
The Legacy Categories tab enables you to categorize sources, destinations, and levels via a 
hierarchal system of tags. You can use legacy categories to filter sources, destinations, or levels into 
manageable groups for legacy RCP-QE panels. Refer to the RCP-QE User Guide for details.

Table 56 summarizes the options displayed in the top toolbar. 

 

Table 53  Group Categories Tab — Middle Panel

Item Description
Name Indicates the name of a resource

Type Indicates the type of resource

Delete Deletes the selected resource(s) from the currently selected group

Table 54  Group Categories Tab — Right Panel

Item Description
Destinations Displays the unassigned destinations in alphabetical order

Sources Displays the unassigned sources in alphabetical order

Levels Displays the unassigned levels in alphabetical order

Assign Select the resource(s) and click Assign to assign it to the group selected 
in the left table

Table 55  Group Categories Tab — Bottom Toolbar

Item Description
Auto Generate Click to auto-generate group categories based on the resource names 

from the current database

Cancel Ignores all unsaved changes and reverts the tab back to the last saved 
entries

Apply Applies all change made in the Group Categories tab

Table 56  Legacy Categories Tab — Top Toolbar

Item Description
Destinations Lists the destination category/index assignments

Sources Lists the source category/index assignments

Levels Lists the level category/index assignments
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Table 57 summarizes the options displayed when the Edit button is selected from the bottom 
toolbar.

Salvos Tab
A salvo is a set of pre-defined switch events. The Salvos tab provides a list of the global salvos 
available in the currently selected database. From this tab you can create salvos, rename, and 
delete salvos. 

The workspace in the Salvos tab displays a grid pattern with sources at the top and the destinations 
along the left side. A list of currently available (saved) salvos displays on the far left-side of the tab. 
The toolbar on the far right-side displays a button for each level available in the database with each 
button set in the color specified for the level. The toolbar in the bottom right corner of the interface 
displays three buttons: Advanced, Cancel, and Apply.

Figure 68  Example of a Salvos Tab

Table 58 summarizes the options displayed in the Salvos tab. 

Table 57  Legacy Categories Tab — Bottom Toolbar

Item Description
Copy Copies the selected cells in the tab

Paste Pastes the previously copied items to the current cell selection

Clear Clears the data from the selected cells

Clear All Clears all category/index assignments

Fill Auto fills a range of cells

Auto Generate Auto fills the cells based on spaces in the source/destination names

Table 58  Buttons on the Salvos Interface

Button Description
Salvos: Provides a list of configured salvos for the currently loaded database. 

Double-click an item in the list to update the grid in the Salvos tab.

Edit... Displays the Edit dialog for the soft panel. Refer to “Edit Dialogs”.
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Advanced Menus

Clicking the Advanced button in the Salvos tab displays the options outlined in Table 59. 

Panels Tab
The Panels tab includes a series of sub-tabs that enable you to customize soft panels (control 
panels within the DashBoard environment). You can choose to assign the levels, sources, and 
destinations from an Ultricore BCS database to the soft panel buttons.

The soft panels display as sub-nodes in the Soft Panels tree using the name specified in the Info 
tab. When you save a soft panel to the database, a node for the panel automatically displays under 
the Soft Panels node in the Tree View. The soft panels display in the tree according to their assigned 
Panel ID number (where an ID of 1 is the highest, and ID of 2 is the second highest etc.). 

Select All Click this button to select all the Destinations in the matrix of the Salvos 
tab. This will include all the destinations in the matrix in the salvo 
configuration.
• All the Destination buttons are lit red in the matrix.
• The button now displays the Clear All label. Click the button again to 

remove all the Destinations from the salvo configuration.

Level # A button is assigned to each level available in the currently loaded 
database. The color and label of the button is specified in the Levels 
tab.

Advanced Displays the Advanced options outlined in Table 59.

Cancel Discards any recent changes made in the Salvos tab, and clears the 
matrix. Note that the Destinations are still selected (buttons are lit red) 
if you clicked Select All.

Apply Applies changes made in the Salvos tab and updates the salvo settings.

Table 59  Advanced Menu Items

Button Description
Clear All Presets Clears the workspace in the Salvos tab and resets all settings to the 

default values.

Clear Dest Presets Clears all selections made in the Destinations column of the workspace.

Capture System 
Status

Captures the current routing state of the Ultricore BCS system.

Capture Dest Status Updates the workspace to reflect only the status of the destinations of 
the Ultricore BCS system.

Table 58  Buttons on the Salvos Interface

Button Description
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Figure 69  Example of Entries in a Panels Tab

Panels Menu

The Panels menu displays on the left side of the interface. This menu provides a list of soft panels 
saved in the current database. Selecting a soft panel from the list updates the tab entires in the 
Panels tab with the settings for that soft panel.

Info Tab

Use the options in the Info tab to assign a panel a unique identifier, select the panel style template 
to use, and how the panel will perform tasks such as Take transitions. This is the default tab that the 
interface opens on. Table 60 summarizes the fields and menus displayed in the Info tab. 

Table 60  Info Tab

Item Parameters Description
Panel Style 
(read-only)

<name> Specifies the panel type that was assigned to the 
soft panel when it was created

Panel ID <integer> Specifies the auto-assigned number assigned to 
the soft panel

Panel Name <name> Provides a unique identifier for the soft panel. This 
name also displays as a sub-node in the Soft Panels 
tree

Description # Provides a textual summary of the soft panel or 
additional information about the panel

Protection 
Operation

Lock Displays only the Lock button in the panel interface

Protect Displays only the Protect button in the panel 
interface

Both Displays the Lock and Protect buttons in the panel 
interface
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Levels Tab

Use the options in the Levels tab to specify the number of levels for the panel, and organize them in 
a hierarchy for the panel. Table 61 summarizes the fields and menus displayed in the Levels tab. 

Take 
Operation

Confirm A TAKE button displays on the soft panel. You must 
click this button before the transition occurs

Direct A Take transition occurs automatically when a 
Level, Destination, and Source are selected on the 
soft panel.

Selection 
Operation

Single The Multi Select button does not display on the soft 
panel.

Multi Displays the Multi Select button on the soft panel. 
Use this button to quickly select multiple 
destinations for a crosspoint switch.
This button is only applicable for MultiBus and 
Category panels.

Machine 
Control

Enable Displays a Machine Control button on the panel. 
When selected on the panel, this Machine Control 
button sends a Take request directed to a Ross 
NK-M series data router to automatically make the 
reciprocal port switch. On a video router, the 
connection is all one way from an input port to an 
output port (e.g. such as from IN 1 to OUT 2). 

Disable Does not display a Machine Control button on the 
panel.

Nongroup 
Resourcesa

Hide Resources that are not assigned to a specific group 
are not displayed on the soft panel.

Show All resources are displayed on the soft panel.

a. This menu is only available when the Panel Style is set to Group Category.

Table 61  Levels Tab

Item Parameters Description
Viewable 
Levels

<integer> Specifies the maximum number of levels, as 
selectable buttons, that can display on the 
panel interface

Available <integer> List all the levels in the current database

Assigned <integer> Specifies which levels will be available in the 
soft panel

Table 60  Info Tab

Item Parameters Description
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Destinations Tab

Use the options in the Destinations tab to specify which router outputs will be available in 
Destination bus of the soft panel. Table 62 summarizes the fields and menus displayed in the 
Destinations tab. 

Sources Tab

Use the options in the Sources tab to specify which router inputs will be available in Source bus of 
the soft panel, and their hierarchy. Table 63 summarizes the fields and menus displayed in the 
Sources tab. 

Salvos Tab

Use the options in the Salvos tab to specify the total number of salvos displayed in the soft panel 
and their hierarchy. Table 64 summarizes the fields and menus displayed in the Salvos tab. 

Table 62  Destinations Tab

Item Parameters Description
Viewable 
Destinations

<integer> Specifies the maximum number of 
destinations, as selectable buttons, on the 
panel. This field is not displayed when the 
Panel Style is set to Group Category or 
Cat/Index Category.

Available <integer> Lists all the destinations in the current 
database

Assigned <integer> Specifies which destinations will be 
available in the soft panel

Table 63  Sources Tab

Item Parameters Description
Viewable 
Sources

<integer> Specifies the maximum number of sources, 
as selectable buttons, on the panel. This 
field is not displayed when the Panel Style is 
set to Group Category or Cat/Index 
Category.

Available <integer> Lists all the sources in the current database

Assigned <integer> Specifies which sources will be available in 
the soft panel

Table 64  Salvos Tab

Item Parameters Description
Viewable 
salvos

# Specifies the maximum number of salvos 
that will be listed on the Recall Salvos dialog 
for the panel. This field is not displayed 
when the Panel Style is set to Matrix.

Available # Lists all the salvos in the current database

Assigned # Specifies which salvos will be available in 
the soft panel
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Favorites Tab

 The Favorites tab only displays when the Panel Style is set to Ultritouch PB.

Table 65 summarizes the fields and menus displayed in the Favorites tab. 

Home View Tab

 The Home View tab only displays when the Panel Style is set to Ultritouch PB or Push Button.

Table 66 summarizes the options displayed in the Home View tab. 

Table 65  Favorites Tab

Item Parameters Description
Name <name> Provides a unique identifier for the type of Favorite 

for this soft panel.

Type Crosspoint Creates a Favorites button on the soft panel that 
recalls a specific crosspoints switch

Group Creates a Favorites button on the soft panel that 
loads a specific Group Category in the database

Salvo Creates a Favorites button on the soft panel that 
recalls a specific salvo in the database

Sources Creates a Favorites button on the soft panel that 
selects a specific source in the database

Destinations Creates a Favorites button on the soft panel that 
selects a specific destination in the database

Field 1 Specifies the first item for the Favorite. For 
example, if the type is set to Crosspoint, Field 1 
reports the destination.

Field 2 Specifies the second item for the Favorite. For 
example, if the type is set to Crosspoint, Field 2 
reports the source.

Up Moves the selected row higher in the table

Down Moves the selected row lower in the table

Top Moves the selected row to the top of the table

Bottom Moves the selected row to the bottom of the table

Sort Sorts by window type

Table 66  Home View Tab

Item Parameters Description
Display Icons Enable The Destination and Source buttons on the soft 

panel display icons

Disabled The Destination and Source buttons do not display 
icons; only the labels are displayed on each button.

Orientation Portrait The windows are organized into columns (vertical 
panes) on the soft panel

Landscape windows are organized into rows (horizontal panes) 
on the soft panel

Home Windows
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Buttons

Table 67 summarizes the buttons displayed in all Panel sub-tabs. 

Window (read-only) <text> Specifies the window type

Percent # Specifies the width of the window in a percentage 
of the overall soft panel size

Rows # Specifies the number of button rows in the window

Columns # Specifies the number of button columns in the 
window

Reset Loads the default window layout and widths

Up Moves the selected row higher in the table

Down Moves the selected row lower in the table

Top Moves the selected row to the top of the table

Bottom Moves the selected row to the bottom of the table

Sort Sorts by window type

Table 67  Button on the Panels Interface

Button Description
In the Available area, clicking this button toggles the sorting order between 
alphabetical or database-index (based on the current order listed in the 
Levels, Destinations, or Sources tabs)

Moves the selected items in the Available list to the Assigned list.

 
Moves the selected item(s) from the Assigned list back to the Available list. 
These items will not be available in the soft panel window.

Moves all the available labels to the Assigned list

Removes all the items from the Assigned list back to the Available list. 
These items will not be available in the soft panel window.

Up Moves the selected item in the Assigned list up one position. This changes 
the order of the displayed items on the soft panel.

Down Moves the selected item in the Assigned list down one position. This 
changes the order of the displayed items on the soft panel.

Top Moves the selected item in the Assigned list to the top of the list. This 
changes the order of the displayed items on the soft panel.

Bottom Moves the selected item in the Assigned list to the bottom of the list. This 
changes the order of the displayed items on the soft panel.

In the Assigned area, clicking this button arranges the items into 
alphanumerical order.

Table 66  Home View Tab

Item Parameters Description
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System Monitor Tab
Table 68 summarizes the options displayed in the System Monitor tab. 

In the Assigned area, clicking this button arranges the items in the Assigned list 
according to the order established in the Levels, Destinations, or Sources tabs.

Edit... Displays the Edit dialog for the soft panel

Cancel Discards any recent changes made in the soft panel, and reverts to the 
previously saved settings.

Apply Applies changes made in the soft panel and updates the Ultricore BCS 
database

Table 68  System Monitor Tab

Item Parameters Description
Active Database <text> Indicates the database currently loaded in Ultricore 

BCS

IP #.#.#.# Indicates the IP Address assigned to this Ultricore 
BCS

Ver # Indicates the build version of the Ultricore BCS 
panel

Name <text> Indicates the unique identifier assigned to the 
Ultricore BCS

Uptime #h #m #s Indicates the number of hours, minutes, and 
seconds since the last reboot of the Ultricore BCS 
panel

Redundant Mode active Two Ultricore BCS panels are configured in a 
redundant system where they share the same IP 
address.
Refer to “Setting up a Redundant System”.

inactive The current Ultricore BCS panel is not setup in a 
redundant system

Shared IP # When operating in a redundant system, this field 
indicates the IP address that the primary and 
secondary Ultricore BCS panels are currently using.

Incoming Connections

DashBoard Clients # Indicates the total number of DashBoard clients 
communicating with this Ultricore BCS 

RCP Panels # Indicates the total number of remote control panels 
communicating with this Ultricore BCS

3rd Party Control # Indicates the total number of third-party 
automation control devices communicating with 
this Ultricore BCS

Ross IP-Video # / # Indicates the total number of Ross Video IP 
Connectivity (video) devices communicating with 
this Ultricore BCS

Table 67  Button on the Panels Interface

Button Description
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Destination Follow Tab
Table 69 summarizes the options displayed in the Destination Follow tab. 

Additional Dialogs, Menus, and Toolbars in the Database Interfaces
Each tab displays a toolbar located at the bottom that provides buttons that display additional 
editing dialogs (e.g. insert, cut, paste, search). Also, right-clicking a row in any tab also displays a 
menu of editing dialogs. This section briefly outlines those additional editing dialogs.

Ross IP-Audio # / # Indicates the total number of Ross Video IP 
Connectivity (audio) devices communicating with 
this Ultricore BCS

IP-Video # / # Indicates the total number of third-party IP 
Connectivity (video) devices communicating with 
this Ultricore BCS

IP-Audio # / # Indicates the total number of third-party IP 
Connectivity (audio) devices communicating with 
this Ultricore BCS

Outgoing Connections

<device name> 
#.#.#.#

Displays the unique identifier and the assigned IP address of external 
devices (such as Ultrix routers) that the Ultricore BCS is sending 
information to.
The status indicator reports if the external device is reporting an error 
condition (red) or not (green).

Memory Utilization

# Percentage of system RAM currently in use

Disk Space Utilization

# Percentage of available storage space

System Utilization

# Measure of the communication traffic that the Ultricore BCS is 
managing

Table 69  Destination Follow Tab

Item Parameters Description
Destination # Specifies the Destination you want to configure

Following # Specifies the router output that the specified 
Destination will follow

Table 68  System Monitor Tab

Item Parameters Description
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Bottom Toolbar

The bottom toolbar of each tab in the Database includes buttons for applying changes made to 
settings in the interface, or adding elements to the table in the interface. Table 70 summarizes the 
buttons displayed in the Bottom toolbar. Note that not all buttons display in all tabs. 

Edit Dialogs

Table 71 summarizes the buttons displayed in the Edit dialogs. Note that not all options display in 
all tabs. 

Table 70  Bottom Toolbar Items

Button Description
Edit Displays the Edit dialog for the tab. Refer to Table 71 for details.

Find Displays the Find dialog that enables the entering of criteria for 
searching of the tab contents.

Fill Label Applies a custom label to the selected port

Reset Label Reverts the label content to the previously saved text

Delete Removes the selected port from the list for the matrix

Add Adds the selected port from the list for the matrix

Cancel Discards any recent changes made in the tab, and reverts to the 
previously saved table settings.

Apply Applies changes made in the tab and updates the Ultricore BCS 
database

Table 71  Edit Dialogs Items

Button Description
Add In interfaces with lists on the left toolbar (e.g. Panels, Port Labels, 

Salvos), selecting a list item and then clicking Add creates a copy of the 
selected item. The name to the newly created item includes the name 
from the copied item with the prefix “New”.

Auto Generate Automatically fills the cells in the table with a default value. For 
example, clicking this button in the Destinations tab automatically fills 
all the cells with the text “Dest”.

Clear Removes the data from the selected cell.

Clear All Removes the text or entry in all cells of the interface.

Copy Copies the selected cell data to the clipboard. In some interfaces, such 
as in the Salvo tab, the salvo settings are copied in entirety.

Cut Copies the cell data to the clipboard and then delete it from the table.

Deletea When working in an interface with a table layout, clicking this button 
removes the currently active row from the table.
When working in an interface with lists on the left toolbar, clicking this 
button removes the selected item from the list. You will still need to 
click Apply to completely remove the item from the database.
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Find Dialogs

Table 72 summarizes the buttons displayed in the Find dialogs. 

Fill A range of name cells may be filled with consecutive numerical data. 
For example, VTR1 to VTR4 may be entered quickly by defining a prefix 
(in this case VTR) and a suffix that will numerically increment. 
Selecting Fill from the Insert toolbar, a dialog displays prompting you to 
enter a prefix (alphanumeric) and the start/end numerical values.
This method adds rows to the destination table inserting below the 
active row. 

Fill & Replace Enables you to overwrite a range of cells in the table. Rows beneath the 
currently active row are overwritten with data from the Fill & Replace 
dialog.

Insert Above Inserts a new row above the currently active row in the table. Any 
existing data is moved down the table by one row.

Insert Below Inserts a new row below the currently active row in the table. Any 
existing data is moved up one row.

Insert Series Inserts a sequential range of labels below the currently selected row.

Paste Pastes the copied cell data from the clipboard. In some interfaces, such 
as in the Salvo tab, the copied salvo settings are pasted in entirety.

Paste Below Pastes the copied cell data, from the clipboard, to currently selected 
cell.

Rename When working in an interface with lists on the left toolbar, clicking this 
button enables you to provide a different name/label to the selected 
item.

Reset All IDs Resets the source/destination ID numbers based on their current row 
number.
It is recommended to verify the interfaces that referenced IDs (such as 
Soft Panels, Salvos, etc.)

a. Ensure the ID numbers are correctly sequenced when deleting and inserting entries in the tabs. Refer to 
the Reset All IDs row in this table.

Table 72  Find Dialogs Items

Item Description
Column A pull-down menu that lists the columns available in the current 

interface. Select the column to perform the search within.

Find What: Specifies the characters, or text, to search the table contents.

Direction Begins the search by searching below the currently selected row 
(Down), or above the selected row (Up).

Match whole word 
only

Select the check box to search only for the characters in the Find What: 
field as they are typed in the field. For example, typing “put” will search 
for instances of the word “put” and not “input” or “output”.

Cancel Cancels the search criteria and closes the Find menu.

Find Performs a search through the table contents based on the specified 
criteria.

Table 71  Edit Dialogs Items

Button Description
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Advanced Fill Tool
The Advanced Fill tool is provided to create new destination and source labels that are 
automatically assigned to physical outputs and inputs depending on options set by the user. The 
audio routing features provided by the routers in your system can result in an extensive source and 
destination definition map requiring some time to manually enter. The Advanced Fill tool will 
speed the assignment of physical sockets greatly.

For More Information on...
• using the tool to set up your database, refer to “Using the Advanced Fill Tool”.

Breakaway Fill Dialog

The Breakaway Fill dialog is the Advanced Fill tool for the Sources tab. This dialog is displayed 
when you click Edit > Fill.

Figure 70  Example of a Breakaway Fill Dialog

Table 73 summarizes the options displayed in the Breakaway Fill dialog. 
Table 73  Breakaway Fill Dialog

Item Parameters Description
Fill Custom Insert labels with assignments for a custom range 

defined by the Range setting

Entire Slot Insert labels with assignments for a single router 
slot (including the AUX ports on the Ultrix router)

Entire Device Insert labels with assignments for the entire router 
(including the AUX ports on the Ultrix router)

Name <text> The prefix for the label creation. For example, 
typing VTR results in labels VTR1, VTR2, etc. 
Take care when determining label names. While a 
long name may be nice and descriptive for the 
Source tab, many control devices have limited 
screen space and labels may be truncated.

Starting # The starting numerical extension for the label 
creation. For example, typing 3 results in labels 
Name3, Name4, etc. 

Range # The quantity of labels for custom fill range

Slot # The Ultrix slot number to start the label assignment 
froma

Port # The Ultrix port to start the label assignment froma
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Destinations Fill Dialog

The Destinations Fill dialog is the Advanced Fill tool for the Destinations tab. This dialog is 
displayed when you click Edit > Fill.

Starting 
Channel

# The Ultrix channel to start the label assignment 
froma

Level # This column lists the levels defined as per user 
entries in the system Levels setup table

I/O 
Assignment

# This column lists the starting assignment for the 
given Level row

Fixed Select the box to fix the I/O assignment selection 
even though it may be out of natural order 
compared to other I/O assignments.
For example, 
Ultricore BCS.slot1.in[1].audio.ch1  
Ultricore BCS.slot2.in[1].audio.ch1.

BRK I/O Select the box to insert a label with this I/O 
assignment on all BRK Level selections.
For example, IN 1 ch1  | slot1.in[1].audio.ch1 | 
slot1.in[1].audio.ch1 | slot1.in[1].audio.ch1.

BRK Level Select the box to include this level when creating a 
breakaway label. For example, IN 1 ch1.

BRK Suffix <text> By default, breakaway label naming uses the chx 
part of the Ultricore BCS name. A user defined 
suffix may be entered here.

Assign Click this button to automatically fill the I/O Assignment column 
based on the Slot, Port, Starting Channel settings to the selected 
row(s).

Apply Click this button to insert labels with assignments based on dialog 
settings into the source assignment table below the current 
selected row.

Cancel Click this button to cancel the settings and close the dialog. No 
changes to the Source table will be made.

a. The Breakaway Fill dialog uses the default naming convention of FrameName.slot 
n.in/out[p].type.chx.

Table 73  Breakaway Fill Dialog

Item Parameters Description
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Figure 71  Example of a Destinations Fill Dialog

Table 74 summarizes the options displayed in the Destinations Fill dialog. 
Table 74  Destinations Fill Dialog

Item Parameters Description
Fill Custom Insert labels with assignments for a custom range 

defined by the Range setting

Entire Slot Insert labels with assignments for a single router 
slot

Entire Device Insert labels with assignments for the entire 
router/device

Name <text> The prefix for the label creation. For example, 
typing VTR results in labels VTR 1, VTR 2, etc. 
Take care when determining label names. While a 
long name may be nice and descriptive for the 
Destination tab, many control devices have limited 
screen space and labels may be truncated.

Starting # The starting numerical extension for the label 
creation. For example, typing 3 results in labels 
Name3, Name4, etc. 

Range # Specifies the quantity of labels for custom fill range

Slot # The Ultricore BCS slot number to start the label 
assignment froma

Port # The Ultricore BCS port to start the label assignment 
froma

Starting 
Channel

# The Ultricore BCS channel to start the label 
assignment froma

Level # This column defines the levels as per user entries in 
the system levels setup table

I/O 
Assignment

# Starting assignment for the given level row

Assign Click this button to automatically fill the I/O Assignment column 
based on the Slot, Port, and Starting Channel settings to the 
selected row/s
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Devices Interface
The Devices node summarizes the hardware components of the routing system. The nodes 
represent a hierarchy of the routing system communicating with the Ultricore BCS.

For More Information on...
• how Ultricore BCS communicates with Ross devices, refer to “Operation with Ross Devices”.
• general control of external devices via third-party protocols, refer to “External Control”.

Controllers and Matrices
The Controllers and Matrices node allows access to hardware settings and device options 
including any licensing configuration. Double-clicking the node for a device opens the interface for 
that particular device.

Figure 72  Example of an Expanded Controllers and Matrices Node

Soft Panels Interfaces
The Soft Panels interface represents the routing system crosspoint control in the virtual space of 
the Ultricore BCS. Each available soft panel in the database displays as a sub-node under the Soft 
Panels main node in a tree layout. The soft panels display in a hierarchy based on their Panel ID. 
Double-click a soft panel node to display its interface in the DashBoard window. There are three 
types of soft panels: Matrix, MultiBus, and Category.

Apply Click this button to insert labels with assignments based on dialog 
settings into the source assignment table below the current 
selected row.

Cancel Click this button to cancel the settings and close the dialog. No 
changes to the Destination table will be made.

a. The Fill Destination dialog uses the default naming convention of FrameName.slot 
n.in/out[p].type.chx.

Table 74  Destinations Fill Dialog

Item Parameters Description
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 You must configure your connections, sources, destinations, and levels, before you can create a 
soft panel and perform crosspoint switches.

For More Information on...
• creating a database for your routing system, refer to “Creating a New Database”.
• the interface for creating soft panels, refer to “Soft Panels Interfaces”.
• using soft panels, refer to “Soft Panels in DashBoard”.
• creating and using salvos, refer to “Using Salvos”.

Matrix Panel
The Matrix Panel provides a visual representation of multi-level crosspoints, in a grid layout, and 
offers a convenient and easy way to select and switch crosspoints. The columns of the grid 
represent the configured Sources and are labeled with the labels specified in the Input Name cells 
of the Sources tab. The rows of the grid represent the configured Destinations and display the 
labels specified in the Destination tab.

Figure 73  Example of a Matrix Panel

Right-side Toolbar

Table 75 summarizes the buttons displayed in the toolbar on the right-side of the interface. 
Table 75  Matrix Panel Toolbar Items

Button Description
Level # Each configured level in the currently active database is represented 

with a button. When selected, the button is lit with the color assigned to 
the level. Crosspoint selections on the matrix are also lit this color when 
the level is included in the next switch.

Follow Automatically selects all the Level buttons listed on the Matrix panel 
(buttons are now lit). All levels are now included in next crosspoint 
selection.

TAKE Performs a Take transition to the next crosspoint selection.

Lock Locks the Matrix panel from all switches or function button operation.

Protect Protects the currently selected source/destination level pair from use 
by other sources, as well as from other linked panels.
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Salvo Menus

Table 76 summarizes the options displayed in the Salvo menu. 

Advanced Menus

Table 77 summarizes the options displayed in the Advanced menu. 

Free Removes the Lock and Protect from the next crosspoint switch.

Salvo Displays the options for managing the salvos for your soft panel. Refer 
to “Salvo Menus” for details.

Advanced Displays the options for managing crosspoint switches on your soft 
panel. Refer to “Advanced Menus” for details.

Table 76  Matrix Panel — Salvo Menus

Button Description
Recall Recalls and applies the last saved salvo settings.

Edit Enables you to load a salvo, update its settings, and then save your 
changes.

Save Saves the current crosspoint selection as a local salvo.

Capture Current 
Status

Automatically creates a salvo based on the currently selected 
destination and source positions.

Capture Dest Status Automatically creates a salvo based on the currently selected 
destination positions.

Table 77  Matrix Panel — Advanced Menus

Button Description
Clear All Presets Removes all selections currently made on the soft panel and returns 

the panel to its default destination and source selections.

Clear Dest Presets Removes only the selections made on the Destinations bus. No 
destination buttons are selected.

Diagonal Presets The destination and source crosspoint selections are automatically 
made starting at the top left corner and progressively moving down the 
grid in a 1:1 pattern. For example, Src1 and Dest1, Src2 and Dest2, Src3 
and Dest3 etc.

R-Diagonal Presets The destination and source crosspoint selections are automatically 
made starting at the top right corner and progressively moving down 
the grid in a 1:1 pattern. For example, Src10 and Dest1, Src9 and Dest2, 
Src8 and Dest3 etc.

Setup Automation Automatically loops the crosspoint switches for the specified length of 
time.

Stop Automation Stops the automatic loop of crosspoint switches that was initiated using 
the Setup Automation option.

Table 75  Matrix Panel Toolbar Items

Button Description
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MultiBus Panel
The MultiBus Panel provides breakaway control and status monitoring of several destinations 
simultaneously. The MultiBus Panel interface is organized into two buses with a central status row 
of indicators for the levels. The toolbar on the far left of the interface provides options for locking 
and protecting crosspoints, setting up the transition, and selecting the levels. The bottom row of the 
interface is populated with buttons for the salvos defined in the database.

Figure 74  Example of a MultiBus Panel

Left Toolbar

Table 78 summarizes the fields and information displayed in the left toolbar of the MultiBus 
Panel. 

Table 78  MultiBus Panel — Left Toolbar Items

Button Description
Lock Locks the MultiBus panel from all switches or function button 

operation.

Take Performs a Take transition to the next crosspoint selection.

Preset Enables you to configure a crosspoint switch that will not take effect 
until the Take button is selected.

Clear Clears the selections in the crosspoint buses. No buttons are lit and the 
fields in the Destination buses are blank.

Multi Select Enables you to assign a single source to multiple destinations for a 
multi-switch configuration.

Level # Each configured level in the currently active database is represented 
with a button. When selected, the button is lit with the color assigned to 
the level. Crosspoint selections on the matrix are also lit this color when 
the level is included in the next switch.

Follow Automatically selects all the Level buttons listed on the Matrix panel 
(buttons are now lit). All levels are now included in next crosspoint 
selection.
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Destinations Bus

Each Destination is represented as a distinct box on the top bus of the MultiBus Panel. Figure 75 
provides an example of a Destination bus. The Destination bus only displays the destinations 
specified when the soft panel was configured.

Figure 75  Example of a Destination Bus on the MultiBus Panel

Table 79 summarizes the buttons displayed for each Destination in the MultiBus Panel. 

Sources Bus

Each Source is represented as a distinct button on the bottom bus of the MultiBus Panel. Figure 
76 provides an example of a Source bus. The Source bus only displays the sources, and in the 
hierarchy, specified when the soft panel was configured.

Figure 76  Example of a Source Bus on the MultiBus Panel

Category Panel
There are two types of Category Panels: Classic and Group. Each Category Panel organizes the 
sources and destinations according to the definitions set in the applicable Category interface for the 
database. The top toolbar is used in conjunction with the central button matrix for selecting sources 

Table 79  MultiBus Panel — Destination Items

Button Description
Name The Destination name/label is reported at the top of each area and 

displays as a selectable button. This enables for quick identification on 
the bus when selecting crosspoint switches.
The Destinations available on the bus is dependent on the database 
currently loaded on the router and how many destinations were 
specified when the soft panel was configured.

Level # This field reports the level(s) that the destination was associated with 
on the last crosspoint switch.

Source # This field reports the source(s) currently selected on the Source bus 
located near the bottom of the MultiBus Panel interface.

Lock Locks the Destination from all switches or function button operation.

Protect Protects the currently selected Destination from use by other sources, 
as well as from other linked panels.
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and destinations. The left side of the interface provides access to level selection, and reports on the 
breakaway status with fields for each level. Some functions are category type specific. Refer to 
“Using Category Panels” for details.

Figure 77  Example of a Category Soft Panel for an Ultricore BCS

Ultritouch PB Panels
You can control an Ultrix router via Ultritouch by loading a saved soft panel using the Ultritouch 
hard panel interface. Loading a soft panel to Ultritouch requires a similar method as loading a soft 
panel in the Ultrix and/or Ultricore menu system. You select the device in the Ultritouch > All 
Connections interface, navigate to the specific soft panel you wish to load, and select it from the 
provided list. 

Figure 78  Example of an Ultritouch Soft Panel

For More Information on...
• the creating and using Ultritouch soft panels, refer to the Ultritouch + Ultricore BCS User Guide.

Push Button Panels
The Push Button Panel interface is organized into four distinct areas. The top area displays the 
Destinations, the middle row includes the Source buttons, and each area includes an independent 
method for filtering the buttons. A toolbar displays on the right to provide access to the level 
buttons, and includes a status field. The bottom toolbar provides options for locking and protecting 
crosspoints, setting up the transition, selecting salvos, and other functions. 
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Figure 79  Example of a (Landscape) Push Button Soft Panel

For More Information on...
• the creating and using Push Button soft panels, refer to “Using Push Button Panels”.

Using Walkabout in DashBoard
Walkabout is a Ross router utility operating within DashBoard, as of DashBoard version 6.2, that 
enables you to configure the network settings for NK devices. Once a valid connection is established 
with Walkabout, the device is listed in the Tree View of DashBoard and available for monitoring and 
configuration via DashBoard. 

Ultricore BCS supports a basic configuration mode via the Walkabout system for initial 
configuration of IP settings:

• specify device IP settings and names
• specify a name for your routing system
• specify the system role (e.g. primary, backup, device)
• select a system to join from a list of valid system names assigned to controllers
• set communications server from a list of valid communication server devices (or IP)

For More Information on...
• the features of Walkabout, refer to the Ross Video document Configuring Devices Using 

Walkabout.
• using Walkabout and Ultricore BCS, refer to “Using Walkabout to Assign an IP Address to the 

Ultricore BCS Panel”.
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Panel Menu System Overview
There are two methods for monitoring: via a DashBoard client computer or using the Ultricore BCS 
hard panel. This chapter outlines the status field displayed on the hard panel.

Ultricore BCS System Monitoring Window
The System Monitoring window of the Ultricore BCS hard panel is organized into groups of 
read-only fields. Use this window to verify the network settings for the panel, monitor 
communications with devices in your routing system, and troubleshoot system status.

 This window reflects the same information as reported on the System Monitor tab in DashBoard. 
To access this interface on a DashBoard client computer, double-click the Ultricore BCS Device 
sub-node in the Tree View and select Database > System Monitor.

Figure 80  Example of the Ultricore BCS Panel System Monitoring Window

Table 80 summarizes the options displayed in the System Monitoring window. 
Table 80  System Monitoring Window

Item Parameters Description
Active Database <text> Indicates the database currently loaded in Ultricore 

BCS

IP #.#.#.# Indicates the IP Address assigned to this Ultricore 
BCS

Ver # Indicates the build version of the Ultricore BCS 
panel

Name <text> Indicates the unique identifier assigned to the 
Ultricore BCS

Uptime #h #m #s Indicates the number of hours, minutes, and 
seconds since the last reboot of the Ultricore BCS 
panel

Redundant Mode active Two Ultricore BCS panels are configured in a 
redundant system where they share the same IP 
address.
Refer to “Setting up a Redundant System” for 
details.

inactive The current Ultricore BCS panel is not setup in a 
redundant system

Memory Utilization Disk Space UltilizationDB Clients 8
RCP Panels 3
3RD Party Control 1
Ross IP-Video 3/4
Ross IP-Audio 1/2
IP-Video 1/1
IP-Audio 1/1

188_5RU        13.62.18...
145_5RU        13.62.14...
209_5RU        13.62.20...

System Utilization

IP: 12.32.123.235

Version: x.x.x

Name: UltricoreBCS-2AE75D

Uptime: 22h 38m 19s 

Redudant Mode: active

Shared IP: 12.32.123.237

default
Active Database

25% 15% 5%
Outgoing Connections

Incoming Connections
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Shared IP # When operating in a redundant system, this field 
indicates the IP address that the primary and 
secondary Ultricore BCS panels are currently using.

Incoming Connections

DashBoard Clients # Indicates the total number of DashBoard clients 
communicating with this Ultricore BCS 

RCP Panels # Indicates the total number of remote control panels 
communicating with this Ultricore BCS

3rd Party Control # Indicates the total number of third-party 
automation control devices communicating with 
this Ultricore BCS

Ross IP-Video # / # Indicates the total number of Ross Video IP 
Connectivity (video) devices communicating with 
this Ultricore BCS

Ross IP-Audio # / # Indicates the total number of Ross Video IP 
Connectivity (audio) devices communicating with 
this Ultricore BCS

IP-Video # / # Indicates the total number of third-party IP 
Connectivity (video) devices communicating with 
this Ultricore BCS

IP-Audio # / # Indicates the total number of third-party IP 
Connectivity (audio) devices communicating with 
this Ultricore BCS

Outgoing Connections

<device name> 
#.#.#.#

Displays the unique identifier and the assigned IP address of external 
devices (such as Ultrix routers) that the Ultricore BCS is sending 
information to.
The status indicator reports if the external device is reporting an error 
condition (red) or not (green).

Memory Utilization

# Percentage of system RAM currently in use

Disk Space Utilization

# Percentage of available storage space

System Utilization

# Measure of the communication traffic that the Ultricore BCS is 
managing

Table 80  System Monitoring Window

Item Parameters Description



Ultricore BCS User Guide (v9.0) Technical Specifications • 251

Technical Specifications
This chapter provides technical information for Ultricore BCS.

 Specifications are subject to change without notice.

Physical Dimensions

Ethernet Port Connectors
Each Ultricore BCS comes standard with two ENET ports on the rear panel to interface with a local 
network, and Ross devices that use an Ethernet protocol for communications.

 The ENET 2 port is not implemented.

USB Port

Supported USB-Serial Converters
The following USB-Serial chip-sets are supported:

• FTDI
• Silicon Labs CP210x
• Prolific PL2303
• Belkin

Table 81  Technical Specifications — Physical Dimensions

Item Specification
Width 19” (48cm)

Depth 2.5” (6cm)

Height 3.5” (9cm)

Weight (approx.) 5.25lb (2.40kg)

Table 82  Technical Specifications — Ethernet Ports

Item Specifications
Number of Ports 2

Connector Type 8-pin, RJ45 1GbE network interface

Table 83  Technical Specifications — USB Ports

Item Specifications
Number of Ports 1

Connector Type USB2.0 socket
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Environmental

Power

Table 84  Technical Specifications — Environmental

Item Specifications
Maximum Ambient Temperature 
Range

0°C to 40°C (32°F to 104°F)

Humidity, non-condensing < 95%

Table 85  Technical Specifications — Power Supply Ratings

Item Specifications
Number of Ports 2

Power 15VDC @ 4A

Input 100-240Vac, 50/60Hz

Input Current 1.4A
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Software Licenses
This chapter provides third-party software license information for your Ultricore BCS. This product 
includes multiple software components which are individually licensed under one or more of the 
following licenses included in this chapter.

BSD
Copyright (c) 1991,1993, The Regents of the University of California. All rights reserved.

This code is derived from software contributed to Berkeley by Kenneth Almquist.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other 
materials provided with the distribution.

3. <BSD Advertising Clause omitted per the July 22, 1999 licensing change ftp://ftp.cs.berkeley.edu/pub/4bsd/README.Impt.License.Change> California, Berke-
ley and its contributors.

4. Neither the name of the University nor the names of its contributors may be used to endorse or promote products derived from this software without specific prior 
written permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN 
NO EVENT SHALL THE REGENTS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CON-
SEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABIL-
ITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGE.

Dual GPL
Portions of this software are copyright (C) 1996-2002 The FreeType Project (www.freetype.org). All rights reserved.

This project is also covered under the GPL v2.

GPL
GNU GENERAL PUBLIC LICENSE

Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Preamble

The GNU General Public License is a free, copyleft license for software and other kinds of works.

The licenses for most software and other practical works are designed to take away your freedom to share and change the works. By contrast, the GNU General Pub-
lic License is intended to guarantee your freedom to share and change all versions of a program--to make sure it remains free software for all its users. We, the Free 
Software Foundation, use the GNU General Public License for most of our software; it applies also to any other work released this way by its authors. You can apply 
it to your programs, too.

When we speak of free software, we are referring to freedom, not price. Our General Public Licenses are designed to make sure that you have the freedom to distrib-
ute copies of free software (and charge for them if you wish), that you receive source code or can get it if you want it, that you can change the software or use pieces 
of it in new free programs, and that you know you can do these things.

To protect your rights, we need to prevent others from denying you these rights or asking you to surrender the rights. Therefore, you have certain responsibilities if 
you distribute copies of the software, or if you modify it: responsibilities to respect the freedom of others.

For example, if you distribute copies of such a program, whether gratis or for a fee, you must pass on to the recipients the same freedoms that you received. You must 
make sure that they, too, receive or can get the source code. And you must show them these terms so they know their rights.

Developers that use the GNU GPL protect your rights with two steps: (1) assert copyright on the software, and (2) offer you this License giving you legal permission 
to copy, distribute and/or modify it.

For the developers' and authors' protection, the GPL clearly explains that there is no warranty for this free software. For both users' and authors' sake, the GPL 
requires that modified versions be marked as changed, so that their problems will not be attributed erroneously to authors of previous versions.

Some devices are designed to deny users access to install or run modified versions of the software inside them, although the manufacturer can do so. This is funda-
mentally incompatible with the aim of protecting users' freedom to change the software. The systematic pattern of such abuse occurs in the area of products for indi-
viduals to use, which is precisely where it is most unacceptable. Therefore, we have designed this version of the GPL to prohibit the practice for those products. If 
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such problems arise substantially in other domains, we stand ready to extend this provision to those domains in future versions of the GPL, as needed to protect the 
freedom of users. 

Finally, every program is threatened constantly by software patents. States should not allow patents to restrict development and use of software on general-purpose 
computers, but in those that do, we wish to avoid the special danger that patents applied to a free program could make it effectively proprietary. To prevent this, the 
GPL assures that patents cannot be used to render the program non-free.

The precise terms and conditions for copying, distribution and modification follow.

TERMS AND CONDITIONS

0. Definitions.

"This License" refers to version 3 of the GNU General Public License.

"Copyright" also means copyright-like laws that apply to other kinds of works, such as semiconductor masks.

"The Program" refers to any copyrightable work licensed under this License. Each licensee is addressed as "you". "Licensees" and "recipients" may be individuals or 
organizations.

To "modify" a work means to copy from or adapt all or part of the work in a fashion requiring copyright permission, other than the making of an exact copy. The 
resulting work is called a "modified version" of the earlier work or a work "based on" the earlier work.

A "covered work" means either the unmodified Program or a work based on the Program.

To "propagate" a work means to do anything with it that, without permission, would make you directly or secondarily liable for infringement under applicable copy-
right law, except executing it on a computer or modifying a private copy. Propagation includes copying, distribution (with or without modification), making available 
to the public, and in some countries other activities as well.

To "convey" a work means any kind of propagation that enables other parties to make or receive copies. Mere interaction with a user through a computer network, 
with no transfer of a copy, is not conveying.

An interactive user interface displays "Appropriate Legal Notices" to the extent that it includes a convenient and prominently visible feature that (1) displays an 
appropriate copyright notice, and (2) tells the user that there is no warranty for the work (except to the extent that warranties are provided), that licensees may convey 
the work under this License, and how to view a copy of this License. If the interface presents a list of user commands or options, such as a menu, a prominent item in 
the list meets this criterion.

1. Source Code.

The "source code" for a work means the preferred form of the work for making modifications to it. "Object code" means any non-source form of a work.

A "Standard Interface" means an interface that either is an official standard defined by a recognized standards body, or, in the case of interfaces specified for a partic-
ular programming language, one that is widely used among developers working in that language.

The "System Libraries" of an executable work include anything, other than the work as a whole, that (a) is included in the normal form of packaging a Major Compo-
nent, but which is not part of that Major Component, and (b) serves only to enable use of the work with that Major Component, or to implement a Standard Interface 
for which an implementation is available to the public in source code form. A "Major Component", in this context, means a major essential component (kernel, win-
dow system, and so on) of the specific operating system (if any) on which the executable work runs, or a compiler used to produce the work, or an object code inter-
preter used to run it.

The "Corresponding Source" for a work in object code form means all the source code needed to generate, install, and (for an executable work) run the object code 
and to modify the work, including scripts to control those activities. However, it does not include the work's System Libraries, or general-purpose tools or generally 
available free programs which are used unmodified in performing those activities but which are not part of the work. For example, Corresponding Source includes 
interface definition files associated with source files for the work, and the source code for shared libraries and dynamically linked subprograms that the work is spe-
cifically designed to require, such as by intimate data communication or control flow between those subprograms and other parts of the work.

The Corresponding Source need not include anything that users can regenerate automatically from other parts of the Corresponding Source.

The Corresponding Source for a work in source code form is that same work.

2. Basic Permissions.

All rights granted under this License are granted for the term of copyright on the Program, and are irrevocable provided the stated conditions are met. This License 
explicitly affirms your unlimited permission to run the unmodified Program. The output from running a covered work is covered by this License only if the output, 
given its content, constitutes a covered work. This License acknowledges your rights of fair use or other equivalent, as provided by copyright law.

You may make, run and propagate covered works that you do not convey, without conditions so long as your license otherwise remains in force. You may convey 
covered works to others for the sole purpose of having them make modifications exclusively for you, or provide you with facilities for running those works, provided 
that you comply with the terms of this License in conveying all material for which you do not control copyright. Those thus making or running the covered works for 
you must do so exclusively on your behalf, under your direction and control, on terms that prohibit them from making any copies of your copyrighted material out-
side their relationship with you.

Conveying under any other circumstances is permitted solely under the conditions stated below. Sublicensing is not allowed; section 10 makes it unnecessary.

3. Protecting Users' Legal Rights From Anti-Circumvention Law.

No covered work shall be deemed part of an effective technological measure under any applicable law fulfilling obligations under article 11 of the WIPO copyright 
treaty adopted on 20 December 1996, or similar laws prohibiting or restricting circumvention of such measures.

When you convey a covered work, you waive any legal power to forbid circumvention of technological measures to the extent such circumvention is effected by 
exercising rights under this License with respect to the covered work, and you disclaim any intention to limit operation or modification of the work as a means of 
enforcing, against the work's users, your or third parties' legal rights to forbid circumvention of technological measures.

4. Conveying Verbatim Copies.
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You may convey verbatim copies of the Program's source code as you receive it, in any medium, provided that you conspicuously and appropriately publish on each 
copy an appropriate copyright notice; keep intact all notices stating that this License and any non-permissive terms added in accord with section 7 apply to the code; 
keep intact all notices of the absence of any warranty; and give all recipients a copy of this License along with the Program.

You may charge any price or no price for each copy that you convey, and you may offer support or warranty protection for a fee.

5. Conveying Modified Source Versions.

You may convey a work based on the Program, or the modifications to produce it from the Program, in the form of source code under the terms of section 4, provided 
that you also meet all of these conditions:

a. The work must carry prominent notices stating that you modified it, and giving a relevant date.
b. The work must carry prominent notices stating that it is released under this License and any conditions added under section 7. This requirement modifies 

the requirement in section 4 to "keep intact all notices".
c. You must license the entire work, as a whole, under this License to anyone who comes into possession of a copy. This License will therefore apply, along 

with any applicable section 7 additional terms, to the whole of the work, and all its parts, regardless of how they are packaged. This License gives no 
permission to license the work in any other way, but it does not invalidate such permission if you have separately received it.

d. If the work has interactive user interfaces, each must display Appropriate Legal Notices; however, if the Program has interactive interfaces that do not 
display Appropriate Legal Notices, your work need not make them do so.

A compilation of a covered work with other separate and independent works, which are not by their nature extensions of the covered work, and which are not com-
bined with it such as to form a larger program, in or on a volume of a storage or distribution medium, is called an "aggregate" if the compilation and its resulting 
copyright are not used to limit the access or legal rights of the compilation's users beyond what the individual works permit. Inclusion of a covered work in an aggre-
gate does not cause this License to apply to the other parts of the aggregate.

6. Conveying Non-Source Forms.

You may convey a covered work in object code form under the terms of sections 4 and 5, provided that you also convey the machine-readable Corresponding Source 
under the terms of this License, in one of these ways:

a. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by the Corresponding Source 
fixed on a durable physical medium customarily used for software interchange.

b. Convey the object code in, or embodied in, a physical product (including a physical distribution medium), accompanied by a written offer, valid for at 
least three years and valid for as long as you offer spare parts or customer support for that product model, to give anyone who possesses the object code 
either (1) a copy of the Corresponding Source for all the software in the product that is covered by this License, on a durable physical medium customarily 
used for software interchange, for a price no more than your reasonable cost of physically performing this conveying of source, or (2) access to copy the 
Corresponding Source from a network server at no charge.

c. c) Convey individual copies of the object code with a copy of the written offer to provide the Corresponding Source. This alternative is allowed only 
occasionally and noncommercially, and only if you received the object code with such an offer, in accord with subsection 6b.

d. d) Convey the object code by offering access from a designated place (gratis or for a charge), and offer equivalent access to the Corresponding Source in 
the same way through the same place at no further charge. You need not require recipients to copy the Corresponding Source along with the object code. 
If the place to copy the object code is a network server, the Corresponding Source may be on a different server (operated by you or a third party) that 
supports equivalent copying facilities, provided you maintain clear directions next to the object code saying where to find the Corresponding Source. 
Regardless of what server hosts the Corresponding Source, you remain obligated to ensure that it is available for as long as needed to satisfy these 
requirements.

e. e) Convey the object code using peer-to-peer transmission, provided you inform other peers where the object code and Corresponding Source of the work 
are being offered to the general public at no charge under subsection 6d.

A separable portion of the object code, whose source code is excluded from the Corresponding Source as a System Library, need not be included in conveying the 
object code work.

A "User Product" is either (1) a "consumer product", which means any tangible personal property which is normally used for personal, family, or household purposes, 
or (2) anything designed or sold for incorporation into a dwelling. In determining whether a product is a consumer product, doubtful cases shall be resolved in favor 
of coverage. For a particular product received by a particular user, "normally used" refers to a typical or common use of that class of product, regardless of the status 
of the particular user or of the way in which the particular user actually uses, or expects or is expected to use, the product. A product is a consumer product regardless 
of whether the product has substantial commercial, industrial or non-consumer uses, unless such uses represent the only significant mode of use of the product.

"Installation Information" for a User Product means any methods, procedures, authorization keys, or other information required to install and execute modified ver-
sions of a covered work in that User Product from a modified version of its Corresponding Source. The information must suffice to ensure that the continued func-
tioning of the modified object code is in no case prevented or interfered with solely because modification has been made.

If you convey an object code work under this section in, or with, or specifically for use in, a User Product, and the conveying occurs as part of a transaction in which 
the right of possession and use of the User Product is transferred to the recipient in perpetuity or for a fixed term (regardless of how the transaction is characterized), 
the Corresponding Source conveyed under this section must be accompanied by the Installation Information. But this requirement does not apply if neither you nor 
any third party retains the ability to install modified object code on the User Product (for example, the work has been installed in ROM).

The requirement to provide Installation Information does not include a requirement to continue to provide support service, warranty, or updates for a work that has 
been modified or installed by the recipient, or for the User Product in which it has been modified or installed. Access to a network may be denied when the modifica-
tion itself materially and adversely affects the operation of the network or violates the rules and protocols for communication across the network.

Corresponding Source conveyed, and Installation Information provided, in accord with this section must be in a format that is publicly documented (and with an 
implementation available to the public in source code form), and must require no special password or key for unpacking, reading or copying.

7. Additional Terms.

"Additional permissions" are terms that supplement the terms of this License by making exceptions from one or more of its conditions. Additional permissions that 
are applicable to the entire Program shall be treated as though they were included in this License, to the extent that they are valid under applicable law. If additional 
permissions apply only to part of the Program, that part may be used separately under those permissions, but the entire Program remains governed by this License 
without regard to the additional permissions.

When you convey a copy of a covered work, you may at your option remove any additional permissions from that copy, or from any part of it. (Additional permis-
sions may be written to require their own removal in certain cases when you modify the work.) You may place additional permissions on material, added by you to a 
covered work, for which you have or can give appropriate copyright permission.
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Notwithstanding any other provision of this License, for material you add to a covered work, you may (if authorized by the copyright holders of that material) supple-
ment the terms of this License with terms:

a. Disclaiming warranty or limiting liability differently from the terms of sections 15 and 16 of this License; or
b. Requiring preservation of specified reasonable legal notices or author attributions in that material or in the Appropriate Legal Notices displayed by works 

containing it; or
c. Prohibiting misrepresentation of the origin of that material, or requiring that modified versions of such material be marked in reasonable ways as different 

from the original version; or
d. Limiting the use for publicity purposes of names of licensors or authors of the material; or
e. Declining to grant rights under trademark law for use of some trade names, trademarks, or service marks; or
f. Requiring indemnification of licensors and authors of that material by anyone who conveys the material (or modified versions of it) with contractual 

assumptions of liability to the recipient, for any liability that these contractual assumptions directly impose on those licensors and authors.

All other non-permissive additional terms are considered "further restrictions" within the meaning of section 10. If the Program as you received it, or any part of it, 
contains a notice stating that it is governed by this License along with a term that is a further restriction, you may remove that term. If a license document contains a 
further restriction but permits relicensing or conveying under this License, you may add to a covered work material governed by the terms of that license document, 
provided that the further restriction does not survive such relicensing or conveying.

If you add terms to a covered work in accord with this section, you must place, in the relevant source files, a statement of the additional terms that apply to those files, 
or a notice indicating where to find the applicable terms.

Additional terms, permissive or non-permissive, may be stated in the form of a separately written license, or stated as exceptions; the above requirements apply either 
way.

8. Termination.

You may not propagate or modify a covered work except as expressly provided under this License. Any attempt otherwise to propagate or modify it is void, and will 
automatically terminate your rights under this License (including any patent licenses granted under the third paragraph of section 11).

However, if you cease all violation of this License, then your license from a particular copyright holder is reinstated (a) provisionally, unless and until the copyright 
holder explicitly and finally terminates your license, and (b) permanently, if the copyright holder fails to notify you of the violation by some reasonable means prior 
to 60 days after the cessation.

Moreover, your license from a particular copyright holder is reinstated permanently if the copyright holder notifies you of the violation by some reasonable means, 
this is the first time you have received notice of violation of this License (for any work) from that copyright holder, and you cure the violation prior to 30 days after 
your receipt of the notice.

Termination of your rights under this section does not terminate the licenses of parties who have received copies or rights from you under this License. If your rights 
have been terminated and not permanently reinstated, you do not qualify to receive new licenses for the same material under section 10.

9. Acceptance Not Required for Having Copies.

You are not required to accept this License in order to receive or run a copy of the Program. Ancillary propagation of a covered work occurring solely as a conse-
quence of using peer-to-peer transmission to receive a copy likewise does not require acceptance. However, nothing other than this License grants you permission to 
propagate or modify any covered work. These actions infringe copyright if you do not accept this License. Therefore, by modifying or propagating a covered work, 
you indicate your acceptance of this License to do so.

10. Automatic Licensing of Downstream Recipients.

Each time you convey a covered work, the recipient automatically receives a license from the original licensors, to run, modify and propagate that work, subject to 
this License. You are not responsible for enforcing compliance by third parties with this License.

An "entity transaction" is a transaction transferring control of an organization, or substantially all assets of one, or subdividing an organization, or merging organiza-
tions. If propagation of a covered work results from an entity transaction, each party to that transaction who receives a copy of the work also receives whatever 
licenses to the work the party's predecessor in interest had or could give under the previous paragraph, plus a right to possession of the Corresponding Source of the 
work from the predecessor in interest, if the predecessor has it or can get it with reasonable efforts.

You may not impose any further restrictions on the exercise of the rights granted or affirmed under this License. For example, you may not impose a license fee, roy-
alty, or other charge for exercise of rights granted under this License, and you may not initiate litigation (including a cross-claim or counterclaim in a lawsuit) alleging 
that any patent claim is infringed by making, using, selling, offering for sale, or importing the Program or any portion of it.

11. Patents.

A "contributor" is a copyright holder who authorizes use under this License of the Program or a work on which the Program is based. The work thus licensed is called 
the contributor's "contributor version".

A contributor's "essential patent claims" are all patent claims owned or controlled by the contributor, whether already acquired or hereafter acquired, that would be 
infringed by some manner, permitted by this License, of making, using, or selling its contributor version, but do not include claims that would be infringed only as a 
consequence of further modification of the contributor version. For purposes of this definition, "control" includes the right to grant patent sublicenses in a manner 
consistent with the requirements of this License.

Each contributor grants you a non-exclusive, worldwide, royalty-free patent license under the contributor's essential patent claims, to make, use, sell, offer for sale, 
import and otherwise run, modify and propagate the contents of its contributor version.

In the following three paragraphs, a "patent license" is any express agreement or commitment, however denominated, not to enforce a patent (such as an express per-
mission to practice a patent or covenant not to sue for patent infringement). To "grant" such a patent license to a party means to make such an agreement or commit-
ment not to enforce a patent against the party.

If you convey a covered work, knowingly relying on a patent license, and the Corresponding Source of the work is not available for anyone to copy, free of charge 
and under the terms of this License, through a publicly available network server or other readily accessible means, then you must either (1) cause the Corresponding 
Source to be so available, or (2) arrange to deprive yourself of the benefit of the patent license for this particular work, or (3) arrange, in a manner consistent with the 
requirements of this License, to extend the patent license to downstream recipients. "Knowingly relying" means you have actual knowledge that, but for the patent 
license, your conveying the covered work in a country, or your recipient's use of the covered work in a country, would infringe one or more identifiable patents in that 
country that you have reason to believe are valid.
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If, pursuant to or in connection with a single transaction or arrangement, you convey, or propagate by procuring conveyance of, a covered work, and grant a patent 
license to some of the parties receiving the covered work authorizing them to use, propagate, modify or convey a specific copy of the covered work, then the patent 
license you grant is automatically extended to all recipients of the covered work and works based on it.

A patent license is "discriminatory" if it does not include within the scope of its coverage, prohibits the exercise of, or is conditioned on the non-exercise of one or 
more of the rights that are specifically granted under this License. You may not convey a covered work if you are a party to an arrangement with a third party that is 
in the business of distributing software, under which you make payment to the third party based on the extent of your activity of conveying the work, and under which 
the third party grants, to any of the parties who would receive the covered work from you, a discriminatory patent license (a) in connection with copies of the covered 
work conveyed by you (or copies made from those copies), or (b) primarily for and in connection with specific products or compilations that contain the covered 
work, unless you entered into that arrangement, or that patent license was granted, prior to 28 March 2007.

Nothing in this License shall be construed as excluding or limiting any implied license or other defenses to infringement that may otherwise be available to you under 
applicable patent law.

12. No Surrender of Others' Freedom.

If conditions are imposed on you (whether by court order, agreement or otherwise) that contradict the conditions of this License, they do not excuse you from the con-
ditions of this License. If you cannot convey a covered work so as to satisfy simultaneously your obligations under this License and any other pertinent obligations, 
then as a consequence you may not convey it at all. For example, if you agree to terms that obligate you to collect a royalty for further conveying from those to whom 
you convey the Program, the only way you could satisfy both those terms and this License would be to refrain entirely from conveying the Program.

13. Use with the GNU Affero General Public License.

Notwithstanding any other provision of this License, you have permission to link or combine any covered work with a work licensed under version 3 of the GNU 
Affero General Public License into a single combined work, and to convey the resulting work. The terms of this License will continue to apply to the part which is the 
covered work, but the special requirements of the GNU Affero General Public License, section 13, concerning interaction through a network will apply to the combi-
nation as such.

14. Revised Versions of this License.

The Free Software Foundation may publish revised and/or new versions of the GNU General Public License from time to time. Such new versions will be similar in 
spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Program specifies that a certain numbered version of the GNU General Public License "or any later ver-
sion" applies to it, you have the option of following the terms and conditions either of that numbered version or of any later version published by the Free Software 
Foundation. If the Program does not specify a version number of the GNU General Public License, you may choose any version ever published by the Free Software 
Foundation.

If the Program specifies that a proxy can decide which future versions of the GNU General Public License can be used, that proxy's public statement of acceptance of 
a version permanently authorizes you to choose that version for the Program.

Later license versions may give you additional or different permissions. However, no additional obligations are imposed on any author or copyright holder as a result 
of your choosing to follow a later version.

15. Disclaimer of Warranty.

THERE IS NO WARRANTY FOR THE PROGRAM, TO THE EXTENT PERMITTED BY APPLICABLE LAW. EXCEPT WHEN OTHERWISE STATED IN 
WRITING THE COPYRIGHT HOLDERS AND/OR OTHER PARTIES PROVIDE THE PROGRAM "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PAR-
TICULAR PURPOSE. THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE PROGRAM IS WITH YOU. SHOULD THE PROGRAM 
PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

16. Limitation of Liability.

IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY 
WHO MODIFIES AND/OR CONVEYS THE PROGRAM AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, INCLUDING ANY GENERAL, 
SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE PROGRAM (INCLUDING BUT 
NOT LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES SUSTAINED BY YOU OR THIRD PARTIES OR A FAIL-
URE OF THE PROGRAM TO OPERATE WITH ANY OTHER PROGRAMS), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES.

17. Interpretation of Sections 15 and 16.

If the disclaimer of warranty and limitation of liability provided above cannot be given local legal effect according to their terms, reviewing courts shall apply local 
law that most closely approximates an absolute waiver of all civil liability in connection with the Program, unless a warranty or assumption of liability accompanies 
a copy of the Program in return for a fee.
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LGPL
GNU LESSER GENERAL PUBLIC LICENSE

Version 3, 29 June 2007
Copyright (C) 2007 Free Software Foundation, Inc. <http://fsf.org/>

Everyone is permitted to copy and distribute verbatim copies of this license document, but changing it is not allowed.

This version of the GNU Lesser General Public License incorporates the terms and conditions of version 3 of the GNU General Public License, supplemented by the 
additional permissions listed below.

0. Additional Definitions.

As used herein, "this License" refers to version 3 of the GNU Lesser General Public License, and the "GNU GPL" refers to version 3 of the GNU General Public 
License.

"The Library" refers to a covered work governed by this License, other than an Application or a Combined Work as defined below.

An "Application" is any work that makes use of an interface provided by the Library, but which is not otherwise based on the Library. Defining a subclass of a class 
defined by the Library is deemed a mode of using an interface provided by the Library.

A "Combined Work" is a work produced by combining or linking an Application with the Library. The particular version of the Library with which the Combined

Work was made is also called the "Linked Version".

The "Minimal Corresponding Source" for a Combined Work means the Corresponding Source for the Combined Work, excluding any source code for portions of the

Combined Work that, considered in isolation, are based on the Application, and not on the Linked Version.

The "Corresponding Application Code" for a Combined Work means the object code and/or source code for the Application, including any data and utility programs 
needed for reproducing the Combined Work from the Application, but excluding the System Libraries of the Combined Work.

1. Exception to Section 3 of the GNU GPL.

You may convey a covered work under sections 3 and 4 of this License without being bound by section 3 of the GNU GPL.

2. Conveying Modified Versions.

If you modify a copy of the Library, and, in your modifications, a facility refers to a function or data to be supplied by an Application that uses the facility (other than 
as an argument passed when the facility is invoked), then you may convey a copy of the modified version:

a. under this License, provided that you make a good faith effort to ensure that, in the event an Application does not supply the function or data, the facility 
still operates, and performs whatever part of its purpose remains meaningful, or

b. under the GNU GPL, with none of the additional permissions of this License applicable to that copy.

3. Object Code Incorporating Material from Library Header Files.

The object code form of an Application may incorporate material from a header file that is part of the Library. You may convey such object code under terms of your 
choice, provided that, if the incorporated material is not limited to numerical parameters, data structure layouts and accessors, or small macros, inline functions and 
templates (ten or fewer lines in length), you do both of the following:

a. Give prominent notice with each copy of the object code that the Library is used in it and that the Library and its use are covered by this License.
b. Accompany the object code with a copy of the GNU GPL and this license document.

4. Combined Works.

You may convey a Combined Work under terms of your choice that, taken together, effectively do not restrict modification of the portions of the Library contained in 
the Combined Work and reverse engineering for debugging such modifications, if you also do each of the following:

a. Give prominent notice with each copy of the Combined Work that the Library is used in it and that the Library and its use are covered by this License.
b. Accompany the Combined Work with a copy of the GNU GPL and this license document.
c. For a Combined Work that displays copyright notices during execution, include the copyright notice for the Library among these notices, as well as a 

reference directing the user to the copies of the GNU GPL and this license document.
d. Do one of the following:

1) Convey the Minimal Corresponding Source under the terms of this License, and the Corresponding Application Code in a form suitable for, and under 
terms that permit, the user to recombine or relink the Application with a modified version of the Linked Version to produce a modified Combined Work, 
in the manner specified by section 6 of the GNU GPL for conveying Corresponding Source.

2) Use a suitable shared library mechanism for linking with the Library. A suitable mechanism is one that (a) uses at run time a copy of the Library 
already present on the user's computer system, and (b) will operate properly with a modified version of the Library that is interface-compatible with the 
Linked Version.

e. Provide Installation Information, but only if you would otherwise be required to provide such information under section 6 of the GNU GPL, and only to 
the extent that such information is necessary to install and execute a modified version of the Combined Work produced by recombining or relinking the 
Application with a modified version of the Linked Version. (If you use option 4d0, the Installation Information must accompany the Minimal 
Corresponding Source and Corresponding Application Code. If you use option 4d1, you must provide the Installation Information in the manner specified 
by section 6 of the GNU GPL for conveying Corresponding Source.)

5. Combined Libraries.

You may place library facilities that are a work based on the Library side by side in a single library together with other library facilities that are not Applications and 
are not covered by this License, and convey such a combined library under terms of your choice, if you do both of the following:

a. Accompany the combined library with a copy of the same work based on the Library, uncombined with any other library facilities, conveyed under the 
terms of this License.

b. Give prominent notice with the combined library that part of it is a work based on the Library, and explaining where to find the accompanying 
uncombined form of the same work.
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6. Revised Versions of the GNU Lesser General Public License.

The Free Software Foundation may publish revised and/or new versions of the GNU Lesser General Public License from time to time. Such new versions will be sim-
ilar in spirit to the present version, but may differ in detail to address new problems or concerns.

Each version is given a distinguishing version number. If the Library as you received it specifies that a certain numbered version of the GNU Lesser General Public 
License "or any later version" applies to it, you have the option of following the terms and conditions either of that published version or of any later version published 
by the Free Software Foundation. If the Library as you received it does not specify a version number of the GNU Lesser General Public License, you may choose any 
version of the GNU Lesser General Public License ever published by the Free Software Foundation.

If the Library as you received it specifies that a proxy can decide whether future versions of the GNU Lesser General Public License shall apply, that proxy's public 
statement of acceptance of any version is permanent authorization for you to choose that version for the Library.

MIT
Copyright 1987, 1988 by MIT Student Information Processing Board.

Permission to use, copy, modify, and distribute this software and its documentation for any purpose is hereby granted, provided that the names of M.I.T. and the 
M.I.T. S.I.P.B. not be used in advertising or publicity pertaining to distribution of the software without specific, written prior permission. M.I.T. and the M.I.T. 
S.I.P.B. make no representations about the suitability of this software for any purpose. It is provided "as is" without express or implied warranty. 

zlib
Copyright (C) 1995-1998 Jean-loup Gailly and Mark Adler

This software is provided 'as-is', without any express or implied warranty. In no event will the authors be held liable for any damages arising from the use of this soft-
ware.

Permission is granted to anyone to use this software for any purpose, including commercial applications, and to alter it and redistribute it freely, subject to the follow-
ing restrictions:

1. The origin of this software must not be misrepresented; you must not claim that you wrote the original software. If you use this software in a product, 
an acknowledgment in the product documentation would be appreciated but is not required.

2. Altered source versions must be plainly marked as such, and must not be misrepresented as being the original software.

3. This notice may not be removed or altered from any source distribution.Jean-loup Gailly Mark Adler jloup@gzip.org madler@alumni.caltech.edu

The data format used by the zlib library is described by RFCs (Request for Comments) 1950 to 1952 in the files ftp://ds.internic.net/rfc/rfc1950.txt (zlib format), 
rfc1951.txt (deflate format) and rfc1952.txt (gzip format).
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Glossary
The following terms are used throughout this guide:

Breakaway — an act of performing a switch on only some of the signals grouped together under 
one label.

Connection Point — setting to define a communication connection between Ultricore BCS and a 
device in the routing system.

Crosspoint — a switch within a matrix. For example, the connection of signal IN 1 to OUT 1 requires 
one crosspoint.

Destination — a signal output from the routing system.

Hard Panel — the physical Ultricore BCS panel that provides a touchscreen interface to the menu 
system.

IP Address — a setting that defines the Internet protocol address of a device within a network.

Label — text that is used by control displays to identify a signal as an input or output.

Level — refers to a section of a routing system. For example, a video router would be one level and 
an audio router would be a second level.

Logical (virtual) Label — a name for a group of routing system inputs or outputs.

Logical (virtual) Routing — the action of switching a group of otherwise unrelated signals via a 
common label (name).

Remote Control Panel (RCP) — a physical hardware panel of buttons that is used to control the 
routing system.

Salvo — a system wide sequence of matrix control operations and crosspoint actions.

Soft Panel — a DashBoard software interface that represents a panel of buttons that is used to 
control the routing system.

Source — a signal input to the routing system.

Virtual Label — a name for a group of routing system inputs or outputs.

Virtual Routing — the action of switching a group of otherwise unrelated signals via a common 
label (name).
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